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1

> New In This Release

What’'s New in Siebel Server Sync Guide, Version 7.7, Revision A
Table 1 lists changes in this version of the documentation. This revision provides increased accuracy
and usability to support release 7.7 of Oracle's Siebel Server Sync for Microsoft Exchange (SSSE)

software.

Table 1.

What's New in Siebel Server Sync Guide, Version 7.7, Revision A

Topic Description

“SSSE Deployment Options” on
page 14

Added a caution regarding workflows.

Supported PIMs

Deleted topic. Supported platforms information is in Siebel
System Requirements and Supported Platforms.

“Initial Extract and Ongoing Extract”
on page 19

Added more information about case-sensitivity during initial
extract and deletion behavior during ongoing
synchronization.

“SSSE System Requirements” on
page 28

Added information about clustered environments, Active
Directory forest requirement, troubleshooting a shortage of
database connections, and time zone requirements.
Information about required operating systems has been
moved to Siebel System Requirements and Supported
Platforms on Siebel SupportWeb.

“Process of Preparing Microsoft
Exchange 2000 Environment for
SSSE Installation” on page 34

Corrected topic. Not all tasks in this process must be
performed on both PIMSI Engine machines and Exchange
Connector machines.

“Installing Exchange 2000 System
Management Tools” on page 34

Corrected topic. This task is required for Exchange Connector
machines, but not for PIMSI Engine machines that do not run
Exchange Connector.

“Installing Exchange Server Service
Pack 3 Rollup” on page 35

Added information about why this software is needed on
PIMSI Engine and Exchange Connector machines.

“Process of Preparing Microsoft
Exchange 2003 Environment for
SSSE Installation” on page 37

Corrected topic. Not all tasks in this process must be
performed on both PIMSI Engine machines and Exchange
Connector machines.

“Installing Exchange 2003 System
Management Tools” on page 37

Siebel Server Sync Guide Version 7.7, Revision A

Corrected topic. This task is required for Exchange Connector
machines, but not for PIMSI Engine machines that do not run
Exchange Connector.




What’s New in This Release =

Table 1.

What's New in Siebel Server Sync Guide, Version 7.7, Revision A

Topic Description

“Configuring Firewalls for Use With
SSSE” on page 39

Added a new topic containing information about how to
configure firewalls for use with SSSE.

“Modifying the Database” on
page 44

Added information about the automatic recreation of the
index S_SD_SV_PROFILE_F1.

“Modifying the Repository” on
page 45

Added information in Step 1 about preserving customizations
when modifying the Siebel Repository for use with SSSE.

“Modifying Seed Data” on page 49

Corrected topic. In Step 6. changed table heading from Siebel
Value to PIM Value.

“Verifying SSSE Component
Definitions” on page 52

Added information in Step 7 about how addresses are stored
in Exchange and in the Siebel database.

“About Tuning SSSE for Optimal
Performance” on page 55

Added a new topic about specific SSSE parameters that can
affect performance.

“Setting Up the Connector Share
Directory” on page 56

Modified topic to clarify share name requirements.

“About Exchange Service Account
Privileges” on page 58

Added a new topic about the privileges that the Exchange
Connector needs for proper operation.

“Configuring Exchange Service
Account Credentials” on page 58

Modified topic to add information about Send As privileges
that must be granted explicitly for some versions of
Exchange.

“Configuring the Database for
SSSE” on page 61

Updated information about which script to use in supported
database environments. Added information about reinstalling
SSSE triggers after using the Generate Triggers server
component. Added a caution about changing triggers.

“Populating DB_LAST_UPD
Columns” on page 63

Corrected topic. Optimizer does not populate the column with
data, but it should be used after the column is populated.
Removed the references to scripts that are no longer provided
with the product.

“Configuring Exchange Connector
Application DCOM Security” on
page 65

Added conceptual information about DCOM settings.
Corrected Step 9 of procedure for configuring Exchange
Connector DCOM security. The user identity that the
Exchange Connector uses must have permission to read
Exchange mailboxes, but does not need to match the identity
of the user who starts the Siebel Server Windows services.

“Configuring the Generic Siebel
Organizer” on page 71

Added more information about the requirements for the
Generic Siebel Organizer Login.

“Tuning SSSE Siebel Profile
Parameters” on page 73

Added information about the following parameters:
AttendeeQueryForceEmailLower, ExtractStartDateFormat,
ForceTranscode, MaxAlarmLeadMinutes, and
ResolveContactbyEmailAddress.
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Table 1.

Topic Description

“Configuring Exchange Connector
Parameters” on page 79

What’s New in This Release m

What's New in Siebel Server Sync Guide, Version 7.7, Revision A

Modified topic to clarify the share name requirements. Added
information about specifying the preferred Global Catalog
servers for Exchange Connector to contact.

“About Synchronizing Additional
Fields” on page 88

Added information about why synchronization is not
supported for certain fields.

“Setting User-Level
Synchronization” on page 118

Added information to clarify how the Visibility setting affects
which records are available for synchronization by a specific
user.

“About SSSE File Maintenance” on
page 124 and “Reinitializing an
SSSE User” on page 124

Added information about the effects of unmapping and
remapping a user.

“About SSSE Log Files” on page 125

Added information about error messages that can safely be
ignored.

“About Moving or Deleting
Mailboxes for SSSE Users” on
page 127

Added a new topic about how to move or delete the Exchange
mailbox for an SSSE user.

“Factors That Determine Calendar
Synchronization” on page 131 and
“Creating, Modifying, or Deleting an
Appointment” on page 132

Added information about how archiving affects the
synchronization of Calendar records.

“About Minor Error Messages” on
page 148

Added a new topic that lists error messages for minor
synchronization problems.

“System Requirements for Siebel
Outlook Add-In” on page 154

Information about supported versions of Microsoft Outlook
has been moved to Siebel System Requirements and
Supported Platforms on Siebel SupportWeb.

“(Optional) Setting Siebel Outlook
Add-In Objects and Fields” on
page 156

Added a new topic that describes how to make optional
adjustments to the information that Outlook Add-In provides.

“About Embedded Outlook
Calendar” on page 165

Modified topic wording to improve clarity.

“System Requirements for
Embedded Outlook Calendar” on
page 167

Information about supported versions of Microsoft Outlook
has been moved to Siebel System Requirements and
Supported Platforms on Siebel SupportWeb.

“Enabling Embedded Outlook
Calendar Visibility” on page 168

Modified topic to include additional requirements.
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What’s New in This Release =

What’s New in Siebel Server Sync Guide, Version 7.7
Table 2 lists changes in a prior revision of the documentation to support release 7.7 of the software.

Table 2. What’s New in Siebel Server Sync Guide, Version 7.7

Topic Description

All Topics Siebel Server Sync for Microsoft Exchange Server (SSSE) is
new functionality in release 7.7.2.3 that allows server-based
synchronization of Siebel Calendar, Activity, and Contact data
between Microsoft Exchange Servers and Siebel Servers. This
allows SSSE users to view the synchronized data either in a
Siebel application or in a Microsoft Exchange client
application such as Microsoft Outlook.
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2 Siebel Server Sync

This chapter provides introductory information about Siebel Server Sync. It includes the following
topics:

B “About SSSE” on page 13
B “SSSE Deployment Options” on page 14
[l “SSSE Synchronization Options” on page 15

About SSSE

Siebel Server Sync is a server-side integration product that synchronizes Siebel application data with
Personal Information Manager (PIM) Server products. The current version of Siebel Server Sync
supports synchronization with Microsoft Exchange Server only. This version of the Siebel Server Sync
product is referred to as Siebel Server Sync for Microsoft Exchange Server (SSSE). Synchronization
with Microsoft Exchange Server allows Exchange client software such as Microsoft Outlook to access
the synchronized data.

SSSE can synchronize data that appears in the My Activities, My Calendar, My Contacts, My Personal
Contacts, and All Employees views of the Siebel application. Synchronization of data between the
Siebel application and Exchange is done automatically and with a frequency an administrator can
tune. No user action is required to initiate synchronization. However, each user must use the Add To
Sync List command to designate the individual Contact and Employee records that SSSE will
synchronize for that user.

If anyone adds or changes a record in the Siebel application, SSSE automatically exports or
synchronizes the change with Exchange. Likewise, if anyone adds or changes a record in Exchange,
SSSE automatically imports or synchronizes the change with the Siebel application. SSSE performs
these operations on a single-user basis, using a synchronization schedule that administrators can
adjust. Typically, SSSE synchronizes a data change within a few minutes after a user makes the
original change.

SSSE supports three deployment options as described in “SSSE Deployment Options” on page 14.
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SSSE Deployment Options

Figure 1 shows SSSE deployment options in relation to Siebel Server and Microsoft Exchange Server.

Embedded

Outlook Add-In Cutlook

Calendar
. - - | Exchange
Siebel Server ja—r PIM S Engine i Server

Figure 1. SSSE deployment options with related servers

SSSE supports three deployment options:

B PIM Server Integration (PIMSI) Engine and Dispatcher. Allows server-based
synchronization of data between the Siebel application and Exchange. See Chapter 3, “Siebel
Server Sync Architecture Overview.”

B Siebel Outlook Add-In. Allows users to access Siebel data from within Microsoft Outlook and
associate Siebel data with Outlook Contacts, Calendar and Tasks. See Chapter 9, “Setting Up and
Using Siebel Outlook Add-In.”

B Embedded Outlook Calendar. Allows users to access their Microsoft Outlook calendar from
within the Siebel application. See Chapter 10, “Setting Up and Using Embedded Outlook Calendar.”

You can choose to deploy these options in the following combinations:

B PIMSI Engine and PIMSI Dispatcher only

B PIMSI Engine and PIMSI Dispatcher plus Siebel Outlook Add-In or Embedded Outlook Calendar
B PIMSI Engine and PIMSI Dispatcher plus Siebel Outlook Add-In and Embedded Outlook Calendar
See the following chapters for information about PIMSI Engine and PIMSI Dispatcher:

Chapter 3, “Siebel Server Sync Architecture Overview”

B Chapter 4, “Installing Siebel Server Sync”
B Chapter 5, “Configuring Siebel Server Sync”
B Chapter 7, “Administering Siebel Server Sync”

Chapter 8, “Using Siebel Server Sync”

After you install and set up PIMSI Engine and PIMSI Dispatcher, then you can install Siebel Outlook
Add-In or Embedded Outlook Calendar or both, if you choose to do so. See these chapters:

B Chapter 9, “Setting Up and Using Siebel Outlook Add-In”
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B Chapter 10, “Setting Up and Using Embedded Outlook Calendar”

CAUTION: Do not activate PIMSI workflows unless Siebel Technical Support or Siebel Expert
Services instructs you to do so. The workflows that are provided in seed data are not currently used
by SSSE, and can cause PIMSI Engine crashes if improperly deployed.

SSSE Synchronization Options
SSSE supports three data synchronization options:

B Full Sync. Bidirectional synchronization of data between the Siebel database and one or more
Microsoft Exchange Servers

B Export Only. Exportation of data from the Siebel database to one or more Microsoft Exchange
Servers

B None. No synchronization of data

Administrators set synchronization options. Administrators can set these options for each user on
each domain. Domain refers to the information domains: To Do items, Business Contacts, Personal
Contacts, Employees, and Calendar. User can be individual users or groups of users specified by
Organization, Position, or User List. For more information, see “Setting SSSE Group and User Access
Controls” on page 118.

Table 3 shows the default synchronization settings.

Table 3. Default SSSE Synchronization Settings

Object Full Sync Export Only
To Do

Calendar X

Personal Contact X

Business Contact X

Employee X

NOTE: SSSE does not currently support synchronization of email.

If synchronization is enabled for Calendar and Activities/To Do items for a user, then SSSE
automatically synchronizes new or changed calendar and activity records for that user. Contacts use
an opt-in strategy. This means that the user must use the Add To Sync List command to direct SSSE
to synchronize a Contact, Personal Contact, or Employee record before the record can be
synchronized between the Siebel Server and the Microsoft Exchange mailbox for that user. If a
Contact, Personal Contact, or Employee record originates in Microsoft Exchange, the user must also
specify an appropriate Category setting before SSSE will synchronize the record. For more
information, see “Using Siebel Server Sync” on page 129.

Siebel Server Sync Guide Version 7.7, Revision A 15



Introducing Siebel Server S

Related Topics
“Setting Siebel Domain-Level Synchronization” on page 111

“Designating Contact Records for Synchronization” on page 141
“Designating Employee Records for Synchronization” on page 146

Siebel Server Sync Guide Version 7.7, Revision A



3 ver Sync Architecture

This chapter provides an overview of the architecture of SSSE, including information about the SSSE
Server Components, PIMSI Engine and PIMSI Dispatcher. It includes the following topics:

“About PIMSI Engine” on page 17
“About PIMSI Dispatcher” on page 18
“About Exchange Connector” on page 18

“Important SSSE Terminology” on page 18

“SSSE System Requirements” on page 28
“SSSE Architecture” on page 29

|

|

|

|

B “Initial Extract and Ongoing Extract” on page 19
|

|

B  “Required Components for SSSE” on page 29

|

“PIMSI Engine Data Flow” on page 30

About PIMSI Engine

PIMSI Engine is a Siebel Server Component that enables synchronization of data between Siebel
Enterprise Server and Microsoft Exchange Server. This component allows the synchronization of
Calendar appointments, Tasks (called To Do items in Siebel applications), and Contacts (Business,
Personal, and Employees), between the Siebel database and the Exchange server (or servers).

PIMSI Engine administration and configuration is conducted using centralized administration and
configuration screens in the Siebel application. No end-user installation is required for
synchronization of Calendar appointments, Tasks, or Contacts. End users designate the contact
records to be synchronized, but other end user action is not required. Synchronization can be
selectively enabled for individual users or groups of users. After synchronization is initiated between
Exchange and the Siebel application for a specific user, synchronization is performed automatically
for that user. The time that elapses between when a data change takes place and when the change
is synchronized depends on a system-wide configuration parameter that the administrator can
adjust.

NOTE: Because PIMSI Engine is server based, users must use Offline Store (OST) files to replicate
data between Microsoft Exchange Servers and their local Outlook client, or they must store their
Outlook data exclusively on the Microsoft Exchange Server. PIMSI Engine cannot synchronize data
stored in Personal Folders (PST) files.

If a PIMSI Engine goes offline in a Siebel implementation that has multiple PIMSI Engines, the
remaining PIMSI Engines pick up the workload of the nonfunctioning PIMSI Engine. When that PIMSI
Engine comes back online, workloads for all PIMSI Engines rebalance automatically.
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About PIMSI Dispatcher

PIMSI Dispatcher is a Siebel Server Component that performs the following actions at regular,
configurable intervals:

B Determines which users require synchronization within a synchronization cycle due to changes
in Siebel data. For example, if 1000 users have synchronization enabled, Dispatcher identifies
which of those users have had Siebel data change since the user’s last successful
synchronization.

B Sends a synchronization Task Request to PIMSI Engine for each user who has synchronization
enabled. The Task Request contains a SiebelChangeFlag property that indicates whether Siebel
data changes need to be synchronized or not. For all such Task Requests, PIMSI Engine
synchronizes any changes in that user’s Exchange data that have been made since the user’s last
successful synchronization. If SiebelChangeFlag is set to Y, then PIMSI Engine also synchronizes
changes in the user’s Siebel data.

NOTE: If the SSSE Dispatcher goes offline, synchronization stops until the SSSE Dispatcher is
restarted. You can set PIMSI Dispatcher to restart automatically upon failure.

About Exchange Connector

Exchange Connector is an SSSE component that is responsible for all communications with Exchange
Server.

NOTE: Exchange Connector is not a Siebel Server component.
You can deploy Exchange Connector in either of the following ways:
B Deploy one Exchange Connector at a central location within the Siebel Enterprise

B Deploy multiple Exchange Connectors at geographic locations near Exchange Servers

Important SSSE Terminology

This topic provides definitions of some important terms related to SSSE operations:

B Siebel Domain. A set of Siebel objects that SSSE considers for synchronization with the PIM.
Such Siebel Objects currently include Business Contacts, Calendar, Employees, Personal
Contacts, and To Do items.

B PIM Domain. A set of PIM objects that SSSE considers for synchronization with Siebel. Such PIM
objects currently include Microsoft Exchange Calendar, Contacts, and Tasks.

B Domain Mapping. A mapping between Siebel Domain objects and PIM Domain objects. This
determines which Siebel Domain object is synchronized with which PIM Domain object.

B Outbound Synchronization. The process of sending data from the Siebel Server to the PIM
Server.

B Inbound Synchronization. The process of sending data from the PIM Server to the Siebel
Server.
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Initial Extract and Ongoing Extract

This topic describes the Initial Extract process and the Ongoing Extract process which synchronize
Siebel data and Microsoft Exchange Server data.

For each enabled user, SSSE periodically extracts changes from both the Siebel database and the
Microsoft Exchange data store, and then applies the changes from each data store to the other. The
SSSE administrator can configure the time period between extractions to suit your business
requirements. For each user, the first iteration of this periodic extraction process is called the Initial
Extract, and the following extractions are called Ongoing Extracts.

During an Initial Extract, SSSE takes data from the user's Exchange folders and the Siebel database.
SSSE analyzes the data to find any Exchange records that match Siebel records, and then
synchronizes all of the applicable data.

For example, suppose that there are 10 Contacts in a user’'s Exchange folder and 20 completely
different Business Contacts in the same user’s My Contacts list in the Siebel Application. (In other
words, none of the user’s Contacts in Exchange match any of that user’s Business Contacts in the
Siebel database.) If the user has synchronization enabled and has used the Add To Sync List
command to request synchronization of all 20 Siebel Business Contacts, then, after Initial Extract is
performed for that user, both the user’s Exchange Contact folder and the user’s My Contacts list will
contain 30 contact listings. As part of this process, for any contacts that SSSE imports from Exchange
to the Siebel database, SSSE automatically adds the user to the record’s Sync List for future
synchronizations. The Sync List for the record is a multi-value group (MVG) field that lists the
employees who synchronize that record.

The Initial Extract process prepares the user’s data for Ongoing Extract synchronizations. More
detailed information about the Initial Extract process is provided later in this topic.

The Ongoing Extract process repeatedly inspects a user’s data for changes. Ordinarily, it
synchronizes just the data that has changed since SSSE performed the most recent successful
synchronization. However, in some circumstances, such as changes in the synchronization level of a
domain, all of the user’s data within that domain is reextracted.

For more details about how extractions work, see “PIMSI Engine Data Flow” on page 30.

About Synchronizing Records during Initial Extract

During the Initial Extract process for a particular user, for each domain that the user can synchronize,
the Initial Extract process compares that user's Exchange records in that domain with that user's
Siebel records in the corresponding Siebel domain.

The actions that follow this comparison depend on the following factors:

B  Synchronization level for the current domain and user. The synchronization level
determines whether SSSE will synchronize a domain. For a domain that SSSE can synchronize,
the synchronization level determines whether information can flow in both directions between
the Exchange Server and the Siebel Database, or whether information must always flow in one
direction.

B Existence or absence of a matching record. SSSE compares Exchange records and Siebel
records to determine when corresponding records need to be modified and when new records
need to be created.
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B Data values in key fields. When SSSE compares Exchange records and Siebel records, SSSE
only checks the values in certain key fields to determine whether the records match. For
information about setting key fields, see “Setting Key Fields” on page 117.

B PIM Category Value. Depending on how your SSSE implementation is configured, SSSE may
or may not synchronize Exchange Contact records depending on whether the Category field in
the Exchange record has a value that matches the PIM Category value setting in your Siebel
implementation, as described later in this topic.

B Sync List Status. SSSE may or may not synchronize Siebel Contact records depending on
whether the Sync List flag is set for the record and user in question.

B Status of case sensitivity settings for your Siebel implementation. Siebel implementations
can be set for case-sensitivity or case insensitivity at the application level, at the AOM
(application object manager) level, or at the field level. The status of these settings affects
whether or not SSSE detects differences between two field values that differ only in
capitalization. By default, Siebel applications are set to be case-sensitive. For example, the
default settings cause SSSE to detect no match between a value of ABC Corp on the PIM and a
value of ABC CORP in the Siebel database. In such a case, SSSE synchronizes the records
separately, resulting in both forms of the record being present on the PIM and in the Siebel
database. However, if your Siebel application is case-insensitive in the context where SSSE
checks for matching records, then SSSE would treat these two values as a match. For information
about setting applications, AOMs, and fields to be case-insensitive, see Applications
Administration Guide.

For information about how SSSE handles Exchange Task and Calendar records during Initial Extract,
see Table 5.

Table 5. Initial Extraction Behavior for an Exchange Task Record or Calendar Record

Similar Record Exists
in Siebel Database

and is Visible to the

Synchronization Level User Exchange Result Siebel Result
Full Sync or Export Only | Yes SSSE overwrites the | SSSE associates the
Exchange record with | Siebel record with
Siebel data the Exchange record
Full Sync No No change to SSSE creates a new
Exchange record Siebel record and
associates it with the
Exchange record

SSSE has a configurable parameter called OnlySyncCategorizedContacts that can be set to TRUE or
FALSE to suit your business requirements. This Boolean parameter setting determines whether or
not Initial Extract operations synchronize Exchange Contact records that have the Category field set
to a specified value.
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If the OnlySyncCategorizedContacts parameter is set to FALSE, all the user’s Exchange Contact
records are considered for synchronization. By default, this parameter is set to FALSE. For more
information about how SSSE handles Exchange Contact records during an Initial Extract when the
OnlySyncCategorizedContacts parameter is set to FALSE, see Table 6 on page 22.

If the OnlySyncCategorizedContacts parameter is set to TRUE, then, in order to be synchronized
during an Initial Extract operation, Exchange Contact records must have the Category field set to a
value that matches the Siebel setting called PIM Category Value. (The default value for the PIM
Category Value setting is Siebel Contact). For more information about how SSSE handles Exchange
Contact records during an Initial Extract when the OnlySyncCategorizedContacts parameter is set to
TRUE, see Table 7 on page 24.
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Table 6.

Initial Extract Behavior for an Exchange Contact Record when

OnlySyncCategorizedContacts Parameter is Set to FALSE

Similar
Record
Exists In
Category Siebel
Field Set Database
to and is
Specified Visible in Corresponding
PIM the User’s Siebel Record
Synchronization Category Sales Rep has the Userin Exchange
Level Value View Sync List Result Siebel Result
Full Sync or Yes Yes Yes SSSE SSSE
Export Only overwrites associates the
the Siebel record
Exchange with the
record with Exchange
Siebel data record
Full Sync Yes Yes No No change to | SSSE creates a
Exchange new Siebel
record record, places
the user in the
record’s Sync
List, and
associates the
Siebel record
with the
Exchange
record
Full Sync Yes No Not applicable No change to | SSSE creates a
Exchange new Siebel
record record, places
the user in the
record’s Sync
List, and
associates the
Siebel record
with the
Exchange
record
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Table 6.

Initial Extract Behavior for an Exchange Contact Record when

OnlySyncCategorizedContacts Parameter is Set to FALSE

Category
Field Set
to
Specified
PIM

Similar
Record
Exists In
Siebel
Database
and is
Visible in
the User’s

Corresponding
Siebel Record

cture Overview & Initial Extract and Ongoing Extract

Synchronization Category Sales Rep has the Userin Exchange
Level Value View Sync List Result Siebel Result
Full Sync or No Yes Yes SSSE SSSE
Export Only overwrites associates the
the Siebel record
Exchange with the
record with Exchange
Siebel data record
Full Sync No Yes No No change to | SSSE creates a
Exchange new Siebel
record record, places
the user in the
record’s Sync
List, and
associates the
Siebel record
with the
Exchange
record
Full Sync No No Not applicable No change to | No change to

Exchange
record

Siebel record
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Table 7.

Initial Extraction Behavior for an Exchange Contact Record when
OnlySyncCategorizedContacts Parameter is Set to TRUE

Similar
Record
Category Exists In
Field Set Siebel
to Database
Specified and is Corresponding
PIM Visibleinthe Siebel Record
Synchronization Category User’s Sales hastheUserin Exchange Siebel
Level Value Rep View Sync List Result Result
Full Sync or Yes Yes Yes SSSE SSSE
Export Only overwrites associates
the the Siebel
Exchange record with
record with the Exchange
Siebel data record
Full Sync Yes Yes No No change to | SSSE creates
Exchange a new Siebel
record record, places
the user in
the record’s
Sync List, and
associates
the Siebel
record with
the Exchange
record
Full Sync Yes No Not applicable No change to | SSSE creates
Exchange a new Siebel
record record, places
the user in
the record’s
Sync List, and
associates
the Siebel
record with
the Exchange
record
Full Sync or No Not applicable | Not applicable No change to | No change to

Export Only

Exchange
record

Siebel record
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About Synchronizing Records during Ongoing Extract
The Ongoing Extract process is similar to the Initial Extract process but differs in the following
respects:

B The only record changes that Ongoing Extract evaluates are the changes that have taken place
since the last time the user was successfully synchronized.

B If a Siebel record and an Exchange record were associated with each other in a previous
synchronization, key fields are not used to determine what action to take. Instead, record IDs
are used when determining whether a Siebel record or Exchange record has changed. This allows
users to change values in key fields while preserving the association between a Siebel record and
an Exchange record.

B If a record changes in both the Siebel environment and the Exchange environment between
synchronizations, SSSE treats the situation as an update conflict. The changes in the Siebel
environment are preserved and the Exchange environment inherits these changes through
synchronization.

B In general, if a record is modified in one environment but is deleted in the other, then the record
is deleted in the remaining environment at the next synchronization. However, the behavior
differs slightly depending on which domain is involved, where the deletion occurs, and when the
deletion occurs, as follows:

m If a Siebel Contact, Task, or Calendar record is synchronized to Exchange and the user
deletes it in Exchange before that user’s next synchronization occurs, then the next
synchronization does not delete or otherwise affect the Siebel record. This is a known
technical limitation.

If, instead, the user’s data is synchronized successfully at least once between the initial
synchronization to Exchange and the deletion of the record in Exchange, then the results are
as described in the following paragraphs.

m If a user deletes a Contact record in Outlook that has the Private check box selected, then
SSSE deletes the corresponding Siebel Personal Contact record.

m If a user deletes a Task in Outlook, then SSSE deletes the corresponding Siebel Task record.

m If a user deletes a To Do record in Outlook, then SSSE deletes the corresponding Siebel To
Do record.

m If a user deletes a Contact record in Outlook that does not have the Private check box
selected, then SSSE removes the user from the Sync List for the corresponding Siebel
Business Contact record.

m If a user deletes a Contact record in Outlook that has the Category field set to Employee (or
PIM Category Value for the Employee domain), or if the Category field is cleared, SSSE makes
no changes to the corresponding Siebel record, because the Employee domain is configured
for one-way synchronization, from the Siebel record to the Exchange record.

B The Category field for an Exchange Contact record must contain an appropriate value in order
for the record to be synchronized to the Siebel database. Depending on the values in the
Category field and whether or not the Private check box is selected, the Siebel record that
corresponds to a synchronized Exchange Contact record can be any of the following Siebel record
types:
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m Siebel Business Contact record
m Siebel Personal Contact record
m Siebel Employee record

For more information about how Exchange Category field values and Private check box status
affect corresponding Siebel record types, and vice versa, see Table 8.

Table 8. Relationships Between Exchange Contacts and Siebel Contacts and Employees

Corresponding Exchange Corresponding Exchange

Contact Category Field Contact Private Check Box
Siebel Record Type Value Status

Siebel Business Contact match PIM Category Value not selected
setting for Siebel Business
Contact domain (default value
is Siebel Contact)

Siebel Personal Contact match PIM Category Value selected
setting for Siebel Personal
Contact domain (default value
is Siebel Contact)

Siebel Employee match PIM Category Value Not applicable
setting for Siebel Employee
domain (default value is
Employee)
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For more information about how SSSE handles Exchange Contact records during an Ongoing Extract,

see Table 9.
Table 9. Ongoing Extract Behavior for an Exchange Contact Record
Similar
Record
Category Exists In
Field Set Siebel
to Database
Specified and is Corresponding
PIM Visibleinthe Siebel Record
Synchronization Category User’s Sales hastheUserin Exchange Siebel
Level Value Rep View Sync List Result Result
Full Sync or Yes Yes Yes SSSE SSSE
Export Only overwrites associates
the the Siebel
Exchange record with
record with the Exchange
Siebel data record
Full Sync Yes Yes No No change to | SSSE creates
Exchange a new Siebel
record record, places
the user in
the record’s
Sync List, and
associates
the Siebel
record with
the Exchange
record
Full Sync Yes No Not applicable No change to | SSSE creates
Exchange a new Siebel
record record, places
the user in
the record’s
Sync List, and
associates
the Siebel
record with
the Exchange
record
Full Sync or No Not applicable | Not applicable No change to | No change to

Export Only

Exchange
record

Siebel record
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SSSE System Requirements

SSSE is a part of the Siebel Enterprise. SSSE is composed of the following components:

B Siebel Enterprise Server. Hosts one or more Siebel Servers that run the PIMSI Engine server
component and the PIMSI Dispatcher server component, with the following characteristics:

For proper operation, one instance of the PIMSI Dispatcher component must serve your
entire Siebel Enterprise. However, you can run multiple instances of the PIMSI Engine
component, either on a single Siebel Server or on multiple Siebel Servers.

You can use SSSE in either clustered environments or nonclustered environments.
Performance for SSSE in a clustered environment is roughly comparable to performance in a
nonclustered environment that has multiple servers running the PIMSI Engine and the Siebel
Exchange Connector components.

For optimum performance, it is recommended that you run the process-intensive PIMSI
Dispatcher component on a machine that does not run the process-intensive PIMSI Engine
component.

A machine that hosts the PIMSI Engine component or the PIMSI Dispatcher component must
use a supported operating system. For information about operating systems currently
supported, see Siebel System Requirements and Supported Platforms on Siebel SupportWeb.

A machine that hosts the PIMSI Engine component must be in a domain that is a part of the
same Active Directory forest (one or more Active Directory domains that share certain
characteristics and information) as the Exchange Server.

If your Siebel implementation experiences a shortage of connections to the database,
increasing the number of PIMSI Engine components can sometimes resolve the problem.
However, SSSE is only one kind of Siebel software that uses database connections. For more
information about general management of database connections, see Siebel Performance
Tuning Guide.

If your Siebel implementation uses Coordinated Universal Time (UTC) throughout, then SSSE
automatically converts dates and times appropriately. If your Siebel implementation does not
use UTC, then your Siebel Servers, Exchange Connector Host, Exchange Servers, and
Database Server must all be set to use the same time zone. For more information about using
UTC, see Siebel Global Deployment Guide.

B Exchange Connector Host. Houses the Siebel Exchange Connector software. The machine that
serves as the Exchange Connector Host must use a supported operating system. For information
about operating systems currently supported, see Siebel System Requirements and Supported
Platforms on Siebel SupportWeb. The Exchange Connector machine can be a machine that is
serving as part of the Siebel Enterprise Server or another machine that resides inside your
organization’s firewall.

PIMSI Engine works in conjunction with the Microsoft Exchange Server host, the machine that hosts
the Microsoft Exchange Server software for Microsoft Outlook. There are no specific Siebel software
requirements for the Exchange Server machines, except that you locate them in a single Active
Directory forest. See your Microsoft documentation for system requirements.

NOTE: If an Exchange Server goes offline, remaining Exchange Servers continue to synchronize
SSSE users. When an Exchange Server resumes operation, synchronization to that server resumes
automatically.

28

Siebel Server Sync Guide Version 7.7, Revision A




Siebel Server Sync Architecture Overview B SSSE Architecture

SSSE Architecture

Figure 2 illustrates the SSSE Architecture. Each SSSE user’s machine interacts with the Siebel
database and the Microsoft Exchange Server Host. The communications that occur between the
Siebel Database and the PIMSI Engine and PIMSI Dispatcher servers are separate from the
communications that occur between the Siebel Database and individual SSSE user machines. The
Exchange Connector Host acts as an intermediary for communications between PIMSI Engine and
the Microsoft Exchange Server Host.

Siebel Server Siebel Server Exchange Exchange
Connector Host Server Host
PIMSI Dispatcher A
Engine ‘L’ Exchange
-
* Connector
Microsoft
N Exchange
- B Mailboxes

User's Machine

Dutlook
P~ Siebel
Desktop Add-In
Database Siebel Cache

Figure 2. SSSE Architecture

If your implementation includes firewalls between SSSE components, you may need to open specific
ports in the firewall to allow the various parts of the implementation to communicate with each other.
For more information about using SSSE with firewalls, see “Configuring Firewalls for Use With SSSE”
on page 39.

Required Components for SSSE

The SSSE server components, PIMSI Dispatcher and PIMSI Engine, handle several important
functions in the synchronization process.

At regular, configurable intervals, PIMSI Dispatcher performs the following actions:

B Determines which users require synchronization within a synchronization cycle due to changes
in Siebel data. For example, if 1000 users have synchronization enabled, Dispatcher identifies
which of those users have had Siebel data change since the user’s last successful
synchronization.

B Sends a synchronization Task Request to PIMSI Engine for each user who has synchronization
enabled and who requires synchronization due to changes in Siebel data.
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B Sends a synchronization Task Request to PIMSI Engine for each user who has synchronization
enabled, to synchronize any changes in that user’s Exchange data since the user’s last successful
synchronization.

For each user who needs data synchronized, PIMSI Engine performs the following actions:
B Computes the incremental data change since the user’s last successful synchronization
Communicates with Exchange Connector to request data from Exchange Server

Reads data from the Siebel database

Performs data conflict detection and resolution

Sends data to the Exchange Connector to be written to the user’s mailbox on the Exchange
Server

I Uses EAI methods to write data to the Siebel database

You can run PIMSI Engine components on multiple Siebel Servers in your Siebel Enterprise. If you
set the MaxTasks and MaxMTServers parameters for the PIMSI Engine component appropriately, you
can also have multiple PIMSI Engine processes running simultaneously on a Siebel Server host.

The following additional components are required for PIMSI Engine to communicate and synchronize
data to and from the Exchange Server:

B EAI components. Siebel Enterprise Application Integration (EAIl) is the primary means of
communication with the Siebel database for the PIMSI Engine component. EAI includes Siebel
Adapter, Data Mapper, and XML Converter.

B Exchange Connector. This is the liaison between PIMSI Engine and the Microsoft Exchange
Server. The Exchange Connector can reside on the same machine as the Siebel Server that hosts
PIMSI Engine components, or it can reside on a separate machine. The Exchange Connector uses
several APIs to communicate with Exchange Server. The exact set of APIs that Exchange
Connector uses may change over time, as needed for technical reasons. The Exchange Connector
currently uses MAPI, ADO, WebDAV and ADSI APIs.

PIMSI Engine Data Flow

The following steps describe the data flow that takes place during either initial extractions or ongoing
extractions:

1 An administrator enables a user for synchronization.

2 At preconfigured intervals, PIMSI Dispatcher determines which users have synchronization
enabled. For each such user, the Dispatcher sends a Task Request to PIMSI Engine, requesting
synchronization of Exchange data for that user. If the user’s Siebel data has changed since the
user’s last successful synchronization, or if the user has not yet synchronized successfully, then
the Task Request also asks for synchronization of the applicable Siebel data.

3  PIMSI Engine determines which data must be synchronized for the user, for both Siebel data and
Exchange data. This involves requesting data from both the Siebel database and the Exchange
Server.
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4 PIMSI Engine sends data from the Siebel database to the Exchange Connector, which identifies
the user’s mailbox on the Exchange Server and writes to it.

5 PIMSI Engine uses EAI methods to write data from the Exchange Server to the Siebel database.

NOTE: This data flow relies upon database triggers recording information in the S_SD_SYNC_INFO
table about changes to Siebel data.
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This chapter describes preinstallation and installation tasks for the SSSE components PIMSI Engine
and PIMSI Dispatcher. It includes the following topics:

“Roadmap for Installing SSSE” on page 33

“Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation” on page 34
“Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation” on page 37
“Configuring Firewalls for Use With SSSE” on page 39

“Installing Siebel Server for PIMSI Dispatcher” on page 40

“Installing Siebel Server for PIMSI Engine” on page 41

“Installing Siebel Exchange Connector” on page 42

For information about hardware and software requirements, see “SSSE System Requirements” on
page 28. For information about installing the Outlook Add-In deployment option, see “Process of
Setting Up Siebel Outlook Add-In” on page 155. For information about installing the Embedded
Outlook Calendar deployment option, see “Process of Setting Up Embedded Outlook Calendar” on
page 167.

Roadmap for Installing SSSE

To install SSSE, perform the following processes and tasks:

NOTE: Preinstallation tasks for SSSE differ depending on whether you are using Microsoft Exchange
2000 Server or Microsoft Exchange Server 2003. Use the appropriate process for your environment.
For information about supported versions, see Siebel System Requirements and Supported Platforms
on Siebel SupportWeb.

1
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“Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation” on page 34 or
“Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation” on page 37

“Configuring Firewalls for Use With SSSE” on page 39
“Installing Siebel Server for PIMSI Dispatcher” on page 40
“Installing Siebel Server for PIMSI Engine” on page 41

“Installing Siebel Exchange Connector” on page 42
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Process of Preparing Microsoft Exchange
2000 Environment for SSSE Installation

Preinstallation tasks differ depending on which version of Microsoft Exchange Server you are using.
This topic describes the process of preparing a Microsoft Exchange 2000 Server environment before
installing SSSE. For information about preparing a Microsoft Exchange Server 2003 environment, see
“Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation” on page 37.

This process is a step in “Roadmap for Installing SSSE” on page 33.

To prepare a Microsoft Exchange 2000 Server environment before installing SSSE, perform the
following tasks. Except where otherwise indicated, perform these tasks on each PIMSI Engine
machine and each Exchange Connector machine:

“Installing Exchange 2000 System Management Tools” on page 34
“Installing Exchange 2000 Server Service Pack 3” on page 34
“Installing Exchange Server Service Pack 3 Rollup” on page 35

“Installing MSXML 4.0 SP2” on page 36

a A 0w N PR

“Checking Domain Controller Properties” on page 36

NOTE: In addition to the software requirements listed in the preceding numbered steps, a
compatible version of Internet Information Services Manager (I1SM) must reside on the Microsoft
Exchange Server machine.

Installing Exchange 2000 System Management Tools

The following procedure briefly describes how to install Exchange 2000 System Management Tools
on Exchange Connector machines.

This task is a step in “Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation”
on page 34.

NOTE: This task must be performed for all Exchange Connector machines, but is not required for
PIMSI Engine machines that do not run Exchange Connector.

To install the Exchange 2000 System Management Tools
1 Insert the Exchange 2000 installation CD into your target server.

2 From the Exchange 2000 Setup choose the Custom setup.

3  From the Custom setup screen install only the Exchange System Management Tools.

Installing Exchange 2000 Server Service Pack 3

The following procedure briefly describes how to install Exchange 2000 Server Service Pack 3 on
PIMSI Engine machines and Exchange Connector machines.
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This task is a step in “Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation”
on page 34.

To install Exchange 2000 Server Service Pack 3

1 On the machine where you want to install the software, open a browser window and navigate to
the following URL:

http://www.microsoft.com/downloads/details.aspx?FamilylD=d89f820b-18be-4c8e-b392-
84215c9df2de&DisplayLang=en

2 Create a folder named SP3 on the machine’s local hard disk, or in another network-accessible
location.

You can either download this software to each machine where you want to install it, or you can
download it to one network-accessible location, and install the software from that location for
each applicable machine.

3 Download the EX2KSP3_server.exe file into the new SP3 folder by clicking on the
EX2KSP3_server.exe link on the Web page.

Open the SP3 folder on your local hard disk, and then double-click EX2KSP3_server.exe.
In the Unzip To Folder dialog box, enter the location of the SP3 folder, and then click Unzip.

When the self-extraction process is complete, click OK, and then click Close.

N o g b

Install the service pack according to the instructions provided by Microsoft.

For example, you may be instructed to navigate to a subdirectory of the SP3 directory and then
run update.exe.

Installing Exchange Server Service Pack 3 Rollup

The following procedure briefly describes how to install Exchange 2000 Server Service Pack 3 Rollup
on PIMSI Engine machines and Exchange Connector machines. This patch contains critical fixes that
are applied to the Exchange System Management Tools, which the PIMSI Engine and Connector need
in order to communicate with Exchange Server.

This task is a step in “Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation”
on page 34.

NOTE: Exchange Server Service Pack 3 must be installed before you install Exchange Server Service
Pack 3 Rollup. Be sure to complete both tasks.

To install Exchange Server Service Pack 3 Rollup
1 Open a browser window on your target server and navigate to the following URL:

http://www.microsoft.com/downloads/details.aspx?Familyld=43F5CDF6-D1E6-4476-B5F2-
E17371236C3C&displaylang=en

2 Create a new folder on your local hard disk.
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3 Download the EXE file into the folder you created by clicking on the Download button on the Web
page.

4 Open the folder on your local hard disk, and then double-click the EXE file, and follow the
installation instructions.

5 In the Unzip to Folder dialog box, enter the location of the folder you created, and then click
unzip.

6 When the self-extraction process is complete, click OK, and then click Close.

7 Run the installation package from the directory folder you created.

Installing MSXML 4.0 SP2

The following procedure briefly describes how to install MSXML 4.0 SP2 on PIMSI Engine machines
and Exchange Connector machines.

This task is a step in “Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation”
on page 34.

To install MSXML 4.0 SP2
1 Open a browser window on your target server and navigate to the following URL:

http://www.microsoft.com/downloads/details.aspx?familyid=3144b72b-b4f2-46da-b4b6-
c5d7485f2b42&lanuageid=f49e8428-7071-4979-8a67-3cffcbh0c2524&displaylang=en

2  Click the Download link on the Web page.

Download the installation package and install the software.

Checking Domain Controller Properties

For optimum SSSE performance, install PIMSI Engine and Exchange Connector on machines in a
domain whose initially installed Domain Controller (DC) includes a copy of the Active Directory Global
Catalog (GC).

The following procedure briefly describes how to determine whether a Domain Controller contains a
copy of the catalog. This task is a step in “Process of Preparing Microsoft Exchange 2000 Environment
for SSSE Installation” on page 34.

To check Domain Controller properties

1 On a Domain Controller machine, navigate to Start > Programs > Administrative Tools > Active
Directory Sites and Services.

Locate the correct site and select the Domain Controller server in the Servers folder.
Expand the server object.

Select NTDS Settings, and then right-click and select Properties.
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5 Click the General tab, and inspect the Global Catalog check box.

If the Global Catalog check box is selected, then the Domain Controller contains a copy of the
Active Directory Global Catalog.

Process of Preparing Microsoft Exchange
2003 Environment for SSSE Installation

Preinstallation tasks differ depending on which version of Microsoft Exchange Server you are using.
This topic describes the process of preparing a Microsoft Exchange Server 2003 environment before
installing SSSE. For information about preparing a Microsoft Exchange 2000 Server environment, see
“Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation” on page 34.

This process is a step in “Roadmap for Installing SSSE” on page 33.

To prepare a Microsoft Exchange Server 2003 environment before installing SSSE, perform the
following tasks. Except where otherwise indicated, perform these tasks on each PIMSI Engine
machine and each Exchange Connector machine:

1 “Installing Exchange 2003 System Management Tools” on page 37

2 “Installing Exchange 2003 Server Service Pack 1” on page 38

3 “Installing MSXML 4.0 SP2 (for Exchange 2003)” on page 38

4 “Checking Domain Controller Properties (for Exchange 2003)” on page 38

NOTE: In addition to the software requirements listed here, a compatible version of Internet
Information Services Manager (I1ISM) must reside on the Microsoft Exchange Server machine.

Installing Exchange 2003 System Management Tools

The following procedure briefly describes how to install Exchange 2003 System Management Tools
on Exchange Connector machines.

This task is a step in “Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation”
on page 37.

NOTE: This task must be performed for all Exchange Connector machines, but is not required for
PIMSI Engine machines that do not run Exchange Connector.

To install the Exchange 2003 System Management Tools
1 Insert the Exchange 2003 installation CD into your target server.

2 From the Exchange 2003 Setup choose the Custom setup.

3 From the Custom setup screen install only the Exchange System Management Tools.
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Installing Exchange 2003 Server Service Pack 1

The following procedure briefly describes how to install Exchange 2003 Server Service Pack 1 on
PIMSI Engine machines and Exchange Connector machines.

This task is a step in “Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation”
on page 37.

To install Exchange 2003 Server Service Pack 1

1 On the machine where you want to install the software, open a browser window and navigate to
the following URL:

http://www.microsoft.com/downloads/details.aspx?FamilylD=42656083-784d-4e7e-b032-
2cb6433bec00&DisplayLang=en

2 Create a folder named SP1 on the machine’s local hard disk, or in another network-accessible
location.

(You can either download this software to each machine where you want to install it, or you can
download it to one network-accessible location, and install the software from that location for
each applicable machine.)

3 Download the E3SP1ENG.exe file into the SP1 folder by clicking the E3SP1ENG.exe link on the
Web page.

Open the SP1 folder, and then double-click E3SP1ENG.exe.
In the Unzip To Folder dialog box, enter the location of the SP1 folder, and then click Unzip.

When the self-extraction process is complete, click OK, and then click Close.

N o g b

Run the installation package from the SP1 directory.

Installing MSXML 4.0 SP2 (for Exchange 2003)

The process of installing MXSXML 4.0 SP2 in an Exchange 2003 environment is the same as in an
Exchange 2000 environment. For more information about installing MSXML, see “Installing MSXML
4.0 SP2” on page 36.

This task is a step in “Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation”
on page 37.

Checking Domain Controller Properties (for Exchange
2003)

The process of checking Domain Controller properties in an Exchange 2003 environment is the same
as in an Exchange 2000 environment. For more information, see “Checking Domain Controller
Properties” on page 36.
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This task is a step in “Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation
on page 37.

Configuring Firewalls for Use With SSSE

If your SSSE implementation includes firewalls between components, you must open specific ports
in the firewall to allow the various parts of the implementation to communicate with each other. This
topic briefly describes how to configure your firewall for use with SSSE. This task is a step in
“Roadmap for Installing SSSE” on page 33.

Firewall Located Between PIMSI Engine and Exchange Connector

A typical location for a firewall is between a Siebel Server that hosts a PIMSI Engine and a machine
that runs the Siebel Exchange Connector. If this is where your firewall is located, have the firewall
administrator open the ports listed in Table 10, and configure your Siebel Server to use the same
range of ports for DCOM.

Table 10. Ports for a Firewall Located Between PIMSI Engine and Exchange Connector

Traffic Type Firewall Port to Open

DCOM Port range of your choosing, as
described in the Microsoft
Developer’s Network article called
Using Distributed COM with Firewalls
(http://msdn2.microsoft.com/en-us/
library/ms809327.aspx).

NOTE: DCOM traffic requires the use of actual IP
addresses. Firewalls that translate network addresses
prevent proper operation. Therefore, Microsoft does not
support DCOM calls that are made over Network Address
Translation (NAT)-based firewalls. For more information
about using DCOM with firewalls, see http://
support.microsoft.com/kb/248809/en-us (Article #248809
on the Microsoft Support Web site).

End Point Mapper (EPM)/ Service Control Manager (SCM) 135

LDAP 389

LDAP to Global Catalog Server 3268
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Firewall Located Between Exchange Connector and Exchange Server
It is possible (but not recommended) to place a firewall between a machine that runs the Siebel
Exchange Connector and the Microsoft Exchange Servers that the Exchange Connector
communicates with. In this case, the firewall administrator must open additional ports, such as those
as listed in Table 11. On your Siebel Server, be sure to configure corresponding port numbers and
port number ranges.

Table 11. Ports for a Firewall Located Between Exchange Connector and Exchange Server

Traffic Type Firewall Port to Open

End Point Mapper (EPM)/ Service | 135
Control Manager (SCM)

HTTP 80 or your designated HTTP port

LDAP 389

LDAP to Global Catalog Server 3268

MAPI to Exchange 2000/2003 Values of your choosing, as described in Article #270836 on the
Microsoft Support Web site, Exchange Server Static Port
Mappings (http://support.microsoft.com/kb/270836/en-us).

NOTE: As described in this article, you must create registry
entries on the Exchange Server machine that specify static
MAPI ports.

RPC (Remote Procedure Calls) Port range of your choosing, as described in Article #154596 on
the Microsoft Support Web site, How to Configure RPC Dynamic
Port Allocation to Work with Firewalls (http://
support.microsoft.com/kb/154596).

Installing Siebel Server for PIMSI
Dispatcher

The first part of the SSSE installation process is to install Siebel Enterprise Server software on the
machine that will host the PIMSI Dispatcher server component and your Siebel application (such as
Siebel Sales).

NOTE: For optimal performance, it is recommended that you run the PIMSI Dispatcher component
and the PIMSI Engine component on separate machines.

This task is a step in the process that is outlined in “Roadmap for Installing SSSE” on page 33.

The installation of Siebel Enterprise Server software for PIMSI Dispatcher must have the following
characteristics:
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B Beginning with the version 7.7 base build, install and configure the Siebel Server components.
Select the Custom installation type and make sure you select PIM Server Integration for
installation.

CAUTION: If you do not select PIM Server Integration when you install version 7.7, the
installation program does not install SSSE portions of Maintenance Releases and Fix Pack
Releases such as 7.7.2 and 7.7.2.3.

B Choose a language that is supported for SSSE. For more information, see Siebel System
Requirements and Supported Platforms on Siebel SupportWeb.

B After the installation of files is complete, continue following prompts to configure the Siebel
Server software components.

For more detailed information about how to perform this task, see Siebel Installation Guide for the
operating system you are using.

Installing Siebel Server for PIMSI
Engine

The next part of the SSSE installation process is to install Siebel Enterprise Server software on the
machine that will host the PIMSI Engine server component. This server will be part of the Enterprise
you created in “Installing Siebel Server for PIMSI Dispatcher” on page 40.

NOTE: For optimal performance, it is recommended that the PIMSI Dispatcher component and the
PIMSI Engine component be run on separate machines.

This task is a step in the process that is outlined in “Roadmap for Installing SSSE” on page 33.

CAUTION: Never install Microsoft Outlook on a machine that will run the Siebel Exchange Connector
application, because Outlook overwrites a critical Exchange library with a less functional version.

The installation of Siebel Enterprise Server software for PIMSI Engine must have the following
characteristics:

B Beginning with the version 7.7 base build, install and configure the Siebel Server software
component on a supported Windows platform. For more information, see Siebel System
Requirements and Supported Platforms on Siebel SupportWeb. Select the Custom installation
type and make sure you select PIM Server Integration for installation.

CAUTION: If you do not select PIM Server Integration when you install version 7.7, the
installation program does not install SSSE portions of Maintenance Releases and Fix Pack
Releases such as 7.7.2 and 7.7.2.3.

B Choose a language that is supported for SSSE. For more information, see Siebel System
Requirements and Supported Platforms on Siebel SupportWeb.

B After the installation of files is complete, continue following prompts to configure the Siebel
Server software component.
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B Make a mental note of the Windows User Account Name and Windows User Account Password
that you specify. You will need to use the same account name and password later in the
configuration process, when you configure the DCOM security settings for the connector
application.

For more detailed information about how to perform this task, see Siebel Installation Guide for the
operating system you are using.

For information about configuring SSSE, after the installation is complete, see Chapter 5, “Configuring
Siebel Server Sync.”

Installing Siebel Exchange Connector

Siebel Exchange Connector software acts as the liaison between PIMSI Engine and the Microsoft
Exchange Server. This topic describes how to install Exchange Connector software. This task is a step
in “Roadmap for Installing SSSE” on page 33.

Exchange Connector software can run on the same machine as PIMSI Engine, or it can run on a
separate machine that is equipped with the sspicnea.exe executable file and certain SSSE DLLs. Any
Exchange Connectors that reside on machines that do not contain PIMSI Engines are known as remote
Exchange connectors.

When you install PIMSI Engine, Exchange Connector software is automatically installed on the same
machine. Whether or not you use the Exchange Connector software on a PIMSI Engine machine
depends on later configuration steps.

There is no stand-alone installation available for remote Exchange Connectors. The following
procedure describes how to install a remote Exchange Connector.

CAUTION: Never install Microsoft Outlook on a machine that will run the Siebel Exchange Connector
application, as Outlook overwrites a critical Exchange library with a less functional version.

To install a remote Exchange Connector

B On a machine that does not contain PIMSI Engine software, follow the installation instructions
found in “Installing Siebel Server for PIMSI Engine” on page 41.

NOTE: For remote Exchange Connector machines, do not enable or run the Siebel Server or
PIMSI Engine or PIMSI Dispatcher software that is installed along with the Exchange Connector.
Configuration values for the Server, Engine, and Dispatcher can be arbitrary, since the remote
Exchange Connector machine will not use them.

For information about configuring Exchange Connectors on PIMSI Engine machines and remote
Exchange Connectors, see Chapter 5, “Configuring Siebel Server Sync.”
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This chapter provides instructions for configuring SSSE after installation. It includes the following
topics:

B “Process of Configuring SSSE” on page 44

B “Modifying the Database” on page 44

B “Modifying the Repository” on page 45

B “Modifying Seed Data” on page 49

B “Verifying SSSE Component Definitions” on page 52

B “About Tuning SSSE for Optimal Performance” on page 55

B “Setting Up the Connector Share Directory” on page 56

B “About Exchange Service Account Privileges” on page 58

B “Configuring Exchange Service Account Credentials” on page 58

B “Setting System Preferences for SSSE” on page 61

B “Configuring the Database for SSSE” on page 61

B “Populating DB_LAST_UPD Columns” on page 63

B “Configuring the 11S Web Server for Exchange” on page 64

B “Configuring Exchange Connector Application DCOM Security” on page 65
B “Designating Trusted Exchange Servers” on page 69

B “Modifying Log File Settings” on page 70

B “Configuring the Generic Siebel Organizer” on page 71

B “Configuring the Default Account” on page 72

B “Tuning SSSE Siebel Profile Parameters” on page 73

B “About Mapping Exchange Connectors to Exchange Servers” on page 76
B “About Using Exchange Virtual Directories” on page 78

B “Configuring Exchange Connector Parameters” on page 79

B “Enabling and Disabling Components on SSSE Servers” on page 84

B “Restarting Siebel Services” on page 84

B “Configuring and Starting PIMSI Dispatcher” on page 85

|

“Setting Exchange Connector Log Levels” on page 86
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Process of Configuring SSSE
To configure SSSE, perform the following tasks:

“Modifying the Database” on page 44

“Modifying the Repository” on page 45

“Modifying Seed Data” on page 49

“Verifying SSSE Component Definitions” on page 52

1
2
3
4
5 “Setting Up the Connector Share Directory” on page 56
6 “Configuring Exchange Service Account Credentials” on page 58

7 “Setting System Preferences for SSSE” on page 61

8 “Configuring the Database for SSSE” on page 61

9 “Populating DB_LAST_UPD Columns” on page 63

10 “Configuring the 11S Web Server for Exchange” on page 64

11 “Configuring Exchange Connector Application DCOM Security” on page 65
12 “Designating Trusted Exchange Servers” on page 69

13 “Modifying Log File Settings” on page 70

14 “Configuring the Generic Siebel Organizer” on page 71

15 “Configuring the Default Account” on page 72

16 “Tuning SSSE Siebel Profile Parameters” on page 73

17 “Configuring Exchange Connector Parameters” on page 79

18 “Enabling and Disabling Components on SSSE Servers” on page 84

19 “Restarting Siebel Services” on page 84

20 “Configuring and Starting PIMSI Dispatcher” on page 85

The following configuration task is optional:

B “Setting Exchange Connector Log Levels” on page 86

Modifying the Database

SSSE requires certain database characteristics that were not included in earlier versions of Siebel
7.7 software. The following procedure describes how to modify your Siebel database to make it
compatible with SSSE.
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To modify your Siebel database for use with SSSE

1 Using the documentation provided by your database manufacturer, set the database server time
zone to GMT Greenwich / Monrovia.

SSSE relies on Server Request Processor and Server Request Broker. For these server
components to work correctly, the server must use GMT.

2 Drop the index S_SD_SV_PROFILE_F1.
If this index is not dropped, later parts of the configuration process will fail.

If this index is dropped, as described here, it is recreated automatically as part of later
configuration operations.

Modifying the Repository

SSSE requires certain repository characteristics that were not included in earlier versions of Siebel
7.7 software. You must modify the repository, then compile and deploy a new Siebel Repository File
(SRF).

In order to modify the repository correctly, you must check out certain projects in Siebel Tools, and
then import certain SIF files. Table 12 lists these projects and files for your reference as you carry
out the procedure that follows.
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Table 12.

SIF File Name
7722-SSSE-HOR-Base.sif

SIF Files to Import and Associated Projects to Check Out

Projects to Check Out Before Importing

SIF

Table Activity

Comments

Adds the
DB_LAST_UPD

% Table Employee column to tables
B Table Opty and adds or
B Table Organization ypdates _some
indexes in the
B Table Party Siebel Business
B Table Person Applications
database.
B Table Project
I Table Service Request
7722-SSSE-SIA-Base.sif B Table Activity Adds the
DB_LAST_UPD
% Table Employee column to tables
B Table Opty and adds or
I Table Organization ypdates _some
indexes in the
B Table Party Siebel Industry
B Table Person Applications
database.
I Table Project
I Table Service Request
7722-SSSE-ServerDomain.sif | B Table ServerDomain Makes data model
changes to SSSE
objects.
7722-SSSE-Objects.sif B PIM Server Integration Updates existing
. and creates new
B PIM Server Integration (Ul) SSSE repository
B PIM Server Integration Engine objects for the
B PIM Server Integration Workflows Sleb?l B_usmess
Applications
B PIM Server Integration Workflows Level2 | database.
7722-SSSE-SIA-Objects.sif B PIM Server Integration Updates existing
. and creates new
B PIM Server Integration (Ul) SSSE repository
B PIM Server Integration Engine objects for the
. i 11
B PIM Server Integration Workflows Sleb? 'tldus”y
Applications
B PIM Server Integration Workflows Level2 | database.
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Importing these SIF files causes changes in certain database tables. For information about which
tables are changed by which SIF files, see Table 13. You will need this information during the
procedure that follows.

Table 13. Tables That SIF Files Change

SIF File Name Changed Tables

7722-SSSE-HOR-Base.sif and 7722-SSSE-SIA- S_ACT_CONTACT
Base.sif S_ACT_EMP
S_ADDR_ORG
S_ADDR_PER
S_CONTACT
S_CONTACT_BU
S_CONTACT_INFO
S_EVT_ACT
S_OPTY
S_ORG_EXT
S_PARTY
S_POSTN
S_POSTN_CON
S_PROJ
S_SRV_REQ
S_USER

7722-SSSE-ServerDomain.sif S_SD_EXCH_STATE
S_SD_PIM_ROW
S_SD_SRCKEY
S_SD_STATE_DATA
S_SD_SV_PROFILE
S_SD_SYNC_INFO
S_SD_USERMAP_TS
S_SD_USER_MAP

S_SD_USR_ACCESS

S_SVRDOMAIN_EXT
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The following procedure briefly describes how to modify your Siebel repository to make it compatible
with SSSE.

NOTE: Several steps in the following procedure require you to overwrite object definitions in the
repository. This is necessary because SSSE requires that you remove some parameters from the SRF.

To modify your Siebel repository for use with SSSE
1 In Siebel Tools, check out the appropriate projects, and then import one of the following SIF files:

m For Siebel Business Applications, import the file 7722-SSSE-HOR-Base.sif
m For Siebel Industry Applications, import the file 7722-SSSE-SIA-Base.sif

For conflict resolution, select Merge. This will preserve any customizations you have made to your
tables. If you have not customized your tables, you can select Overwrite the object definition in
the repository, instead. For the list of projects that must be checked out for the SIF import to
succeed, see Table 12 on page 46.

2 Check out the appropriate projects, and then import the SIF file 7722-SSSE-ServerDomain.sif.

For conflict resolution, select Overwrite the object definition in the repository. For the list of
projects that must be checked out for the SIF import to succeed, see Table 12 on page 46.

3 Make sure there are no Siebel Servers running against the database.

If servers are running, there will be errors in the next step because the tables that need to be
changed will still be in use.

4 Apply the database table changes by using the Siebel Tools Apply feature.

To use the feature, query for all changed tables, and then apply the changes to the entire query
(select Current for the tables in the dialog). Make sure that all tables listed in Table 13 on page 47
are listed in the query results or other steps in the configuration may fail.

If not all of the tables appear in your query, manually apply the database changes for each of
the tables listed in Table 13 on page 47 by selecting each table and clicking Apply.

For more information about applying changes in Siebel Tools, see Configuring Siebel eBusiness
Applications.

5 Check out the appropriate projects, and then import one of the following SIF files:
m For Siebel Business Applications, import the file 7722-SSSE-Objects.sif
B For Siebel Industry Applications, import the file 7722-SSSE-SIA-Objects.sif

For conflict resolution, select Overwrite the object definition in the repository. For the list of
projects that must be checked out for the SIF import to succeed, see Table 12 on page 46.

6 Compile the SRF.

Be sure to check out the new PIM Server Integration Extract Only project and include it among
the projects you select before compiling.

48 Siebel Server Sync Guide Version 7.7, Revision A



Configuring Siebel Server Sync B Modifying Seed Data

7 Deploy the new SRF to your Siebel Servers.

NOTE: If you are applying 7722-SSSE-HOR-Base.sif in a Microsoft SQL database, certain errors are
common—Microsoft SQL servers have an 8K page size and they report errors if any rows that have
all columns populated will not be stored. You can ignore the following errors unless you intend to
populate all columns in these tables:

B 01000 (1708): [Microsoft][ODBC SQL Server Driver][SQL Server]Warning: The table
'S_ORG_EXT" has been created but its maximum row size (12201) exceeds the maximum number
of bytes per row (8060). INSERT or UPDATE of a row in this table will fail if the resulting row
length exceeds 8060 bytes.

B 01000 (1708): [Microsoft][ODBC SQL Server Driver][SQL Server]Warning: The table
'S_EVT_ACT' has been created but its maximum row size (9513) exceeds the maximum number
of bytes per row (8060). INSERT or UPDATE of a row in this table will fail if the resulting row
length exceeds 8060 bytes.

Modifying Seed Data
SSSE requires changes to the seed data that was included in earlier versions of Siebel 7.7 software.

CAUTION: It is important to remove obsolete seed data before importing new seed data. Failure to
remove obsolete seed data can result in unpredictable software behavior.

The following three procedures describe how to modify your seed data to make it compatible with
SSSE. Perform these procedures in the order shown here.

To remove obsolete seed data before configuring SSSE

1 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > PIM Domains.

2 In the PIM Domains list, select each of the following records and then click Delete.
m Batch Extract
m Exchange Source Key Domain

3  From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Configuration.

4 In the PIM Server Integration Configuration list, select Queue Configuration Template and then
click Delete.

5 Click the LOV Translation tab.

Siebel Server Sync Guide Version 7.7, Revision A 49



Configuring Siebel Server Sync & Modifying Seed Data

6 In the LOV Translation list, select each of the records that are listed in the following table, and

then click Delete.

Name PIM Value

Country

United States Of America

Exchange Time Zone*

Abu Dhabi, Muscat
Adelaide, Central Australia
Almaty, Novosibirsk
Athens, Istanbul, Minsk
Bangkok, Hanoi, Jakarta
Brisbane (4 items)
Bucharest

Buenos Aires, Georgetown
Caracas, La Paz

Baku, Thilisi, Yerevan
Eniwetok, Kwajalein

Fiji, Kamchatka, Marshall Is.

Greenwich Mean Time - Dublin,
Edinburgh, London (2 items)

Helsinki, Riga, Tallinn

Irkutsk, Ulaan Bataar

Islamabad, Karachi, Tashkent

Kolkata, Chennai, Mumbai, New Delhi
Kuala Lumpur, Singapore (4 items)
Magadan, Solomon Is., New Caledonia
Midway Island, Samoa

Moscow, St. Petersburg, Volgograd
Osaka, Sapporo, Tokyo (2 items)

Pacific Time (US & Canada), Tijuana (2
items)

Sarajevo, Skopje, Sofija, Vilnius, Warsaw,
Zagreb (8 items)

Wellington, Auckland
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To import required seed data for use with SSSE

1

From the application-level menu, select Navigate > Site Map > Administration - Integration >
Data Map Editor, and then perform the following substeps:

a In the Integration Object Map list, click the Menu button and select Import Data Map.

b In the EAI EAI Import dialog box, enter the file name SSSE_Data_Maps.XML and then click
Import.

From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains, and then perform the following substeps:

a In the Siebel Domains list, click the Menu button and select Import Siebel Domain.

b Inthe PIM Server Integration Import dialog box, enter the file name SSSE_Siebel_Domain.XML
and then click Import.

C Inthe Siebel Domains list, select a domain, and then click Sync Fields in the Siebel Domain Fields
list.

Repeat this step for each Siebel Domain record.

From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > PIM Domains, and then perform the following substeps:

a In the PIM Domains list, click the Menu button and select Import PIM Domain.

b In the PIM Server Integration Import dialog box, enter the file name SSSE_PIM_Domain.XML
and then click Import.

From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Domain Map, and then perform the following substeps:

a In the Domain Map list, click the Menu button and select Import Domain Map.

b In the PIM Server Integration Import dialog box, enter the file name SSSE_Domain_Map.XML
and then click Import.

From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Configuration > PIM Server Integration Configuration, and then perform the
following substeps:

a In the PIM Server Integration Configuration list, click the Menu button and select Import
Configuration.

b In the PIM Server Integration Import dialog box, enter the file name SSSE_Server_Config. XML
and then click Import.

Click the LOV Translation tab, and then perform the following substeps:
a In the LOV Translation list, click the Menu button and select Import Translation.

b In the PIM Server Integration Import dialog box, enter the file name SSSE_PIM_Translation.XML
and then click Import.

To add seed data Lists of Values (LOVs) for use with SSSE

1

From the application-level menu, select Navigate > Site Map > Administration - Data > List of
Values.
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2 In the List of Values list, click New to create a new record, and complete the fields as described

in the following table.

Repeat this step as needed to create all the records shown in the table. For general information
about creating LOV records, see Applications Administration Guide.

Display Value

Translate

Language-
Independent
Code Parent LIC Code

LOV_TYPE PIMSI_VISIBILITY N PIMSI_VISIBILITY

PIMSI_VISIBILITY PersonalContact N PersonalContact

PIMSI_VISIBILITY Business Contact N Business Contact

PIMSI_VISIBILITY Employee N Employee

PIMSI_VISIBILITY Calendar N Calendar

PIMSI_VISIBILITY Task N Task

PIMSI_VISIBILITY Sales Rep N Sales Rep Business Contact
PIMSI_VISIBILITY All N All Business Contact
PIMSI_VISIBILITY Personal N Personal Calendar
PIMSI_VISIBILITY Personal N Personal Task
PIMSI_VISIBILITY Personal N Personal PersonalContactl

1. Note that there is no space in the PersonalContact language-independent code or display value.

Verifying SSSE Component Definitions

SSSE uses two server components, PIMSI Engine and PIMSI Dispatcher. The following procedure
describes how to configure these components correctly. This task is a step in “Process of Configuring

SSSE” on page 44.

To verify server component definitions

1 From the Siebel application menu, choose Navigate > Site Map > Administration - Server

Configuration > Enterprises > Component Definitions.

2 In the Component Definitions list, use standard query techniques to locate records where

Component matches PIMSI*.

3 If records exist with aliases of PIMSIEng or PIMSIDispatcher, select these records and click

Delete.
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In the Component Definitions list, click New to create a new record, and complete the fields as
described in the following table.

Field Value

Component PIMSI Dispatcher
Alias PIMSIDispatcher
Component Type PIMSI Engine Service (with Batch as the Runtime value)

NOTE: Once the record is saved, this value automatically changes
to Business Service Manager.

Component Group PIM Server Integration Management

With the PIMSI Dispatcher record selected in the Component Definitions list, set the following
values in the Component Parameters list:

For more information about the Maximum Tasks parameter, see “About Tuning SSSE for Optimal
Performance” on page 55.

Business Service Name PIMSI Engine Service
Method Name GenerateExtractRegMsgs
Maximum MT Servers 1

CAUTION: If Maximum MT Servers is set to a
greater value than 1, unpredictable results

may occur.

Maximum Tasks 10

Key Based Enabled TRUE

Application Repository File B For Siebel Business Applications, enter
siebel.srf

B For Siebel Industry Applications, enter
siebel_sia.srf

In the Component Definitions list, click New to create a new record, and complete the fields as
described in the following table.

Field Value

Component PIMSI Engine

Alias PIMSIEng
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12
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Field Value

Component Type PIMSI Engine Service (with Batch as the Runtime value)

NOTE: Once the record is saved, this value automatically
changes to Business Service Manager.

Component Group PIM Server Integration Management

With the PIMSI Engine record selected in the Component Definitions list, set the following values
in the Component Parameters list:

Business Service Query Access SSSE Address Parser (eScript)

Business Service Name PIMSI Engine Service

Method Name BusSvcMgrinit

Maximum MT Servers 1

Maximum Tasks 10

Application Repository File B For Siebel Business Applications, enter
siebel.srf

B For Siebel Industry Applications, enter
siebel_sia.srf

NOTE: The Siebel database and Exchange differ in how they store addresses. The Business
Service Query Access parameter specifies the name of the script that will be used to combine
two Siebel address field values when transmitting address data to Exchange, and split one
Exchange address field value into two values when transmitting address data to the Siebel
database.

From the Siebel application menu, choose Navigate > Site Map > Administration - Server
Configuration > Enterprises > Component Definitions.

In the Component Definitions list, use standard query techniques to locate records where
Component matches PIMSI*.

For each of the components PIMSIDispatcher and PIMSIEng, select the component record, and
then click Enable.

In the Component Definitions list, select PIMSIDispatcher and PIMSIEng, and then click
Synchronize.

When synchronization is complete, verify that the PIMSI Dispatcher component and the PIMSI
Engine component exist.

On the machine that hosts the PIMSI Dispatcher component, restart the Siebel Server.
For information about restarting Siebel Servers, see Siebel System Administration Guide.

On the machine that hosts the PIMSI Engine component, restart the Siebel Server.
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About Tuning SSSE for Optimal
Performance

In general, SSSE works well when you configure your Siebel implementation using the scalability and
sizing recommendations that are discussed in Siebel Performance Tuning Guide. For example, you
can set server component parameters such as MaxMTServers and MinMTServers parameters to the
values that suit your implementation as a whole, without especially considering SSSE performance
issues. However, this topic discusses some configuration recommendations that are particularly
important for ensuring optimum performance for SSSE. You will need this information in order to
make the best use of two other topics in this chapter: “Verifying SSSE Component Definitions” on
page 52 and “Configuring Exchange Connector Parameters” on page 79.

In an SSSE implementation, two key parameters are MaxUsers and MaxTasks (also called Maximum
Tasks). MaxUsers is an Exchange Connector parameter; MaxTasks is a PIMSI Engine server
component parameter.

MaxUsers

The MaxUsers parameter defines the maximum number of users that can be assigned to each
instance of the Exchange Connector. You may want to modify the value of this setting depending on
whether your Siebel implementation will be adding many new SSSE users in the near future:

B If you need to add many new SSSE users, it is recommended that you set the MaxUsers
parameter to a very low value, perhaps even the minimum value of 1. This is because all users
of an Exchange Connector instance compete for the instance’s single communication channel to
the Exchange Server. Ongoing synchronizations rarely take long enough to cause problematic
delays for other users of the same Connector instance, but initial extracts can monopolize a
Connector’s communication channel for significant time periods. To prevent any user’s
synchronization from ever being delayed while another user’s initial extract completes, you can
set MaxUsers to a value of 1, meaning that there is a dedicated Exchange Connector instance for
each user being synchronized.

NOTE: This configuration uses a comparatively large amount of memory on the machines that
run Exchange Connector instances—each instance uses about 25 MB of memory.

B If you add few new SSSE users, you can set the MaxUsers parameter to a higher value. This
uses less memory for Connector instances, at the risk of occasional synchronization delays when
an initial extract is in progress.

MaxTasks

The MaxTasks setting controls the total number of users who are synchronized at one time. The value
you choose for MaxTasks can limit the total number of Connector instances that run at any one time,
preventing the Connector machines from getting overloaded.

Selecting and Testing MaxUsers and MaxTasks Values

The exact settings to use for your implementation depend on the hardware you use. Each Connector
instance uses about 25 MB of memory. As an example, if you have between 1 and 2 GB of memory
available for Connector instances to use, you could set MaxUsers to 1 and set MaxTasks to 50.
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Perform some initial extract test runs to assess the amount of CPU and memory that are used with
your initial parameter settings. Check the Connector machines and the Siebel Servers where your
PIMSI Engine components are running. If you have ample CPU and memory still available, you can
try increasing the value of MaxTasks.

At a later time, if initial extracts become comparatively rare, you may find that you obtain better
performance by setting MaxUsers to a higher value.

Choosing an Appropriate Dispatcher Repeat Interval

When you are satisfied with your MaxUsers and MaxTasks setting values, you may want to measure
how quickly SSSE can process your entire population of ongoing SSSE users. You can use the
information to adjust the values of the Repeating Info settings for the PIMSI Dispatcher job, so that
the Dispatcher runs at an interval of your choosing. The optimum interval is one that is longer than
the length of time needed for the Dispatcher to process your ongoing SSSE users. The easiest way
to ensure this is to set Repeat From to a value of End, meaning that each Dispatcher cycle is started
at a specific interval after the end of the previous cycle. If you prefer, you can set Repeat From to
Start, instead. In that case, it is recommended that you set Repeat Interval to a value that is greater
than the length of time needed for the Dispatcher to process your current ongoing users.

For more information about setting up PIMSI Dispatcher jobs, see “Configuring and Starting PIMSI
Dispatcher” on page 85.

Setting Up the Connector Share
Directory

In SSSE’s modular architecture, the Exchange Connector module provides the interface through
which the PIMSI Engine communicates with an Exchange server. For the Siebel-provided Exchange
connector, installation-specific configuration is required.

A portion of the Exchange Connector is a COM (Component Object Model) application. SSSE starts
COM applications as needed. COM applications can run on any machine that hosts the Exchange
Connector software, including any machine that hosts the PIMSI Engine component. For a COM
application to function correctly, you must create a local shared directory on the machine where the
COM application will run. The security and permissions for the shared directory should be configured
to give the user account that runs PIMSI Engine full access rights to the directory. This user is
sometimes called the SSSE startup user. For more information about security requirements for COM
applications, see “Configuring Exchange Connector Application DCOM Security” on page 65.

Perform the following tasks to create a shared directory, and then register its location with SSSE.

You must create a shared directory on each machine that will run the Exchange Connector
applications, and then register the location of the shared directory with SSSE, as described in the
following procedures. These tasks are steps in “Process of Configuring SSSE” on page 44.
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To create the shared connector directory

1

a A W N

(o))

To

On each machine where the Exchange Connector is installed, create a new folder.
The folder name can be any name you choose.

Right-click the folder, and choose Sharing and Security.

In the Properties dialog box, select Share This Folder and enter a share name.
Click Permissions to display the Permissions for <ShareName> dialog box.

Click Add and enter the user name that the PIMSI Engine component runs under.
If you want to increase security, also select Everyone and click Remove.

Click OK to display the Properties dialog box, and click the Security tab.

Enter the user name that the PIMSI Engine component runs under.

If you want to increase security, also select Everyone and click Remove.

Click OK twice.

register the shared directory with SSSE

From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Configuration > PIM Server Integration Configuration.

In the PIM Server Integration Configuration list, select the Exchange 2000 Connector record.

In the Configuration Parameters list, click New, and then complete the fields as described in the
following table.

Field Value

Section Engine Shares
Parameter Sharen (where n is a unique number for each shared directory)
Value <share pathname=> (Example: \\MachineName\ ShareName, where

MachineName is the name of the Connector machine and ShareName is the
name designating the shared directory.)

Repeat Step 3 for each shared directory that you created. Increment the Parameter value to
match the instance of the Exchange Connector software.

For example, use either Sharel or ShareO1 for the first Exchange Connector instance, and
Share2 or Share02 for the second Exchange Connector instance, and so on.

Restart the Siebel Servers on your PIMSI Dispatcher and PIMSI Engine machines.

For information about restarting Siebel Servers, see Siebel System Administration Guide.

Siebel Server Sync Guide Version 7.7, Revision A 57



Configuring Siebel Server Sync & About Exchange Service Account Pr

About Exchange Service Account
Privileges

The Exchange Connector requires certain privileges in order for SSSE to function properly. This topic
describes the necessary privileges.

The user name that the Exchange Connector runs under (the Exchange service account) must have
administrative privileges including read/write access to the Exchange mailboxes of all users who will
synchronize using SSSE. The account must be a domain account, not a local account.

You need only one Exchange service account for your whole Exchange infrastructure, regardless of
how many Exchange servers you have. Exchange servers are not listed in the Siebel database.
Instead, the Exchange Connector queries the Active Directory Global Catalog at runtime to determine
which Exchange Server handles the mailbox for a given user (SMTP email address).

The Exchange service account can be administered entirely by your Windows administrators. Siebel
administrators do not need to know the login credentials for the Exchange service account.

To manage the process of giving the Exchange service account read/write access to SSSE user
mailboxes, you can use a script that gathers information about the applicable users from the Siebel
User Map view. For more information about the script, see “Configuring Exchange Service Account
Credentials” on page 58. Alternately, you can place all Exchange mailboxes for SSSE users on one or
more designated Exchange servers, and give the connector read/write access at the server level, but
this approach is not recommended if Exchange user mailboxes are frequently moved between
Exchange Servers.

NOTE: For proper operation of SSSE, each user to be synchronized must have an activated Exchange
mailbox. The Exchange service account must also have an activated Exchange mailbox.

Configuring Exchange Service Account
Credentials

The Exchange Connector uses the credentials of the user name it runs under to interact with all of
the Exchange mailboxes in the Active Directory forest (one or more Active Directory domains that
share certain characteristics and information). This user is required to have an activated Exchange
mailbox account. Additionally, this user must have special mailbox access privileges in order to
access other users’ activated Exchange mailboxes. For more information about these privileges, see
“About Exchange Service Account Privileges” on page 58.

The task of configuring these credentials is a step in “Process of Configuring SSSE” on page 44.

Before you configure the credentials for your Exchange service account, use the following procedure
to check whether your account will need Send As privileges in addition to full mailbox access. Some
versions of Microsoft Exchange implicitly grant Send As privileges along with full mailbox access, and
other versions do not. The Exchange service account needs either implicit or explicit Send As
privileges.
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Determining whether to grant Send As privileges to your Exchange service account

1

Determine which version of Microsoft Exchange your Exchange server is running, and complete
the appropriate following substep:

E For Microsoft Exchange 2003, review Article #895949 on the Microsoft Support Web site,
“Send As” permission behavior change in Exchange 2003 (http://support.microsoft.com/kb/
895949).

m For Microsoft Exchange 2000, review Article #915358 on the Microsoft Support Web site,
A hotfix is available to change the behavior of the Full Mailbox Access permission in Exchange
2000 Server (http://support.microsoft.com/kb/915358/).

Determine which version of Store.exe your Exchange server is running.

m For Microsoft Exchange 2000 Server Service Pack 3 (SP3) and Store.exe version 6619.4 or
higher, plan to grant your Exchange service account explicit Send As privileges.

m For Microsoft Exchange Server 2003 Service Pack 1 and Store.exe file version of 7233.51 or
higher, plan to grant your Exchange service account explicit Send As privileges.

You will use this information in a later procedure.

The following procedures describe two ways of configuring the necessary credentials: a method that
uses a script, and a manual method.

Script Method. The method that uses a script is recommended if you need to provide the
Connector application with access to many users’ mailboxes, as would be typical during
deployment of SSSE. However, if you need to grant Send As privileges explicitly, you may need
to modify the script that is supplied by Oracle. For more information about Send As privileges in
various versions of Microsoft Exchange, see one or both of the articles that are listed in Step 1.

Manual Method. The manual method is recommended if you only need to grant access to a few
users’ mailboxes, such as when you want to enable synchronization for a few new employees.

NOTE: You can run the Exchange Connector application under the same user as the PIMSI Engine
component, or under a different user. Using different users separates Siebel security settings and
Exchange security settings as much as possible.

Configuring Credentials Using a Script

The following procedure uses the ssse_exchange2k3_permissions.vbs script to configure the security
settings that grant access to other users’ mailboxes for the user that the Exchange Connector
application runs under.

To configure Exchange service account credentials using a script

1

Verify that the user that the Exchange Connector will run under has an activated mailbox on the
Exchange server, or create and activate one if necessary.

Log in to your Siebel application as an administrator and navigate to Site Map > Administration
- PIM Server Integration > Sync Access Control > User Map.

In the User Map list, verify that the column names appear in the following order:

m Siebel User Login
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PIM Server Type
PIM User ldentifier

Language
®m  Sync Enabled
If necessary, use the Columns Displayed command to adjust the order of the columns.

4 In the User Map list, select the users who will use SSSE, and then click the menu button and
select Export.

5 In the Export dialog box, choose settings as described in the following table, and then click Next.

Setting Value

Rows to Export All Rows in Current Query
Columns to Export Visible Columns
Output Format Comma Separated Text File

6 In the File Download dialog box, click Save and then use standard Windows techniques to select
an output file name and location.

In the Export dialog box, click Close.

Use a text editor to open the file you saved, remove the column names, and then save the file
using the ANSI encoding option.

9 Follow the directions documented in the following script file, where install_directory is the
installation directory for your Siebel implementation:

install _directonAsiebsrvr\bin\ssse_exchange2k3_permissions.vbs

Configuring Credentials Manually
The following procedure describes how to manually configure the security settings that grant access
to other users’ mailboxes for the user that the Exchange Connector application runs under.

To configure Exchange service account credentials manually

1 Verify that the user that the Exchange Connector application runs under has a mailbox on the
Exchange server, or create one if necessary.

2 On any machine that has the Exchange System Management Tools installed (for example, the
Exchange Server or any Siebel Exchange Connector machine), start the Active Directory Users
and Computers console.

3  From the View menu, select Advanced Features.
4 In the Tree pane, select Users.
5 Perform the following substeps:

a In the Users pane, right-click the user name and choose Properties.
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b In the user’s Properties dialog box, click the Exchange Advanced tab.
On the Exchange Advanced tab, click Mailbox Rights.

In the Permissions for USERNAME dialog box, click Add and enter the user that SSSE is running
under.

e Click Check Names.
If there is no error message, click OK to return to the Permissions for USERNAME dialog box.
If there is an error message, correct the user name before continuing.

T In the Names list, make sure the user is selected.

g In the Permissions list, select the Allow check box for Full mailbox access.

h  If your version of Microsoft Exchange and Store.exe do not grant Send As privileges implicitly
with Full mailbox access, then also select the Allow check box for Send As.

6 Click OK twice to close the dialog boxes and put the Properties changes into effect.

7 Repeat Step 5 and Step 6 for each user who will use SSSE.

Setting System Preferences for SSSE
The following procedure describes how to set a system preference that SSSE requires.

This task is a step in “Process of Configuring SSSE” on page 44.

To set system preferences for use with SSSE

1 Log in to your Siebel application as an administrator and navigate to Site Map > Administration
- Application > System Preferences.

2 In the System Preferences list, select Universal Time Coordinated, and then enter TRUE in the
System Preference Value field.

Configuring the Database for SSSE

The next stage in configuring SSSE is to configure database triggers for SSSE, as described in the
following paragraphs.

This task is a step in “Process of Configuring SSSE” on page 44.
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Activating SSSE Database Triggers

SSSE relies on database triggers to guarantee correct operation. These triggers are not related to
Siebel workflows, but are native to and supported by the database. The following procedure briefly
describes how to install the triggers.

NOTE: After each use of the Generate Triggers server component, you must reinstall the database
triggers for SSSE, as described in this topic. (The GenTrig component removes all Siebel triggers on
the database.)

CAUTION: SSSE also includes triggers for position change, synchronization level change, and
visibility change. Do not change triggers in these areas without consulting with Siebel Expert
Services or Siebel Professional Services.

To install database triggers

1 On either your PIMSI Dispatcher machine or your PIMSI Engine machine, use the Windows
Explorer to navigate to install_director)\siebsrvr\bin, where install_directory is the
installation directory for your Siebel implementation.

2 Locate the SSSE_trigger_database_platform.sql script that is appropriate for your database, as
shown in the following table.

Database Platform Script File Name

IBM DB2 — Using Unicode ssse_triggers_db2.sql

IBM DB2/390 ssse_triggers_db2_390.sql
IBM DB2 — Using Code Page ssse_triggers_db2_cp.sql
Microsoft SQL Server ssse_triggers_mssql.sql
Oracle 8i ssse_triggers_ora8.sql
Oracle 9i or Oracle 10g ssse_triggers_ora9.sql

3 Use any text editor to modify the SQL script to replace the <change me> tags with the correct
name space for your database.

4 To enable the SSSE triggers in your environment, use the appropriate database utility for your
database platform to execute the script against your database.
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Populating DB_LAST_UPD Columns

If your Siebel implementation uses an Oracle or DB2/UDB database, then SSSE performance
optimization requires that you place data in the DB_LAST_UPD column of each of the Siebel tables
listed in Table 14 on page 63. These columns were added to the listed tables specifically for use by
SSSE. When SSSE makes queries related to these new columns, Oracle and DB2/UDB database
optimizer performance improves if the columns contain data.

Table 14. Database Tables and Indexes that Affect SSSE Performance

Table Index

S_ACT_CONTACT

S_ACT_CONTACT_M1(DB_LAST_UPD,ACTIVITY_ID)

S_ACT_EMP S_ACT_EMP_M5(DB_LAST_UPD,ACTIVITY_ID)
S_ADDR_ORG S_ADDR_ORG_M7(DB_LAST_UPD,ROW_ID)
S_ADDR_PER S_ADDR_PER_M6(DB_LAST_UPD,ROW_ID)
S_CONTACT S_CONTACT_M23(DB_LAST_UPD,PAR_ROW_ID)

S_CONTACT_BU

S_CONTACT_BU_M3(DB_LAST_UPD,CONTACT_ID)

S_CONTACT_INFO

S_CONTACT_INFO_M1(DB_LAST_UPD,
SYNC_FLG,TARGET_PER_ID)

S_EVT_ACT S_EVT_ACT_M12(DB_LAST_UPD,ROW_ID
S_OPTY S_OPTY_M10(DB_LAST_UPD,ROW_ID)
S_ORG_EXT S_ORG_EXT_M23(DB_LAST_UPD,PAR_ROW_ID)
S_PARTY S_PARTY_M5(DB_LAST_UPD,ROW._ID)
S_POSTN S_POSTN_M4(DB_LAST_UPD,PAR_ROW_ID)

S_POSTN_CON

S_POSTN_CON_M4(DB_LAST_UPD,CON_ID)

S_PROJ S_PROJ_M9(DB_LAST_UPD,ROW_ID)
S_SRV_REQ S_SRV_REQ_M12(DB_LAST_UPD,ROW_ID)
S_USER S_USER_M3(DB_LAST_UPD,ROW._ID)

The following procedure briefly describes how to populate these columns with the recommended

data.

NOTE: This task is highly recommended for Siebel implementations that use Oracle or DB2/UDB
databases. This task is not needed for Siebel implementations that use other database types.

To populate DB_LAST_UPD columns with data

1 For each Siebel table that is listed in Table 14 on page 63, use one of the following methods to
place data in the DB_LAST_UPD column of at least some rows:
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B Run a database script to copy the value of the LAST_UPD system field into the DB_LAST_UPD
field of the same record, then update your database statistics.

m If you are working in a Test environment where Contact, Calendar, and To Do records are
being modified as part of testing, enable database triggers for a time period that is long
enough to capture some changes in all of the tables listed in Table 14 on page 63 (for
example, perhaps one week), and then update your database statistics.

For more information about enabling these database triggers, see “Configuring the Database
for SSSE” on page 61.

2 After you have used a script or database triggers to populate the DB_LAST_UPD columns with
data, update your database statistics and then modify your database optimizer so that it is forced
to consider the DB_LAST_UPD indexes.

NOTE: It is not possible to force a Microsoft SQL Server database optimizer to consider
DB_LAST_UPD indexes.

Configuring the 11S Web Server for
Exchange

SSSE has certain configuration requirements for the Internet Information Services (11S) Web server
where the Exchange Server resides. This topic describes how to meet those requirements.

This task is a step in “Process of Configuring SSSE” on page 44.

The Siebel Exchange Connector uses the WWW Distributed Authoring and Versioning (WebDAV)
extension to HTTP to perform calendar operations. The Secure Socket Layer protocol (SSL, which
uses URLs that start with https:) is not supported. If the Web Server for Exchange is set up to require
authentication, then you must either set up the Exchange Connector application to run using the
security context of a user that the Web Server authentication will accept as valid, or else reconfigure
the Web Server to allow anonymous access.

If you have the urlscan product installed, make sure that the urlscan.ini file (typically located at
C:\WINNT\system32\inetsrv\urlscan\urlscan. ini) is set up to allow the following:

B Make sure that urlscan allows for the following verbs:
® PROPPATCH
® PROPFIND
m GET
m DELETE
B Make sure the Web server allows the HTTP request header Translate.

If you want SSSE to synchronize Outlook-created calendar items that contain periods in the
Subject field, then make sure AllowDotlInPath is set to 1. This directs the Web server to accept
URLSs that contain periods in them. This setting is relevant because SSSE uses WebDAYV to interact
with Exchange Calendar records. This kind of interaction requires WebDAV to specify a URL that
includes a file name that is based on the text of the Subject for the calendar item.
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B Make sure that [DenyUrlSequences] is configured appropriately for your requirements. For
example, if you want to allow Outlook-created items with ".." in the Subject, you must comment
out the ".." line in the urlscan.ini file. You can comment out a line in the file by placing a semi-
colon (;) at the beginning of the line.

B If Web server logging options are turned on, log files are typically located in
C:\WINNT\system32\inetsrv\urlscan\logs. When the Web server rejects a URL because it does
not meet the criteria specified in the .ini file, Exchange Connector log files record the rejected
URL. You can use the URL from the Connector log file to find entries in the Web server log file
that will help you to determine why the URL was rejected. For example, the following error
indicates that urlscan is configured to reject PROPPATCH requests:

[06-03-2004 - 17:31:36] Client at 172.20.63.233: Sent verb "PROPPATCH", which
is not specifically allowed. Request will be rejected.

The following error indicates that urlscan is configured to reject the Translate request header:

[06-03-2004 - 23:20:45] Client at 172.20.63.221: URL contains disallowed
header "translate:" Request will be rejected. Site Instance="1", Raw URL="/
exchange/pimsi2202/Calendar/WzkBF100800142102ibndtst81.eml*

NOTE: Note the URL contains the user ID which may be useful for debugging purposes.

Configuring Exchange Connector
Application DCOM Security

After installing the database triggers, you must configure DCOM security settings for the following
applications on each machine where the Siebel Exchange Connector will run:

B SSPICNEA. The sspicnea application is the Exchange Connector application that synchronizes
data in Exchange user mailboxes.

B  SSPICNFM. The sspicnfm application is the file moniker application, which allows PIMSI Engine
instances to work with Exchange Connector application instances.

This task is a step in “Process of Configuring SSSE” on page 44.

If you are already familiar with DCOM settings, you may find it helpful to consult Table 15 and
Table 16 on page 66. The procedure that follows these tables provides detailed instructions for
configuring the individual settings.

Table 15. DCOM Configuration Settings for SSPICNEA (Exchange Connector Application)

Security Setting Required by Users Explanation
Allow Access PIMSI Engine user and Both PIMSI Engine processes and SSPICNFM
processes make RPC calls to methods in

Exchange Connector user SSPICNEA.
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Table 15. DCOM Configuration Settings for SSPICNEA (Exchange Connector Application)

Security Setting Required by Users Explanation

Allow Launch Exchange Connector user | SSPICNFM has the identity of the Exchange
Connector user. SSPICNFM launches SSPICNEA.

ldentity Exchange Connector user | The Exchange Connector user is the user that
SSPICNEA runs as. This user also has access
rights for the Exchange mailboxes.

NOTE: The Exchange Connector application, SSPICNEA, makes RPC calls to the PIMSI Engine.
Therefore, all PIMSI Engine machines must grant default DCOM security access to the Exchange
Connector user. Procedures for granting this access follow the procedure for configuring Exchange
Connector DCOM settings, later in this topic.

Table 16. DCOM Configuration Settings for SSPICNFM (File Moniker Application)

Security Setting Required by Users Explanation

Allow Access PIMSI Engine user PIMSI Engine processes run as PIMSI Engine user. PIMSI
Engine makes RPC calls to methods in SSPICNFM.

Allow Launch PIMSI Engine user PIMSI Engine launches SSPICNFM.
ldentity Exchange Connector components run as the Exchange Connector
Connector user user.

To configure Exchange Connector application DCOM security

1 On each machine where you have installed Exchange Connector software and where you plan to
run the Exchange Connector applications, from the Windows Start menu, choose Run, enter
dcomcnfg.exe, and then click OK.

Depending on the version of dcomcnfg.exe that you run, you may need to navigate within the
dcomcnfg.exe application to a location such as Console Root > Component Services > Computers
> My Computer > DCOM Config.

If one or more DCOM Configuration Warnings are displayed, click No.

2 In the Distributed COM Configuration Properties dialog box, on the Applications tab, select
sspicnea, and then click Properties.
If your version of dcomcnfg.exe does not display an Applications tab, select the sspicnea
application in the right pane, and then right-click and choose Properties.

3 On the General tab of the Properties dialog box, verify the following:

m  That Application type is set to local server

66 Siebel Server Sync Guide Version 7.7, Revision A



r Sync = Configuring Exchange Connector Application DCOM
Security

® That the local path is set to the correct location for the sspicnea application

NOTE: In Windows 2003, the path does not show up in the dcomcnfg Ul. Instead, check the
Windows Registry manually for this information. For information about the Registry settings
to check, see Table 17 on page 68.

CAUTION: Using Registry Editor incorrectly can cause serious problems that may require
you to reinstall your operating system. There is no guarantee that problems resulting from
the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. It is
strongly recommended that you back up your Registry before editing it. For more information
about using the Registry Editor, see the Microsoft Windows documentation.

If the path or application type is incorrect, you must close the dcomcnfg application, reregister
all Siebel Exchange Connector components, and restart dcomcnfg.

To reregister Siebel Exchange Connector components, perform the following substeps:

a  Open a Command Prompt window and navigate to install_directory\siebsrvr\bin, where
install_directory is the installation directory for the Siebel Server software.

b  Enter the following commands:

sspicnea.exe /RegServer
regsvr32 sspicneaps.-dll
sspicnfm.exe /RegServer
regsvr32 sspicnfmps.dll
regsvr32 sspicnexps.dll

These commands register, respectively, the connector application, the proxy/stub component for
the connector application, the file moniker, the proxy/stub component for the file moniker, and
the proxy-stub component of the connector plug-in.

In the sspicnea Properties dialog box, click the Location tab, select Run application on this
computer, and clear all other check boxes.

Click the Security tab, select one of the following settings (the wording depends on your software
version), and then click Edit:

B Use custom access permissions.
m Customize in the Access Permissions area.

Inspect the Registry Value Permissions dialog box to see if the users that PIMSI Engine and
Exchange Connector will run under have access to the sspicnea application.

If necessary, add these users and specify Allow Access. Then click OK to return to the Properties
dialog box.

On the Security tab, select one of the following settings (the wording depends on your software
version), and then click Edit:

B Use custom launch permissions.

m Select Customize in the Launch Permissions area.
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8 Inspect the Registry Value Permissions dialog box to see if the user that Exchange Connector will
run under has permission to launch the sspicnea application.

If necessary, add this user and specify Allow Launch. Then click OK to return to the Properties
dialog box.

9 Click the Identity tab, click This User, specify the user name and password for the user that the
Exchange Connector application will run under, and then click Apply and OK.

NOTE: Specifying this user allows the Connector application authenticate in the Windows
domain. You must specify the domain as part of the user name, using the format
domain_name\user_name. The credential that is used must be a user who has the correct
privileges for reading Exchange mailboxes.

10 Repeat Step 2 through Step 9, substituting sspicnfm for sspicnea in all steps, and making the
following additional changes:

a In Step 6, only the PIMSI Engine user needs access to the sspicnfm application.

b In Step 8, only the PIMSI Engine user need permission to launch the sspicnfm application,
instead of the Exchange Connector user.

Table 17. Exchange Connector Information to Verify in the Windows Registry

Exchange

Connector File Windows Registry Path to Verify

sspicnea.exe HKEY_CLASSES_ ROOT\CLSID\{9DFC7C9A-727C-11D7-BF98-
CDAEB956EB35}\LocalServer32

sspicneaps.dll HKEY_CLASSES_ ROOT\CLSID\{9DFC7C99-727C-11D7-BF98-
CDAEB956EB35}\InProcServer32

sspicnexps.dll HKEY_CLASSES_ ROOT\CLSID\{2056A863-A523-4247-9347-
F884E53D9974}\InProcServer32

sspicnfm.exe HKEY_CLASSES_ ROOT\CLSID\{D9E08991-7245-11D7-BF98-
CDAEB956EB35}\LocalServer32

sspicnfmps.dll HKEY_CLASSES_ ROOT\CLSID\{D9E08990-7245-11D7-BF98-
CDAEB956EB35}\InProcServer32

You must complete an additional task to configure access to the PIMSI Engine component for the
Exchange Connector application. The following procedures provide instructions for this configuration
task for Windows 2000 and Windows 2003 environments.

To configure access to the PIMSI Engine for the Exchange Connector (Windows
2000)

1 On each machine that runs the PIMSI Engine component, from the Windows Start menu, choose
Run, enter dcomcnfg.exe, and then click OK.

If one or more DCOM Configuration Warnings are displayed, click No.
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Click the Default Security tab.
In the Default Access Permissions area of the dialog box, click Edit Default.

Add the user that the Connector application will run under.

2
3
a4
5

To configure access to the PIMSI Engine for the Exchange Connector (Windows
2003)

1 On each machine that runs the PIMSI Engine component, from the Windows Start menu, choose
Run, enter dcomcnfg.exe, and then click OK.

Click OK twice.

2 Within the dcomcnfg application, navigate to Console Root > Component Services > Computers
> My Computer.

If one or more DCOM Configuration Warnings are displayed, click No.
Right-click My Computer and select Properties.

Click the Default COM Security tab.

In the Access Permissions area of the dialog box, click Edit Default.

Add the user that the Connector application will run under.

N o 0o A~ W

Click OK twice.

Designating Trusted Exchange Servers

If the Exchange Connector application runs in a Windows 2003 environment, you must designate all
of your Exchange Servers as trusted sites for your local intranet, as described in the following
procedure.

This task is a step in “Process of Configuring SSSE” on page 44.

NOTE: This task is required only for Exchange Connector machines running Windows 2003.

To designated trusted Exchange Servers for Exchange Connectors in Windows 2003

1 On each Windows 2003 machine that runs the Siebel Exchange Connector, open the Internet
Options Control Panel.

2 Click the Security tab.
3 Select Local intranet as your Web content zone, and then click Sites.
4 For each of your Exchange Servers, enter the HTTP URL for the server and click Add.

If the dialog box does not provide a field for entering URLSs, click Advanced to display the correct
dialog box for this step.

5 Click OK twice to save the changes and exit from the Control Panel.

If you clicked Advanced in Step 4, click OK three times instead of twice.
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Modifying Log File Settings

SSSE log files contain information about SSSE operations. Each log file contains information for the
operations that are carried out by a particular Siebel Server. The amount of information that is logged
depends on the log level.

The following procedures describe how to change log levels for SSSE, and how to consolidate SSSE
log files.

NOTE: Siebel Exchange Connector logs are separate from other SSSE logs. For more information
about Exchange Connector log levels, see “Setting Exchange Connector Log Levels” on page 86.

These tasks are steps in “Process of Configuring SSSE” on page 44.

To change log levels for SSSE

1 On each Siebel Server that runs an SSSE component, open a Command Prompt window, and
navigate to install _directory\siebsrvr\bin, where install_directory is the installation
directory for your Siebel implementation.

2 Log in to Server Manager at the server level for this machine, using a command such as the
following:

srvrmgr /u db_user_name /p db_password /e enterprise server /g gateway host /s
server_name

Use the name of the Siebel Server you are configuring for the value server_name.

3 At the srvrmgr prompt, enter an appropriate command for the SSSE component log file you are
configuring, such as one of the following commands:

Change evtloglvl PIMSIEngSvc=n for comp PIMSIEng
Change evtloglvl PIMSIEngSvc=n for comp PIMSIDispatcher

Substitute an integer from 1 to 5 for n, where 1 logs the least information and 5 logs the most
information.

By default, many SSSE log files are created. If you want, you can use the following procedure to
consolidate these files into one log file for each SSSE component instance on a given Siebel Server.
This means that if you consolidate all your SSSE log files, you get one log file for the PIMSI
Dispatcher, on the machine where the Dispatcher runs, and you get one log file for each instance of
the PIMSI Engine, on the machine where that instance runs.

To consolidate SSSE log files

1 On a Siebel Server that runs an SSSE component, open a Command Prompt window and navigate
to install _directon\siebsrvr\bin, where install_directory is the installation directory for
your Siebel implementation.

2 Enter the following command to log in to Server Manager at the server level for this machine:
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srvrmgr /u db_user_name /p db_password /e enterprise_server /g gateway host /s
server_name

Use the name of the Siebel Server you are configuring for the value server_name.

At the srvrmgr prompt, enter one the following commands:

B To consolidate PIMSI Engine component log files, enter the following command:
Change param LogUseSharedFile=true for comp PIMSIEng

B To consolidate PIMSI Dispatcher component log files, enter the following command:
Change param LogUseSharedFile=true for comp PIMSIDispatcher

The resulting consolidated log file is located in the standard log directory. It has a file name with
the following format: <component_name>_<taskld>.log.

Configuring the Generic Siebel Organizer

SSSE Calendar synchronization operations require you to configure a Generic Siebel Organizer Login.
SSSE automatically assigns the value of the Generic Siebel Organizer Login setting as the owner of
any Siebel Activity record for which either of the following statements is true:

The Microsoft Outlook meeting that corresponds to the Siebel Activity is owned by a user who is
not a valid Employee in the Siebel implementation.

The Microsoft Outlook meeting that corresponds to the Siebel Activity is owned by a user who
does not have SSSE synchronization enabled.

The following procedure describes how to specify a value for the Generic Siebel Organizer Login. This
task is a step in “Process of Configuring SSSE” on page 44.

To configure the Generic Siebel Organizer Login setting

1

Decide which login you want to use for the Generic Siebel Organizer setting.

The login must meet the following conditions:

B The login must correspond to a valid Siebel Employee record that includes an email address.
B The login must be mapped to a valid Exchange Account that has an Active Directory entry.

B For a production environment, use the login name of an SSSE administrator who does not
have synchronization enabled. (Test environments do not need to meet this condition.)

From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Configuration > PIM Server Integration Configuration.

In the PIM Server Integration Configuration list, use standard query techniques to locate and
select the record in which the value of the Profile Name field is Siebel.

In the Configuration Parameters list, locate and select the record in which the value of the
Parameter field is Generic Siebel Organizer.
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5 In this record, set the Value field to SADMIN, or to the login name of any other Siebel user who
you want to designate as the generic organizer.

Configuring the Default Account

Every Business Contact record that is stored in the Siebel database should be associated with an
Account. This association provides the Account’s Primary Address for the Business Contact. When a
Siebel Business Contact is synchronized using SSSE, the Account and Account Location fields for the
contact and the Account’s Primary Address are synchronized with the Company Name field, the Office
field, and the Address field in Microsoft Exchange, respectively.

If a user enters a value for the Address field for a Contact record in Microsoft Outlook, but does not
enter a value for the Company field and the Office field, a problem occurs when SSSE attempts to
synchronize the record, because the Siebel data model cannot associate the address with the Contact
if there are no values for Account Name and Location. For this reason, it is recommended that users
always include a Company name and Office value when entering a Contact address in Microsoft
Outlook.

To work around this problem, you can specify Account name and Account Location values that already
exist in the Siebel database as the default values for the Account Name and Account Location fields.
This allows the Contact address from Outlook to be synchronized in the Siebel database. However,
that address is associated with the default account, since no account was supplied in Outlook.

NOTE: The Account Location field appears in the Contacts List and the Accounts List as the Site field.

This task is a step in “Process of Configuring SSSE” on page 44.

To set defaults for the Account and the Account Location fields

1 Log in to your Siebel application as an administrator and navigate to Site Map > PIM Server
Integration > Siebel Domains.

2 In the Siebel Domains list, select Siebel Business Contact.
In the Siebel Domain Fields list, select the record where the value of the Name field is Account.
In the Default Value field of the selected record, specify an existing Siebel Account.

If a user enters an Address for a Contact in Outlook without specifying an Account, SSSE assigns
the default Account name to the Contact record when synchronizing it with the Siebel database,
and associates the Address for the Contact with this default Account.

5 In the Siebel Domain Fields list, select the record where the value of the Name field is Account
Location.

6 In the Default Value field of the selected record, specify an existing Account Location that
corresponds with the default Account you specified in Step 4.
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Tuning SSSE Siebel Profile Parameters

SSSE contains various parameters that you can adjust to optimize performance. The following
procedure describes how to change Siebel profile parameters. The profile applies to all PIMSI Engines
in your Siebel Enterprise.

This task is a step in “Process of Configuring SSSE” on page 44.

To tune SSSE parameters in the Siebel profile

1 Log in to your Siebel application as an administrator and navigate to Site Map > Administration -
PIM Server Integration > Configuration > PIM Server Integration Configuration.

2 In the PIM Server Integration Configuration list, select the record in which the value of Profile
Name is Siebel.

3 In the Configuration Parameters list, modify the fields or add records as needed to tune the
performance of your Siebel implementation, using the information in Table 18 on page 73.

Table 18. Siebel Profile Configuration Parameters
Section Parameter Default Comment

Siebel AttendeeQueryForceEmailLower | FALSE When synchronizing an
appointment from Exchange to
Siebel, force the email addresses
of attendees to lower case when
querying for the contact in Siebel.
Set this parameter to TRUE if
your Siebel email addresses use
mixed case or upper case letters.

Siebel DispCycleCount for GC 12 Determines how many times the
Dispatcher runs before unneeded
information is removed from the
S_SD_SYNC_INFO table, where
information is stored about data
to synchronize. Using default
values, this removal of unneeded
information occurs once an hour,
because the Dispatcher job is
normally run every five minutes.
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Table 18. Siebel Profile Configuration Parameters

Section Parameter Default Comment

Siebel ExtractStartDate 01/01/1980 Determines which Calendar and
To Do records will be excluded
from synchronization because of
their date settings. For more
information, see “Factors That
Determine Calendar
Synchronization” on page 131 or
“Factors That Determine To Do
Record Synchronization” on

page 138.

Siebel ExtractStartDateFormat MM/DD/YYYY | Date format for the
ExtractStartDate parameter.
SSSE uses the format that you
specify in this setting to interpret
the value of your
ExtractStartDate setting
correctly. It is not necessary for
this format to match the date
format that your Siebel
application generally uses.

Siebel ForceTranscode FALSE Forces text conversion to use
transcode. Set this parameter to
TRUE if your Siebel
implementation uses a transcode
database type.

Siebel MaxAlarmLeadMinutes Not Maximum number of minutes for
applicable an appointment alarm lead time.
Siebel MaxUserExtractRegBatchSize 20 Maximum number of user

extractions that can be requested
in one synchronization request.
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Parameter

NotificationFrequency

Default
2
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Comment

If the PIMSI Dispatcher detects
that a PIMSI Engine component is
not responding correctly, the
Dispatcher signals the Engine to
discover whether it can respond.
This parameter specifies how
many times the Dispatcher
should request a response from
an unresponsive PIMSI Engine
before attempting to recover it.

NOTE: The PIMSI Dispatcher
automatically attempts to
recover any PIMSI Engine that
has failed to respond to the set
number of requests. See the
Dispatcher log for records of any
unresponsive Engines. See the
individual Engine log for
information that may help you
diagnose why the Engine stopped
responding.

Siebel

OnlySyncCategorizedContacts

FALSE

Determines whether or not Initial
Extract operations synchronize
Exchange Contact records that
have the Category field set to a
specified value. Case-insensitive.
For more information about this
parameter, see “Initial Extract and
Ongoing Extract” on page 19.
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Table 18. Siebel Profile Configuration Parameters
Section Parameter Default Comment

Siebel ReconciliationDuration 60 Specifies how many seconds the
PIMSI Dispatcher waits after
signaling a PIMSI Engine. If the
Dispatcher does not receive a
response within this time period,
the Dispatcher either attempts to
recover the Engine or signals it
again, depending on whether or
not the number of unsuccessful
signals has reached the value of
the Notification Frequency
setting.

Siebel ResolveContactbyEmailAddress FALSE If set to TRUE, use email
addresses, as well as first and
last names, when trying to
resolve contacts.

About Mapping Exchange Connectors to
Exchange Servers

This topic provides background information about how Exchange Connector applications work with
Exchange Servers. It is important to understand this information before proceeding to the next task,
“Configuring Exchange Connector Parameters” on page 79.

There are two basic ways you can configure Exchange Connector applications to work with Exchange
Servers: with and without Connector Application Map records. The following paragraphs describe
each type in more detail.

Configurations That Include Connector Application Map Records

In this configuration type, you create Connector Application Map records that assign specific
Exchange Connector machines to handle synchronizations with specific Exchange Servers. This
configuration type is most useful if you want to optimize performance in a Siebel implementation that
has Exchange Servers in widely scattered geographical locations—performance may be optimized
when each Exchange Connector machine is located close to the Exchange Server that the Connector
synchronizes.

This configuration type has the following characteristics:

B Each Connector Application Map record assigns an Exchange Connector machine to synchronize
users on a single Exchange Server. In Connector Application Map records, each Exchange
Connector machine is represented by its Engine Share. Engine Shares are UNC path
configurations that indicate which machines are to run Exchange Connector applications
(sspicnea.exe files).
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An Exchange Server can be listed in multiple Connector Application Map records, but Exchange
Connector machines can only be designated by one record each. This means each Exchange
Server can be synchronized by multiple Exchange Connector machines, but no Exchange
Connector machine can be assigned to synchronize more than one Exchange Server.

The maximum number of Connector Application Map records you can create is the same as the
number of Engine Shares you have.

If the Connector Application Map does not assign any Exchange Connector machines to a
particular Exchange Server, then you must configure the machine that runs the PIMSI Engine
service to run Exchange Connector applications. The PIMSI Engine machine is the one machine
that can synchronize users whose mailboxes are located on Exchange Servers that are not listed
in Connector Application Map records. If the PIMSI Engine machine is not configured to run the
Exchange Connector, then synchronization will fail with an error message for users whose
mailboxes are located on the unmapped Exchange Servers.

When the Exchange Connector needs to run a new instance of the application, it counts the
number of Exchange Connector applications that are running on each Exchange Connector
machine that is assigned to the relevant Exchange Server. The Connector runs the new instance
of the application on the machine that has the fewest Exchange Connector applications running
when it is checked.

Configurations That Exclude Connector Application Map Records

In this configuration type, you do not create any Connector Application Map records. SSSE
dynamically assigns an Exchange Connector application to synchronize each user, as needed—any
Exchange Connector machine can perform synchronizations with any Exchange Server. This
configuration type is most useful for load balancing in implementations where wide-area network
performance is not a major factor, or where the number of Exchange Servers exceeds the number of
Exchange Connector machines.

This configuration type has the following characteristics:

There are no Connector Application Map records in the Siebel implementation.
Each Exchange Connector machine can synchronize users on any Exchange Server.

When the Exchange Connector needs to run a new instance of the application, it counts the
number of Exchange Connector applications that are running on each Exchange Connector
machine. The Connector runs the new instance of the application on the machine that has the
fewest Exchange Connector applications running when it is checked.

For information about creating the Engine Shares that designate which machines run the Exchange
Connector application, see “Setting Up the Connector Share Directory” on page 56.
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About Using Exchange Virtual

Directories

If your Siebel implementation uses any Exchange virtual directories that have names other than the
single word Exchange, then you must include information about these directory names in the
parameters for the Siebel Exchange Connector. This topic describes how the necessary parameter
names and values must relate to each other. For more information on setting the parameters, see
“Configuring Exchange Connector Parameters” on page 79.

Table 19 shows the Section, Parameter, and Value relationships that you must create to use virtual
directories with non-default names. In this table, n can be any character that is unique for its profile
section. For each Exchange Server that you want to associate with a virtual directory, you need to
set one Exchange Virtual Directory Map parameter, one Exchange Server parameter, and at least one

Virtual Directory parameter.

Table 19. Exchange 2000/2003 Connector Parameters Related to Virtual Directories

Section Parameter

Calendar Exchange
Virtual
Directory Map
n

Comment

In the Value field, enter Virtual Directory Map n exactly
as you will later name a profile section. In the Parameter
field, be sure separate each word from the next with a
single space.

Virtual Directory Map n | Exchange
Server

In the Value field, enter the name of an Exchange Server.
Use all upper case characters. Do not include domain
information in the server name (i.e., enter EXCHGO1,
rather thanEXCHGO01.YOURCOMPANY.COM). In the
Parameter field, be sure separate each word from the
next with a single space.

Virtual Directory Map n | Virtual
Directory 1

In the Value field, enter the name of a virtual directory
that is associated with the Exchange Server for the
current Virtual Directory Map. If your implementation
includes a virtual directory called Exchange, you must
specify it as a value for one of your virtual directories. In
the Parameter field, be sure separate each word from the
next with a single space.

Virtual Directory Map n | Virtual
Directory 2

(Optional) In the Value field, enter the name of another
virtual directory associated with the Exchange Server for
the current Virtual Directory Map. In the Parameter field,
be sure separate each word from the next with a single
space.
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See Table 20 for an example of the kind of values you must specify for these related settings.

Table 20. Example of Exchange Connector Setting Values Related to Virtual Directories

Section Parameter Value
Calendar Exchange Virtual Directory Map 1 VirtDirSectionl
VirtDirSectionl Exchange Server EXCHSRV1
VirtDirSectionl Virtual Directory 1 VirtDirl
VirtDirSectionl Virtual Directory 2 VirtDir2

Configuring Exchange Connector
Parameters

The Siebel Exchange Connector contains various parameters that you can adjust to optimize
performance. The following procedure describes how to tune Exchange Connector parameters.

This task is a step in “Process of Configuring SSSE” on page 44.

Exchange Connectors can run on any machine that is equipped with the sspicnea.exe executable file
and certain SSSE DLLs. Exchange Connector, PIMSI Engine, and PIMSI Dispatcher can all be located
on different machines.

If an SSSE deployment contains any Exchange Connector applications that reside on machines that
do not contain PIMSI Engines, those Exchange connector applications are known as remote Exchange
connector applications. For information about installing Exchange Connectors, see “Installing Siebel
Exchange Connector” on page 42.

Use the following procedure to configure Exchange Connector parameters on any machine where
Exchange Connector software is installed.

To configure Siebel Exchange Connector parameters

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Configuration > PIM Server Integration Configuration.

2 In the PIM Server Integration Configuration list, select the record in which the value of Profile
Name is Exchange 2000 Connector.

NOTE: This is the correct record to select for either 2000 or 2003 Exchange environments.

3 In the Configuration Parameters list, create or modify and save records as needed, using the
information in Table 21 on page 80.

You may be able to use default values for most of the parameters listed. However, you must
create records for the Engine Shares section.
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Table 21. Exchange 2000 Connector Configuration Parameters
Section Parameter Default Comments

Calendar QueryExternalDomains FALSE When the Exchange Connector
cannot locate a Calendar item
attendee in the Active Directory
Global Catalog, this setting
determines whether or not to
perform an exhaustive Active
Directory search.
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Section

Connector
Application Map

Parameter

Name of an Engine Share
(for example, Sharel or
Share01)

Default

Not
applicable

bel Server Sync ! Configuring Exchange Connector Parameters

Comments

(Optional) If your Exchange
Servers are located in several
geographical locations, you may
be able to improve performance by
assigning synchronization tasks
for each Exchange Server to
Exchange Connector applications
that run nearby.

To do this, create one or more
records with Section set to
Connector Application Map. In the
Parameter field of each record,
enter the name of one of your
Engine Shares (the shared
directories where Exchange
Connector applications are run).
In the Value field, enter the name
of the Exchange Server that you
want that Exchange Connector to
serve.

You can create as many Connector
Application Map records as you
have Engine Shares. For more
information about this setting, see
“About Mapping Exchange
Connectors to Exchange Servers”
on page 76.

NOTE: If you have sync-enabled
users on more Exchange Servers
than you have Engine shares,
make sure there is an Engine
Share on the PIMSI Engine
machine that is not associated
with any particular Exchange
Server. This share must serve
users on any Exchange Server that
is not explicitly specified in a
Connector Application Map record.
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Table 21. Exchange 2000 Connector Configuration Parameters

Section

Engine Shares

Parameter

Sharen

Default

Not
Applicable

Comments

The n in the parameter name
should be a unique number.
Specify the value of each share as
a UNC path to a remote or local file
system directory that has been
shared, using the format
\\machine_name\share_name.
Connector applications are run on
the machine indicated in the
share. For more information about
configuring shares, see “Setting Up
the Connector Share Directory” on
page 56.

PreferredGCServers

GCServern (replace n
with 1, 2, and so on)

Not
applicable
(Enter the
name of a
Global
Catalog
server)

(Optional) Indicates one or more
preferred Active Directory Global
Catalog servers for the Exchange
Connector to contact when

identifying SSSE user mailboxes.

SyncOptions

PreserveAttachments

TRUE

Indicates whether or not the
Connector should preserve PIM
attachments for noncalendar
domains. If this parameter is set
to FALSE, attachments are
removed when the Connector
updates the record in Exchange.
This setting does not affect Siebel
attachments.

SyncOptions

PreserveUnmappedFields

TRUE

Indicates whether or not the
Connector should preserve the
data for fields which are not
mapped for synchronization for
noncalendar domains. If this
parameter is set to FALSE, any
data in an unmapped field is
removed from the record in
Exchange.
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Timeouts

Exchange 2000 Connector Configuration Parameters

Parameter Default

Connect

180
seconds

erver Sync ' Configuring Exchange Connector Parameters

Comments

When an Exchange Connector
application first runs, it waits the
configured number of seconds for
a PIMSI Engine instance to
establish a connection with it. If no
connection is established, the
Exchange Connector application
shuts down to conserve resources.
You may want to increase the
value of this setting if your users
run SSSE over a slow network.

NOTE: The application is
automatically restarted if the
PIMSI Dispatcher requests
synchronization for more users
than currently running Exchange
Connector instances can handle.

Timeouts

Reconnect

30 seconds

When a running Exchange
Connector application detects that
no PIMSI Engine instance is
exchanging data with it, the
application waits the configured
number of seconds for a PIMSI
Engine instance to reestablish a
connection. If no connection is
established, the Exchange
Connector application shuts down
to conserve resources. You may
want to increase the value of this
setting if your users run SSSE over
a slow network.
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Table 21. Exchange 2000 Connector Configuration Parameters
Section Parameter Default Comments

UsersPerApplication | MaxUsers 10 Maximum number of users each
instance of a Connector
application can simultaneously
synchronize. Maximum value is
200.

You may find that performance
improves if you use a low value for
this setting during initial extract
operations.

For more information about this
setting, see “About Tuning SSSE for
Optimal Performance” on page 55.

Enabling and Disabling Components on
SSSE Servers

As with all Siebel Servers, you can selectively enable and disable server components and component
groups on the PIMSI Engine and PIMSI Dispatcher machines. This task is a step in “Process of
Configuring SSSE” on page 44.

For proper operation of SSSE, use the following guidelines for enabling and disabling server
components and component groups:

B Enable the PIMSI component group on the Enterprise.

B Enable the PIMSI Engine (pimsieng) component on the Enterprise and on one or more individual
Siebel Server machines.

B Enable the PIMSI Dispatcher (pimsidispatcher) component on the Enterprise and on just one
Siebel Server machine.

B For optimum performance, disable the PIMSI Engine component on the PIMSI Dispatcher server.

For more information on enabling and disabling server components and component groups, see
Siebel System Administration Guide.

Restarting Siebel Services

You must restart the Siebel Servers and Siebel Gateway Name Server for the changes that you made
in this chapter to take effect. For information about restarting Siebel Servers, see Siebel System
Administration Guide.

This task is a step in the process of “Configuring Siebel Server Sync” on page 43.
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Configuring and Starting PIMSI
Dispatcher

PIMSI Dispatcher runs as a job on a Siebel Server machine. This topic discusses PIMSI Dispatcher
job parameters.

PIMSI Dispatcher runs for a certain amount of time for each dispatching cycle. The amount of
execution time is dependent upon your current configuration (the number of active users, machine
configuration, and so on).

Under certain conditions, PIMSI Dispatcher may enter a recovery mode to identify PIMSI Engines that
have stopped working and to recover any resources those Engines had been using, so that
synchronization can resume. When PIMSI Dispatcher enters the recovery mode, multiply
NotificationFrequency by ReconciliationDuration to determine the increase in the amount of time the
PIMSI Dispatcher requires to complete its run. For more information about the NotificationFrequency
and ReconciliationDuration parameters, see “Configuring the Default Account” on page 72.

The following procedure describes how to create the PIMSI Dispatcher job, tune the job’s
parameters, and start the job. This task is a step in “Process of Configuring SSSE” on page 44.

To create the PIMSI Dispatcher job and tune its parameters

1 Log in to your Siebel application as an administrator and navigate to Site Map > Administration
- Server Management > Jobs.

In the Jobs List or the Jobs Detail form, click New.
Complete the fields as described in the following table.

For more information about starting jobs, see Siebel System Administration Guide.

Field Comment

Component/Job Specify PIMSI Dispatcher.

Mode Specify Asynchronous.

Requested Server Specify the machine where you installed the
Siebel Server software for PIMSI Dispatcher.

Repeating? Select the check box.

Repeat Unit The suggested value is Minutes.

Repeat Interval It is strongly recommended that you use the

suggested value of 5.

NOTE: Setting a Repeat Interval smaller than
five minutes can cause SSSE to miss some
Siebel updates, causing incomplete
synchronization and possibly decreasing
performance throughout the Siebel
Enterprise.
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Field Comment

Repeat From The suggested value is End.

Repetitions The suggested value is 0.

4 Save the record and click Start to begin the initial extract.

Ongoing extracts follow automatically, separated by the repetition interval.

Setting Exchange Connector Log Levels

Log files for the Siebel Exchange Connector are located in the siebsrvr\log directory on each
machine where the sspicnea.exe application runs. The Exchange Connector log files have names with
the format PIMSIExchConnApp_processID.log. These log files contain Exchange Connector messages
regarding the synchronization of users with Exchange.

By default, the Siebel Exchange Connector applications log messages at log level 2. The following
procedure describes how to increase or decrease the log level for the application. This task is an
optional step in “Process of Configuring SSSE” on page 44.

To increase or decrease the log level of a Siebel Exchange Connector application

1 On each machine where the Siebel Exchange Connector application (sspicnea.exe) runs, right-
click My Computer and choose Properties.

Click the Advanced tab.
Click Environment Variables.
In the System Variables area of the dialog box, click New.

In the Variable Name field of the New System Variable dialog box, enter SIEBEL_LOG_EVENTS.

o a0~ W N

In the Variable Value field, enter PIMSIEngSvc=n, where n is a value from 1 through 5, inclusive,
and then click OK twice.

7 Restart all of your PIMSI Engine components.

Any change in the log level requires that the application be restarted. The Siebel Exchange
Connector application automatically restarts when you restart PIMSI Engines.
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This chapter covers ways in which you can customize SSSE. It includes the following topics:
B “About Customizing SSSE” on page 87

“About Synchronizing Additional Fields” on page 88

“About SSSE Integration Objects” on page 90

“About SSSE Data Maps” on page 90

“Process of Customizing SSSE” on page 91
“Changing Integration Objects” on page 91
“Changing SSSE Data Maps” on page 96

“Changing Siebel Domain Configurations” on page 98

[ |
[ |
[ |
m  “Changing PIM Domain Configuration” on page 100
m  “Changing Domain Map Configurations” on page 104
m  “About SSSE User Filtering” on page 106

[ |

“Changing User Filtering Configurations” on page 107

About Customizing SSSE

SSSE supports the following kinds of customization, within each supported domain and for a specified
set of database tables:

B Modifying certain properties of fields that are already available for synchronization, such as field
names

B Modifying existing field mappings in the following ways:

® Mapping an Exchange field that is already synchronized to a Siebel field that you add for
synchronization

® Mapping a Siebel field or multi-value group (MVG) that is already synchronized to an
Exchange field that you add for synchronization

B Adding new field mappings in the following ways:

B Adding a new field or MVG for synchronization in a supported Siebel business component and
mapping it to a previously unmapped Exchange field (includes adding a new column in the
underlying Siebel base table)

B Adding a new field for synchronization in Exchange and mapping it to a previously unmapped
Siebel field or MVG

l Deleting existing field mappings
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The customization process can involve changing some or all of the following entities:
B Integration Objects

B Integration Data Maps

B Domain configurations

B Field configurations

Any administrator who customizes SSSE should have experience with working in Siebel Tools, and
should have a good working knowledge of Microsoft Exchange, including the internal representations
of field names in Exchange.

About Synchronizing Additional Fields

SSSE allows fields from certain database tables to be added for synchronization, but does not support
fields from certain other tables. Other characteristics can also affect whether SSSE can synchronize
a field successfully. For example, SSSE does not support synchronization of calculated fields. This
topic discusses supported and unsupported tables, and other characteristics of fields that affect
synchronization possibilities.

A major factor in whether or not you can add a field for synchronization is whether or not SSSE will
detect changes to that field. SSSE monitors a specific set of supported database tables to identify
changes to be synchronized to Exchange. If a field resides in a table that SSSE does not monitor,
SSSE does not detect changes in field values, so synchronization of changes in those tables is not
supported.
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Table 22 lists the tables in each Siebel Domain that can have fields added for synchronization. You
can add most fields from these tables for synchronization.

NOTE: If a field based on a particular table is a multivalue group (MVG), then SSSE synchronizes
only the Primary value from the MVG.

CAUTION: When choosing fields from supported tables to add for synchronization, take care not to
choose business component system fields or fields that have special meaning for Siebel components
(and that should be updated only by those Siebel components), since synchronizing such fields can
have unpredictable results.

Table 22. Siebel Domains and Tables That Allow Fields To Be Added for Synchronization

Siebel Domain Supported Tables Is Field Based on Table an MVG?
Business Contact S ADDR_ORG Y
S_ADDR_PER Y
S_CONTACT N
S CONTACT_INFO Intersection table
S_OPTY N
S _ORG_EXT N
S_PARTY N
S_PROJ N
S_USER N
Calendar and Tasks S EVT_ACT N
S_OPTY N
S _ORG_EXT N
S_PROJ N
S_SRV_REQ N
Employees S_ADDR_ORG Y
S_CONTACT N
S CONTACT_INFO Intersection table
S_PARTY N
S_POSTN N
Personal Contacts S ADDR_PER Y
S_CONTACT N
S CONTACT_INFO Intersection table
S_PARTY N
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If you want to synchronize Siebel fields that are based on tables other than those listed in Table 22
on page 89, contact Siebel Expert Services for assistance in determining feasibility.

About SSSE Integration Objects

Each domain that SSSE synchronizes has a Siebel Integration Object and an Intermediate Integration
Object. Siebel Integration Objects are used to obtain information from the Siebel database.
Intermediate Integration Objects are used to send that data to the PIMSI Engine component.

You must modify Integration Objects any time you customize SSSE, whether the customization
involves adding new fields or modifying existing fields. Table 23 shows the Integration Objects for
each domain that SSSE handles.

Table 23. Integration Object Names for Siebel Domains

Siebel Integration Object Intermediate Integration Object
Business Contact PIMSI Business Contact PIMSI Intermediate Business Contact
Calendar PIMSI Calendar PIMSI Intermediate Calendar
Employee PIMSI Employee PIMSI Intermediate Employee
Personal Contact PIMSI Contact Personal PIMSI Intermediate PersonalContact
Task PIMSI Task PIMSI Intermediate Task

About SSSE Data Maps

Each domain that SSSE synchronizes has an Inbound Data Map for converting Exchange data to
Siebel data, and an Outbound Data Map for converting Siebel data to Exchange data. Data maps
must be modified any time you customize SSSE, whether the customization involves adding new
fields or modifying existing fields. Table 24 shows the names of the data maps for each domain that
SSSE handles.

Table 24. Data Map Names for Siebel Domains
Domain Inbound Data Map Outbound Data Map

Business Contact | PIMSI Business Contact Inbound Map | PIMSI Business Contact Outbound Map

Calendar PIMSI Calendar Inbound Map PIMSI Calendar Outbound Map

Employee PIMSI Employee Inbound Map PIMSI Employee Outbound Map

Personal Contact | PIMSI Personal Contact Inbound Map | PIMSI Personal Contact Outbound Map

Task PIMSI Task Inbound Map PIMSI Task Outbound Map
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Process of Customizing SSSE

To add a field to the fields that SSSE synchronizes, or to modify an existing field that is synchronized,
perform the following tasks before starting or restarting the PIMSI Engine and PIMSI Dispatcher
components:

“Changing Integration Objects” on page 91
“Changing SSSE Data Maps” on page 96
“Changing Siebel Domain Configurations” on page 98

“Changing PIM Domain Configuration” on page 100

“Changing Domain Map Configurations” on page 104
“Changing User Filtering Configurations” on page 107

NOTE: All tasks in this process assume that the field already exists in the appropriate Siebel
Business Component.

Changing Integration Objects

Any time you add or change a field for SSSE to synchronize, you must change one or more
Integration objects for the Siebel domain that is involved. Table 25 shows the changes that are
required.

This task is a step in “Process of Customizing SSSE” on page 91.

Table 25. Integration Object Change Requirements

Field Change Integration Object Modifications Required

Add a new field for synchronization Siebel Integration Object and
Intermediate Integration Object

Modify an existing field that is synchronized Intermediate Integration Object

The following procedure briefly describes how to change an Integration Object as part of customizing
SSSE. For more information about Integration Objects, see “About SSSE Integration Objects” on
page 90.

For an example of how to perform this task for a new field that you want to synchronize, see “Example
of Changing Integration Objects (New Field)” on page 92.

For an example of how to perform this task for an existing field that you want to modify, see “Example
of Changing Integration Objects (Existing Field)” on page 94.

NOTE: This procedure assumes that the new field already exists in the appropriate Siebel Business
Component, but does not yet exist in the Siebel Integration Object or the Intermediate Integration
Object. The procedure also assumes that the new field has not yet been synchronized.
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To change an integration object
Log in to Siebel Tools.

Select the Integration Object that you want to change.
Select the integration component for which a field needs to be changed or added.
Change the integration component field properties as needed.

Save the record.

o 00 A W N P

Recompile the SRF for the project.

Example of Changing Integration Objects (New Field)

This topic gives one example of changing integration objects as part of customizing SSSE. You may
use this feature differently, depending on your business requirements.

In this example, you want to add the new Siebel field ManagerLogin to the Employee domain, so
SSSE can synchronize it. To accomplish this, you must change both the Siebel Integration Object and
the Intermediate Integration Object for the Employee domain. For more information about
Integration Objects, see “About SSSE Integration Objects” on page 90.

NOTE: This example assumes that the new ManagerLogin field already exists in the appropriate
Siebel Business Component, but it does not yet exist in the Siebel Integration Object or the
Intermediate Integration Object, and it has not yet been synchronized.

To change Siebel and Intermediate Integration Objects for a new field
1 Log in to Siebel Tools.

2 In the Object Explorer pane, select Integration Object, and complete the following substeps:
a In the Integration Objects list editor, select PIMSI Employee.
b In the Object Explorer pane, select Integration Component.
C In the Integration Component list editor, select Employee.
d  Scroll to the right until the Inactive field is visible, and clear the Inactive check box.
3 In the Object Explorer pane, select Integration Object, and complete the following substeps:
In the Integration Object list editor, select PIMSI Intermediate Employee.
In the Object Explorer pane, select Integration Component.
In the Integration Component list editor, select Employee.
In the Object Explorer pane, select Integration Component Field.

In the Integration Component Field list, right-click any record, and choose Copy Record.

= ©0 O O T 9

In the Siebel Tools menus, select View Windows > Properties Window.
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g In Properties pane, modify property values for the copied record as shown in the following table.

Field Propert Field Property Value Comment
perty

Name ManagerLogin Internal name of the field.
The Name value must differ
from the Parent Name value,
or data will not synchronize

properly.

External Name ManagerLogin For a Siebel Integration
Objects, External Name must
match the name of the field as
it is specified in the Siebel
Business Component. For an
Intermediate Integration
Object, you can choose any
value for External Name.

XML Tag ManagerLogin Enter a value that does not
contain any spaces. This value
is included in the XML output
that SSSE produces.

XML Sequence 18 Specifies the order in which
the field will appear in the
Output XML message.

Enter a value that is not
already present in the field
list, such as the number that
follows the value used for the
last existing field in the
sequence. It is recommended
that you use the same value
for XML Sequence and
External Sequence.
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Field Property Field Property Value Comment

External Sequence 18 Specifies the order in which
the field will appear, when
Data Mapper is used to map
the fields.

Enter a value that is not
already present in the field
list, such as the number that
follows the value used for the
last existing field in the
sequence.

It is recommended that you
use the same value for XML
Sequence and External
Sequence.

Parent Name Employee The Integration component
that is the parent of the
Integration Object that is
being modified.

CAUTION: For Siebel Integration Objects (but not Intermediate Integration Objects), if an MVG
field is not a user key, be sure to set the XML Sequence property value and the External Sequence
property value to be greater than the value of a user key MVG field. If you do not specify a
greater value, synchronization may not work properly for information that travels from Exchange
to the Siebel application.

A user key MVG field is a field that is specified in the Integration Component User Key object as
a user key. For example, for the Integration Object called PIMSI Employee and the Integration
Component called Employee_Position, the user key field is Position. If any new MVG field is added
to the Employee_Position component, then the XML Sequence and External Sequence property
value for the new field should be greater than that of the Position field.

Save the record.
5 Recompile the SRF for the project.

Use the recompiled SRF when you make corresponding changes to Data Maps.

Example of Changing Integration Objects (EXxisting
Field)

This topic gives one example of changing an integration object as part of customizing SSSE. You may
use this feature differently, depending on your business requirements.
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In this example, in the Employee domain, you want to change the name of the EmployeePosition field
to Position. To accomplish this, you must change the Intermediate Integration Object for the
Employee domain. For more information about Integration Objects, see “About SSSE Integration
Objects” on page 90.

NOTE: This example assumes that the field, itself, has already been renamed in Siebel Tools, but it
has not yet been renamed in the Intermediate Integration Object.

To change an Intermediate Integration Object to synchronize an existing field
1 Log in to Siebel Tools.

2 In the Object Explorer pane, select Integration Object, and complete the following substeps:
a In the Integration Object list editor, select PIMSI Intermediate Employee.
b In the Object Explorer pane, select Integration Component.

Cc In the Integration Component list editor, select EmployeePosition.

d In the Object Explorer pane, select Integration Component Field.
e In the Integration Component Field list, select EmployeePosition.
T In the Siebel Tools menus, select View Windows > Properties Window.
g In the Properties pane, modify EmployeePosition field property values as shown in the following
table.
Field Property Old Vvalue New Value
Name EmployeePosition Position
External Name EmployeePosition Position
XML Tag EmployeePosition Position
Parent Name EmployeePosition EmployeePosition

CAUTION: The value for Name must differ from the value for Parent Name, or data will not
synchronize properly.

NOTE: The values for External Sequence and XML Sequence are not listed in the preceding
table because these settings do not need to be changed when you are modifying an existing
field. The Parent Name values in the table reflect the fact that the EmployeePosition

Integration Component is the parent of the EmployeePosition field that you are modifying.

3  Save the record.
4 Recompile the SRF for the project.

Use the recompiled SRF when you make corresponding changes to Data Maps.
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Changing SSSE Data Maps

Data maps must be modified whenever you add a field for SSSE to synchronize and whenever you
modify a synchronized field. The following procedure briefly describes how to change a Data Map as
part of customizing SSSE. This task is a step in “Process of Customizing SSSE” on page 91. For more
information about Data Maps, see “About SSSE Data Maps” on page 90. For an example of how to
perform this task for a new field to be synchronized, see “Example of Changing Data Maps (New Field)”
on page 96. For an example of how to perform this task for an existing field to be modified, see
“Example of Changing Data Maps (Existing Field)” on page 97.

CAUTION: You must change the Inbound Data Maps for the applicable domains before you proceed
to “Changing Siebel Domain Configurations” on page 98. If this is not done, then Siebel administration
screens for SSSE may not reflect the customization tasks you have already completed.

To change a Data Map for SSSE
1 Use the SRF that contains your changes to Integration Objects.

2 From the Siebel application menus, select Navigate > Site Map > Administration - Integration >
Data Map Editor.

3 In the Integration Map Object list, select the Data Map you need to change.

For information about the names of Data Maps for SSSE domains, see “About SSSE Data Maps”
on page 90.

4 In the Integration Component Map list, select the record for the component you need to change,
and then scroll down.

To determine which component to select, inspect the Source Component Name column in the
Integration Component Map list for the component that you modified in Siebel Tools. The same
component needs to be modified in the data map.

5 In the Integration Field Map list, create a new record, if necessary, and modify field values.

Example of Changing Data Maps (New Field)

This topic gives one example of changing data maps as part of customizing SSSE. You may use this
feature differently, depending on your business requirements.

Continuing with the example from “Example of Changing Integration Objects (New Field)” on page 92,
you want to add the new Siebel field ManagerLogin to the Employee domain, so SSSE can
synchronize it. To accomplish this, you must change the PIMSI Employee Inbound Map and the PIMSI
Employee Outbound Map. For more information about Integration Objects, see “About SSSE
Integration Objects” on page 90.

To change the data map for a new field
1 Use the SRF that contains your changes to Integration Objects.
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2 In your Siebel application, from the application-level menu, select Navigate > Site Map >
Administration - Integration > Data Map Editor.

3 In the Integration Map Object list, select PIMSI Employee Inbound Map.
In the Integration Component Map list, select Employee_Employee, and then scroll down.

5 In the Integration Field Map list, click New and complete the fields as shown in the following

table.
Field Comments
Source Expression [ManagerLogin]
Target Field Name ManagerLogin

6 Save the record.
7 In the Integration Map Object list, select PIMSI Employee Outbound Map.
8 Repeat Step 4 through Step 6.

Example of Changing Data Maps (Existing Field)

This topic gives one example of changing data maps as part of customizing SSSE. You may use this
feature differently, depending on your business requirements.

Continuing with the example from “Example of Changing Integration Objects (Existing Field)” on
page 94, you want to change the name of the existing EmployeePosition field to Position. To
accomplish this, you must change the PIMSI Employee Inbound Map and the PIMSI Employee
Outbound Map. For more information about Integration Objects, see “About SSSE Integration Objects”
on page 90.

To change the data map for an existing field
1 Use the SRF that contains your changes to Integration Objects.

2 In your Siebel application, from the application-level menu, select Navigate > Site Map >
Administration - Integration > Data Map Editor.

3 In the Integration Map Object list, select PIMSI Employee Inbound Map.

4 In the Integration Component Map list, select EmployeePosition_EmployeePosition, and then
scroll down.

5 In the Integration Field Map list, use standard query techniques to locate and select the record
in which Source Expression has a value of [EmployeePosition], and change that value to
[Position].

6 Save the record.
In the Integration Map Object list, select PIMSI Employee Outbound Map.
Repeat Step 4 through Step 6.
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Changing Siebel Domain Configurations

The following procedure describes how to change a Siebel domain configuration, as part of
customizing SSSE. This task is a step in “Process of Customizing SSSE” on page 91.

This procedure involves Field Type settings for both Siebel and PIM domains. The following
constraints exist:

B Synchronization requires mapping between Siebel fields and PIM fields.

B Mapping is only possible between fields that are listed in the Siebel Domain Fields list and the
PIM Domain Fields list.

B For each field that you want to synchronize, the Field Type value for the Siebel Domain Field must
match the Field Type value for the corresponding PIM Domain Field.

For more information about SSSE PIM domain configuration, see “Changing PIM Domain
Configuration” on page 100.

For an example of how to perform this task for a new field to be synchronized, see “Example of
Changing Siebel Domain Configurations (New Field)” on page 99.

For an example of how to perform this task for an existing field to be modified, see “Example of
Changing Siebel Domain Configurations (Existing Field)” on page 99.

To change a Siebel domain configuration

1 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains.

2 In the Siebel Domains list, select the domain to reconfigure.
3 In the Siebel Domain Fields list, click Sync Fields.

This action synchronizes the inbound data maps with Siebel domains, so the domains acquire the
new fields and field modifications that were made in the corresponding Inbound Data Maps.
However, Sync Fields does not delete fields that you deleted in Data Maps. You must delete these
fields manually, as described in Step 5 of this procedure.

4 In the Siebel Domain Fields list, select the record for the newly created or updated field, and set
an appropriate value for Field Type.

The value often describes the type of data that the Siebel field holds. For instance, both the
Business Phone field and the Home Phone field may have Field Type set to Phone.

NOTE: In order for SSSE to map a Siebel field to a PIM field successfully, you must set Field Type
for the Siebel field to a value that matches the field type of the PIM field.

5 In the Siebel Domain Fields list, use standard query techniques to locate the records for any fields
you deleted from Inbound Data Maps, and delete those records.
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Example of Changing Siebel Domain Configurations
(New Field)

This topic gives one example of changing SSSE configuration settings as part of customizing SSSE.
You may use this feature differently, depending on your business requirements.

Continuing with the example from “Example of Changing Integration Objects (New Field)” on page 92,
you want to add the new Siebel field ManagerLogin to the Employee domain, so SSSE can
synchronize it. To accomplish this, you must change the Siebel domain configuration.

To change a Siebel domain configuration for a new field

1 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains.

2 In the Siebel Domains list, select the record for the Siebel Employee domain.
In the Siebel Domain Fields list, click Sync Fields.

In the Siebel Domain Fields list, select the record for the ManagerLogin field, verify that both
Name and Field ldentifier are set to ManagerLogin, and set Field Type to Manager Name.

Example of Changing Siebel Domain Configurations
(Existing Field)

This topic gives one example of changing SSSE configuration settings as part of customizing SSSE.
You may use this feature differently, depending on your business requirements.

Continuing with the example from “Example of Changing Integration Objects (Existing Field)” on
page 94, you want to change the name of the existing EmployeePosition field to Position. To
accomplish this, you must change the Siebel domain configuration.

To change a Siebel domain configuration for an existing field

1 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains.

In the Siebel Domains list, select the record for the Siebel Employee domain.
In the Siebel Domain Fields list, click Sync Fields.

In the Siebel Domain Fields list, use standard query techniques to display all records with Name
set to Position.

In some circumstances, more than one record may be displayed.

5 Find the Position record in which both Name and Field Identifier are set to Position, and set Field
Type to Job Title in that record.

6 If another Position record exists in which Name is set to Position, but Field Identifier is set to
EmployeePosition, select that record and click Delete.
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Changing PIM Domain Configuration

The following procedure describes how to change a PIM domain configuration, as part of customizing
SSSE. This task must be performed if you want to enable synchronization for a PIM field that SSSE
does not currently synchronize. The examples described earlier in this chapter mapped Siebel fields
to PIM fields that were already listed in the PIM Domain Fields list in the Siebel application, so this
task is not required for those examples.

This task is a step in “Process of Customizing SSSE” on page 91.

This procedure involves Field Type settings for both Siebel and PIM domains. The following
constraints exist:

B Synchronization requires mapping between Siebel fields and PIM fields.

B Mapping is only possible between fields that are listed in the Siebel Domain Fields list and the
PIM Domain Fields list.

B For each field to be synchronized, the Field Type value for the Siebel Domain Field must match
the Field Type value for the corresponding PIM Domain Field.

For more information about SSSE Siebel domain configuration, see “Changing Siebel Domain
Configurations” on page 98.

To change a PIM domain configuration

1 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > PIM Domains.

In the PIM Domains list, select the domain to reconfigure.

In the PIM Domain Fields list, click New to create a record for the new PIM field, and complete
the fields as shown in the following table.

Field Comments

Name Specify a name of your choosing for SSSE to
use to identify this PIM field in a later
configuration step. Make a note of the name
you choose.

Field Identifier Specify a name of your choosing for SSSE to
use to identify this PIM field internally.
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Field Comments

Field Type Select a value that describes the kind of data
the PIM field holds, using non-technical terms
that indicate the field’s purpose, such as City
or Last Name or Pager. Must match the Field
Type value for the corresponding Siebel field.
Available values are specified in the Siebel List
of Values (LOV) PIMSI_FIELD_CLASS.

Data Type Select a value that technically specifies the
kind of data the PIM field holds, such as
Boolean or Integer or Unicode String. Valid
values depend on the PIM field you want to
synchronize.

NOTE: The Siebel List of Values (LOV)
PIMSI_FLD_ DATA_TYPE lists all the values
that you can specify for Data Type, but many
of the values in the LOV are not valid for any
individual PIM field.

4 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Configuration.

5 In the PIM Server Integration Configuration list, select the domain to reconfigure, such as
Exchange Calendar, Exchange Contact, or Exchange Task.

6 In the Configuration Parameters list, click New and complete the fields as shown in Table 26 and
Table 27.

NOTE: To fully specify a PIM field for synchronization, you may need to repeat this step several
times, creating several records that specify the same value for Section but different values for
Parameter and Value.

Table 26. PIM Field Configuration Parameters and Values (General Information)

Field Comments

Section Enter the value you specified for Name in
Step 3 on page 100.

Parameter Enter the name of the Exchange API that
provides access to the PIM field you want to
synchronize. For more information, see
Table 27.

Value Enter the name or other value that the
Parameter API uses to identify the PIM field
you want to synchronize. For more
information, see Table 27.
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Table 27. PIM Field Configuration Parameters and Values (Domain-Specific
Information)

PIM Domain

Exchange Contact
or Exchange Task

Parameter

MAPIPropertyName

Values

A MAPIPropertyName value is required for all
Exchange Contact or Exchange Task fields.

B For MAPI named properties, specify the identifier
of the MAPI property.

B For MAPI non-named properties, specify the 8-
digit hexadecimal identifier of the MAPI field.

For more information about MAPI named and non-
named properties, see your MAPI documentation.

PropertySetGUID

A PropertySetGUID value is required for Exchange
Contact or Exchange Task fields that are MAPI named
properties.

Specify the Global Unique Identifier (GUID) of the
property. If the named property is a custom field,
specify the GUID value for PS_PUBLIC_STRINGS or
PS_MAPI. If the named property is not a custom
field, specify the existing GUID.

For more information about property set GUIDs for
MAPI named properties, consult your MAPI
documentation.

SubNamespace

A SubNamespace value is required for Exchange
Contact or Exchange Task fields that are MAPI named
properties. Valid values are Id and String.
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Table 27. PIM Field Configuration Parameters and Values (Domain-Specific
Information)

PIM Domain Parameter Values
Exchange DAVPropertyName If the field you are specifying can be defined using an
Calendar existing WWW Distributed Authoring and Versioning

(WebDAV) property name, specify that name.

SSSE uses WebDAV for most Calendar information
that travels from the Siebel database to Exchange
(outbound data). For information regarding WebDAV
properties, see your Exchange SDK documentation.

ICALPropertyName | If the field you are specifying can be defined using an
existing Internet Calendaring (iCal) property name,
specify that name.

SSSE uses iCal for most Calendar information that
travels from Exchange to the Siebel database
(inbound data). For information regarding iCal
properties, consult RFC #2445.

MAPIPropertyName | If the field you are specifying cannot be defined
using an existing iCal property name for inbound
data or an existing WebDav property name for
outbound data, specify a MAPIPropertyName value
for a MAPI named property.

SSSE uses MAPI to synchronize any Calendar fields
that cannot be defined using existing iCal or WebDav
properties. For more information about MAPI named
properties, see your MAPI documentation.

Namespace Specify a valid property namespace. For information
regarding namespaces, see your Exchange SDK
documentation.

PropertySetGUID A PropertySetGUID value is required for Exchange
Calendar fields that are MAPI named properties.

Specify the Global Unique Identifier (GUID) of the
property. If the named property is a custom field,
specify the GUID value for PS_PUBLIC_STRINGS or
PS_MAPI. If the named property is not a custom
field, specify the existing GUID.

For more information about property set GUIDs for
MAPI named properties, see your MAPI
documentation.

SubNamespace A SubNamespace value is required for Exchange
Calendar fields that are MAPI named properties.
Specify the value String.
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Example of Changing PIM Domain Configuration

This topic gives one example of changing PIM configuration settings as part of customizing SSSE.
You may use this feature differently, depending on your business requirements.

In this example, you want to add the new Exchange field Pager to the Employee domain, which is
equivalent to the PIM Domain IPM.Contact.

To change a PIM domain configuration

1 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > PIM Domains.

In the PIM Domains list, select Exchange Contact.

In the PIM Domain Fields list, click New to create a record for the new PIM field, and complete
the fields as shown in the following table.

Field Value

Name Pager

Field Identifier PR_PAGER_TELEPHONE_NUMBER
Field Type Pager

Data Type Unicode String

4 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Configuration.

In the PIM Server Integration Configuration list, select Exchange Contact.

In the Configuration Parameters list, click New and complete the fields as shown in the following

table:
Field Value to Enter
Section Pager
Parameter MAPIPropertyName
Value 0x3A21001F

Changing Domain Map Configurations

The following procedures describe how to change a Domain Map configuration, as part of customizing
SSSE. The first procedure describes changing a map after designating a field for synchronization.
The second procedure describes changing a map after modifying a field that is already synchronized.

This task is a step in “Process of Customizing SSSE” on page 91.
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To change a Domain Map configuration after designating a field for synchronization

1

From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Domain Map.

In the Domain Map list, select the domain in which you created a new field.

In the Field Map list, use standard query techniques to discover if a record already exists for this
field.

If such a record exists, then select it and click Delete.

In the Field Map list, click New to create a new record for the new field, and complete the fields
as shown in the following table.

Field Comments

Siebel Field Enter the current name of the Siebel field to
be synchronized.

For example, for a newly created Siebel field
called ManagerLogin, enter ManagerLogin.

PIM Field Enter the current name of the PIM field to be
synchronized.

For example, the PIM field to be synchronized
with the new Siebel field might be Manager
Name.

LOV Translation Map Select the name of the translation map that
associates PIM values with Siebel LOV items
for the new field. Scroll down to the
Translation List to see the mappings that the
selected map contains. For example, the
Country map associates the Siebel Value of
USA with the PIM Value of United States of
America.

Key Field Select the check box to direct SSSE to use the
selected field to help uniquely identify any
Siebel record in the selected domain, and to
match that Siebel record with a corresponding
PIM record.

Sync Enabled Select the check box to allow the new field to
be synchronized.

To change a Domain Map configuration after modifying a synchronized field

1

From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Domain Map.

In the Domain Map list, select the domain in which you changed an existing field.
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3 In the Field Map list, select the record for the field you changed, and modify the record’s fields
as needed to map between Siebel fields and PIM fields correctly.

For example, if you changed the name of the Siebel field EmployeePosition to just Position, you
would make a corresponding change to the Siebel Field value in the Field Map list.

4 Inspect the Field Map list to determine whether the field is listed more than once, and delete any
obsolete rows that you find for the same field.

The Field Map list should contain only one record for each field you are mapping.

About SSSE User Filtering

SSSE runs a user filtering algorithm periodically to determine which users have Siebel database
records that have been changed and that need to be synchronized with Microsoft Exchange. For an
implementation of SSSE that is not customized, the default user filtering configuration monitors
changes in every table that is referenced by the domains and fields that are synchronized by default.

The default user filtering configuration involves 15 Siebel Business Components. Table 28 lists these
Business Components and the fields and Objects associated with them. Each business component
has a set of fields that record the true database update time of each row in a table or joined table.
In addition, each Business Component has a User Id field that specifies the owner of each record in
the Business Component.

Table 28. Default SSSE User Filtering Configuration

Fields Mapped to Database

Business Object Business Component Last Update Time

PIMSI Sync Info PIMSI Sync Info DB_LAST_UPDATE

PIMSI User Filter Action PIMSI User Filter Action Activity Last Upd, Act Employee
Last Upd

PIMSI User Filter Action PIMSI User Filter Action Account Account Last Upd

PIMSI User Filter Action PIMSI User Filter Action Contact Action Contact Last Upd

PIMSI User Filter Action PIMSI User Filter Action Contact 2 Contact Last Upd

PIMSI User Filter Action PIMSI User Filter Action Contact 3 Contact Last Upd

PIMSI User Filter Action PIMSI User Filter Action Oppty Oppty Last Upd

PIMSI User Filter Action PIMSI User Filter Action Project Project Last Upd

PIMSI User Filter Action PIMSI User Filter Action SR SR Last Upd

PIMSI User Filter Contact | PIMSI User Filter Contact Contact Info Last Upd, Contact

Last Upd, Party Last Upd

PIMSI User Filter Contact | PIMSI User Filter Contact Account Account Last Upd

PIMSI User Filter Contact | PIMSI User Filter Contact Business | Address Last Upd
Address

106 Siebel Server Sync Guide Version 7.7, Revision A



ustomizing Siebel Server Sync & Process of Customizing SSSE

Table 28. Default SSSE User Filtering Configuration

Fields Mapped to Database

Business Object Business Component Last Update Time

PIMSI User Filter Contact | PIMSI User Filter Contact Oppty Oppty Last Upd

PIMSI User Filter Contact | PIMSI User Filter Contact Personal Address Last Upd
Address

PIMSI User Filter Contact | PIMSI User Filter Contact Position Contact Position Last Upd

Each time the user filtering algorithm runs, a set of queries is issued to identify the users whose
records have changed since the last filtering. For example, for particular values of last_filtering_time
and business_component_name, the query finds information that can be described as follows:

All User Ids in business component_name where DB_LAST_UPDATE >= Jast filtering time

Some Business Components have more than one database update time field. Separate queries are
issued for each of these fields, sequentially. As a result, 18 queries are issued each time the user
filtering algorithm runs. The union of query results is the set of users who have records that need to
be synchronized with the Exchange Server.

Changing User Filtering Configurations

If your customization of SSSE does not involve synchronizing fields from a new table or a new joined
table, then no user filtering configuration changes are required.

If your customization of SSSE does involve synchronizing fields from a new table or a new joined
table, then the application developer must make sure that the user filtering configuration is adequate
for detecting data changes in any new fields that SSSE will synchronize. For more information about
the user filtering process, see “About SSSE User Filtering” on page 106. This task is a step in “Process
of Customizing SSSE” on page 91.

The following procedure briefly describes how to change the user filtering configuration to detect
changes made in new fields to be synchronized.

To change the SSSE user filtering configuration

1 Make sure that the table that contains the field to be synchronized has a DB_LAST_UPD column
that records the true database update time.

2 Generate a script to populate the DB_LAST_UPD column when data in the table changes.

Modify an existing user filtering business component or create a new user filtering business
component to include the DB_LAST_UPD column.

4 From the application-level menu, select Navigate > Site Map > Administration - PIM Server
Integration > Configuration > PIM Server Integration Configuration.

5 In the PIM Server Integration Configuration list, select User Filter.

6 In the Configuration Parameters list, perform one of the following actions:
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For an existing user filtering business component, select the record where Parameter is set
to the Business Component name, and add any new DB_LAST_UPD column to the Value field,
using commas to separate multiple values.

For a new user filtering business component, click New and complete the fields in the new
record, as shown in the following table:

Field Comments

Section Enter the name of the Business Object for
the new Business Component.

Parameter Enter the name of the new Business
Component.
Value Enter DB_LAST_UPD.
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This chapter provides information about administering SSSE. It includes the following topics:
“About Administering SSSE” on page 109

“Establishing Domains for SSSE” on page 109

“SSSE Domain Mapping” on page 115

“Setting SSSE Group and User Access Controls” on page 118

“About SSSE File Maintenance” on page 124

“Reinitializing an SSSE User” on page 124

“About SSSE Log Files” on page 125

“About Moving or Deleting Mailboxes for SSSE Users” on page 127

About Administering SSSE

This chapter provides information about the following aspects of administering SSSE:
Setting Siebel and PIM domain properties

Mapping Siebel and PIM domain fields to each other

Mapping Siebel users and PIM users to each other

Setting access levels

Maintaining files

Using logs

Moving or deleting Exchange mailboxes of SSSE users

Many settings related to domains and mappings are preconfigured in SSSE; you do not need to
perform some tasks unless you want to change the default settings. However, you must set user
access permissions. All tasks in this chapter are performed from the Administration - PIM Server
Integration screen of the Siebel application.

Establishing Domains for SSSE

This topic discusses Siebel domains and PIM domains for which you may need to configure some
settings.
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About Siebel Domains
SSSE is preconfigured with the following Siebel domains, which are designed to synchronize Siebel
data with Microsoft Exchange Server data:

B Siebel Business Contact
B Siebel Calendar
B Siebel Employee
B Siebel Personal Contact

Siebel To Do

CAUTION: Do not change the values of the Name or EAI Integration Object fields for the provided
Siebel domains. PIMSI Engine functions properly using only the Siebel domains in the preceding list.

The current version of SSSE does not support the creation of new Siebel domains. However, following
topics provide information about how to set certain characteristics for the preconfigured Siebel
domains.

About PIM Domains

SSSE is preconfigured with the following PIM domains, which are designed to synchronize Microsoft
Exchange data with the Siebel database:

B Exchange Calendar
B Exchange Contact
B Exchange Task

CAUTION: Do not change the Name or Domain lIdentifier of the provided PIM domains. PIMSI Engine
functions properly using only the PIM domains listed previously.

Although domains are preconfigured, you must set default values and designate required fields, as
described in “Setting Required PIM Domain Fields and Defaults” on page 114.

After the characteristics of Siebel domains and PIM domains are established, then the domain fields
must be mapped and field-level synchronization must be set (see “SSSE Domain Mapping” on
page 115).

Topics in This Section
“Setting Siebel Domain-Level Synchronization” on page 111

“Setting PIM Category Values for Siebel Domains” on page 113
“Setting Required Siebel Domain Fields and Defaults” on page 113
“Setting Required PIM Domain Fields and Defaults” on page 114
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Setting Siebel Domain-Level Synchronization

Domain-level synchronization establishes the highest allowable synchronization setting for all users
and groups on the domain. You must set user-level and group-level synchronization to values that
are equal to or lower than the domain-level synchronization. For more information about
synchronization levels, see “SSSE Synchronization Options” on page 15.

To set domain synchronization

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains.

2 In the Siebel Domains list, select a record.
3 In the Domain Sync Support field, select a synchronization level for the domain.

Table 29 describes the synchronization levels available for all Siebel domains, and Table 30 on
page 111 lists the default synchronization levels for each domain.

4 Repeat Step 2 and Step 3 for each Siebel domain.

Table 29. Available Synchronization Levels for Siebel Domains

Synchronization Level Description

Full Sync Changes made in Microsoft Exchange Server and
Siebel domains are synchronized with each other
bidirectionally.

NOTE: Do not choose Full Sync for the Employee
domain, where the maximum supported level of
synchronization is Export Only. Choosing Full Sync
for the Employee domain can result in data
corruption.

Export Only Changes made in the Siebel domains are exported
to Microsoft Exchange Server.

None No synchronization takes place.

NOTE: Import Only synchronization level is not supported for any of the Siebel domains. For more
information about this limitation, see “About the Limitation Against Import Only Synchronization Level”
on page 112, later in this topic.

Table 30. Default Synchronization Level Values for Siebel Domains

Siebel Domain Default Synchronization Level
Business Contact Full Sync
Personal Contact Full Sync
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Table 30. Default Synchronization Level Values for Siebel Domains

Siebel Domain Default Synchronization Level

Employee Export Only
Siebel Calendar Full Sync
Siebel To Do Full Sync

About the Limitation Against Import Only Synchronization Level
Import Only synchronization level is not supported for any of the Siebel domains. The reason for this
limitation is that there are potential data integrity problems if data is imported only from Exchange
to Siebel applications.

This hazard to data integrity arises from the different methods the two systems use to store data.
Siebel applications use a relational database, but Exchange Servers maintain data using an individual
data store for each Exchange user.

As an example of the kind of issue that could arise, a Business Contact record in a Siebel application
can be shared between multiple people in a team. Any update that one user makes to the Business
Contact record in Siebel is immediately visible to other users, because all users are accessing a single
record in the relational database. However, in Exchange, each user has his or her own set of Contact
records. An update made to one user’s Contact record is not reflected in other users’ Contact
information. If data was only imported from Exchange into Siebel applications, an update made by
one user could be lost when another user makes a conflicting update. The following paragraphs
describe in more detail how an example Business Contact record would be handled for different
synchronization levels:

B  When the synchronization level is set to Full Sync, then if someone changes synchronized data
in either the Siebel application or Exchange, that change is reflected for other users in both the
Siebel application and Exchange. For example, one member of a sales team might learn that a
Business Contact’s phone number had changed. All members of the team would soon see the
new phone number in both the Siebel application and Exchange, regardless of where the change
was made. Within a short period of time after a data change occurs, all users are working from
the same updated data.

B  When the synchronization level is set to Export Only, then a data change made in the Siebel
application is reflected for other users in both Siebel and Exchange, but changes made in
Exchange are visible only to the user who made the change, until such time as a later data
change in the Siebel application overwrites the data in Exchange. So, a Business Contact phone
number changed in the Siebel application would be visible to all team members, in both the
Siebel application and Exchange. However, a phone number changed in Exchange would be
visible only to the team member who changed it, and only until the next synchronization
overwrites it with the value from the Siebel database. Again, within a short period of time after
a data change occurs, all users are working from the same updated data.
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B If you were allowed to set the synchronization level to Import Only, then a data change made in
either Exchange or the Siebel application would be briefly reflected for all team members in the
Siebel application. However, the change would be visible in Exchange only for the user who made
the change. The change in the Siebel application would persist only until another user made a
conflicting update. So, a Business Contact phone number changed either in the Siebel
application, or in Exchange would be visible in the Siebel application to all team members, but
only until the next synchronization of a team member who had a different phone number for the
Business Contact, such as the old phone number. It would be possible for the phone number in
Siebel to change repeatedly between the values held by different Exchange users, and for the
Exchange values to continue to differ, so that team members would not be working from the same
data. For this reason, the Import Only synchronization level is not supported.

Related Topics
“SSSE Synchronization Options” on page 15

Setting PIM Category Values for Siebel Domains

For each Siebel domain, an administrator can specify a value that a Microsoft Exchange record’s
Category field value must match, in order for SSSE to synchronize the record. The following
procedure describes how to specify this value.

NOTE: If your Siebel implementation uses more than one language, a user can specify a Category
value for an Exchange record in the user’s regular working language. For a record that originates in
the Siebel application, SSSE assigns a Category value to the corresponding Exchange record using
the language that the administrator configured for the user in the User Map. For information about
this language setting, see “Mapping Individual Users” on page 122.

To set the PIM Category Value for a domain

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains.

In the Siebel Domains list, select a record.

In the PIM Category Value field, enter the value you want to match against the Category field in
Microsoft Exchange records.

4 Repeat Step 2 and Step 3 for additional domains, as needed.

Setting Required Siebel Domain Fields and Defaults

The administrator can set which Siebel domain fields require a value, and must specify a default
value for each required field.
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When a user creates a new Contact, Appointment, Employee, or To Do record in the Siebel
application, the application cannot save the record until all required fields have a value. Similarly, if
a user creates a new Microsoft Exchange Contact or Task record, SSSE synchronizes the record only
if either the administrator has specified a default value to use when the field is empty, or if the
Exchange record includes values to synchronize to all Siebel fields that require them.

The following procedure describes how to specify that a field requires a value, and how to provide a
default value for that field.

To set required Siebel domain fields and defaults

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Siebel Domains.

2 In the Siebel Domains list, select the domain for which you want to set required fields.
In the Siebel Domain Fields list, select the field you want to make required.
4 Select the Required check box.

NOTE: If Required field is not visible, to make it visible click Menu and choose Columns
Displayed.

5 In the Default Value field, enter the value you want to use as the default value.

Setting Required PIM Domain Fields and Defaults

The administrator can set which PIM domain fields require a value, and must specify a default value
for each required field.

When the user creates a new Contact, Appointment, Employee, or To Do in the Siebel application,
SSSE synchronizes the record with the Exchange Server only if either the administrator has specified
a default value to use when the field is empty, or if the Siebel record includes values to synchronize
to all Exchange fields that require them.

NOTE: In any individual Exchange record, the user can change the value of the field from the default
value to another value, but only an administrator can choose a different value to be assigned as a
default.

The following procedure describes how to specify that a PIM field requires a value, and how to provide
a default value for that field.

To set required PIM domain fields and defaults

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > PIM Domains.

In the PIM Domains list, select the domain for which you want to set required fields

In the PIM Domain Fields list, select the field you want to make required.
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4 Select the Required check box.

NOTE: If Required field is not visible, to make it visible click Menu and choose Columns
Displayed.
5 In the Default Value field, enter the value you want to use as the default value.

If the Default Value field contains the value Not Set, then the user must enter a string value; no
default value is established.

SSSE Domain Mapping

The mapping of PIM domains and Siebel domains is preestablished in SSSE and must not be modified.
However, you can configure the mapping of domain fields. You can also set field-level synchronization
for each mapped field. This determines if the mapped field will be synchronized.

In the case of a synchronization conflict where SSSE cannot reconcile the data, the current version
of SSSE always uses the data from the Siebel application.

The administrator can also set Key Fields. Key Fields are used to determine if records in PIM and the
Siebel application are the same record.

Topics in This Section
“Mapping PIM Domains and Siebel Domains” on page 115

“About Resolving Synchronization Conflicts” on page 116
“Mapping Fields” on page 116

“Setting Key Fields” on page 117

“Setting Field-Level Synchronization” on page 117

Mapping PIM Domains and Siebel Domains

The mapping of a Siebel domain to a PIM domain (such as a Microsoft Exchange Server domain)
allows SSSE to synchronize these two domains.

CAUTION: The mapping of the Siebel and PIM domains is preestablished in SSSE. Do not change
the name of the Domain Maps or the default mapping of PIM and Siebel domains.

Table 31 shows the predefined mapping of Siebel and PIM domains.

Table 31. Default Mapping of Siebel and PIM Domains

Domain Map Name Siebel Domain Name PIM Domain Name
Siebel-Exchange Business Contact Map Siebel Business Contact Exchange Contact
Siebel-Exchange Calendar Map Siebel Calendar Exchange Calendar
Siebel-Exchange Employee Map Siebel Employee Exchange Contact
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Table 31. Default Mapping of Siebel and PIM Domains

Domain Map Name Siebel Domain Name PIM Domain Name
Siebel-Exchange Personal Contact Map Siebel Personal Contact Exchange Contact
Siebel-Exchange Task Map Siebel To Do Exchange Task

About Resolving Synchronization Conflicts

If data in the Siebel application and Microsoft Exchange Server has been modified in such a way that
SSSE cannot synchronize the differences, the current version of SSSE always resolves the conflict by
using the data from the Siebel application.

An example of a synchronization conflict might be that the Status of an Exchange Task was set to a
value that differs from the value of the corresponding Siebel To Do item. If the status was updated
at approximately the same time, thereby falling within the same synchronization cycle, SSSE has no
way to determine which update should be applied, and automatically uses the data from the Siebel
application.

Mapping Fields

Administrators can map individual fields between the Siebel and PIM domains. This mapping
determines which fields in the Siebel application are synchronized with which fields in Microsoft
Exchange Server and vice versa.

Administrators can turn synchronization on or off for each individual mapped field.

NOTE: In SSSE, some editable Exchange fields are mapped to Siebel pick list fields. If data for these
fields is entered in Microsoft, typographical errors and case mismatches can cause synchronization
problems. To minimize this possibility, you can set the Siebel pick list fields to be case insensitive.
For information about enabling field-specific case insensitivity, see Applications Administration
Guide.

To create a new field mapping

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Domain Map.

2 In the Domain Map list, select a record.

3 In the Field Map list, click New, and then fill in the fields for the new record using the following

values.
Field Description
Siebel Field Select a Siebel field.
PIM Field Select a PIM field.
LOV Translation Map Select an appropriate List of Values (LOV) translation map.
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Field Description

Key Field Select this check box if you want this field to be a key field. See
“Setting Key Fields” on page 117.

Sync Enabled Select this check box if you want this field synchronized. For more
information about synchronizing specific fields, see “Setting Field-
Level Synchronization” on page 117.

Setting Key Fields

The first time SSSE synchronizes a particular record, SSSE uses Key fields to determine if a Contact,
Calendar Appointment, Employee, or To Do in the Siebel application is the same record as in Microsoft
Exchange Server and vice versa. If the values in all key fields of a record match, then SSSE assumes
that the record is the same record, and SSSE synchronizes the record between the Siebel application
and Exchange. If all key fields do not match, then SSSE assumes the record is a unique record.

The following procedure describes how to set key fields.

To set key fields

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Domain Map.

2 In the Domain Map list, select a record.
In the Field Map list, select a record.

4 Select the Key Field check box.

Setting Field-Level Synchronization

Administrators can turn synchronization on or off for each individual mapped field. You do not need
to unmap fields to disable synchronization.

To enable or disable field synchronization

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Domain Map.

2 In the Domain Map list, select a record.
In the Field Map list, select a record.

4 Select the Sync Enabled check box if you want synchronization enabled for this field. Clear the
check box if you want synchronization disabled.
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Setting SSSE Group and User Access
Controls

To allow users to synchronize between Microsoft Exchange Server and the Siebel application, you
must map each PIM user to a Siebel user login, and then enable synchronization for the user.
Optionally, you can set a synchronization level for each of a user’s Siebel domains (Business Contact,
Personal Contact, Employee, or To Do). If you do not set the synchronization level for a user, then
SSSE uses the domain synchronization level.

You can also set the synchronization level for a group. A group is any Organization, Position, or User
List defined in the Siebel application.

Topics in This Section
“Setting User-Level Synchronization” on page 118

“Setting Group-Level Synchronization” on page 120
“Mapping Individual Users” on page 122

“Mapping Multiple Users” on page 122

“Enabling or Disabling User Synchronization” on page 123

Setting User-Level Synchronization

User-level synchronization allows you to set the synchronization level separately for each of a user’s
Siebel domains except Calendar (Business Contact, Personal Contact, Employee, or To Do). You can
also use user-level synchronization to give a particular user a different synchronization level from
other users.

You cannot set user-level synchronization higher than domain-level synchronization. For example,
the user cannot have Full Sync privileges if the overall domain is limited to Export Only. If the
domain-level synchronization is set to None, then no users or groups are able to synchronize on that
domain.

No user-level synchronization control is available for the Calendar domain. The administrator sets
Calendar synchronization at the domain level.

NOTE: In addition to setting each user’s synchronization level, you must enable each user’s
synchronization or SSSE cannot synchronize records for that user. For more information about
enabling synchronization, see “Enabling or Disabling User Synchronization” on page 123.
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To set user-level synchronization

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Sync Access Control > User Level Access Control.

2 In the User Level Access Control list, select a record for a particular user.

In the User-Level Access Control list (lower list), click New, and then fill in the fields as shown in
the following table.

Field Description

Siebel Domain Name Select Siebel Business Contact, Siebel Employee, Siebel Personal
Contact, or Siebel To Do.

Administrator Override When selected, user-level synchronization is preserved and used
for the selected user, even if that user belongs to a group for which
an administrator has set a different group synchronization level.
Selected by default. It is recommended that you leave this setting
as is. For more information about group synchronization levels, see
“Setting Group-Level Synchronization” on page 120.

Admin Sync Level Select Full Sync, Export Only, or None. This sets the maximum
synchronization level that can be set for this user and domain.

Allow User Leave check box cleared. User customization of the synchronization
Customization level is not supported in this release of SSSE.

Allow MVG Creation Select the check box (On).

Visibility Type Determines whether the data that the user can synchronize is

limited to records visible in specified views. The available values for
each domain are as follows:

B Business Contact Domain. Available Visibility values are All,
Sales Rep, or no value (empty). Default value is Sales Rep.

B Employee Domain. Available Visibility values are All or no
value (empty). Default value is All.

B Personal Contact Domain. Available Visibility values are
Personal or no value (empty). Default value is Personal.

B Tasks Domain. Available Visibility values are Personal or no
value (empty). Default value is Personal.

For information about the meanings of these Visibility values, see
Table 32 on page 120.

4 Repeat Step 3 on page 119 for each additional domain where you want to specify user-level
access for the selected user.
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Table 32. Visibility Type Value Descriptions

Visibility Value Description

All The user can synchronize any of the data that is visible to them in
the selected domain and that is set up for synchronization by the
Administrator. This Visibility value is available for the Employees and
Business Contact domains.

Sales Rep The user can synchronize data in the selected domain based on his
or her position. If the data is associated with the user’s position or
with a direct report’s position, then the data is visible to the user in
the Contacts view, and the user can synchronize that data. For
example, if the Sales Team field for a Contact record lists anyone
who has the same position as the user or one of the user’s direct
reports, then the data in that Contact record is visible to the user in
the My Contacts view. This Visibility value is available for the
Business Contacts domain, only.

Personal The user is limited to synchronizing data in the selected Domain that
is specifically marked as personal (non-business) data. No other user
can view this data, regardless of position. This Visibility value is
available for Tasks and Personal Contacts domains. Data to be
synchronized must appear in the user’s My Activities or My Personal
Contacts views, depending on the selected domain, and must have
the Private check box selected. Personal visibility is also appropriate
for the Calendar domain, where an administrator must set the
synchronization level settings at the domain level, rather than the
user level.

NOTE: The Personal value cannot be used for the Employees and
Business Contacts domains.

(Empty field) If the Visibility Type field is left blank, SSSE uses the default Visibility
Type for the selected domain.

NOTE: The Visibility setting described in this topic does not affect which records are visible to the
user in the application; it only affects which records can be synchronized.

Related Topics
“SSSE Synchronization Options” on page 15

“Setting Siebel Domain-Level Synchronization” on page 111

Setting Group-Level Synchronization

In addition to the ability to set synchronization level by individual user, you can set synchronization
level for a group of users. A group is any Organization, Position, or User List defined in the Siebel
application.
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Group synchronization is a mechanism for setting the user synchronization level for multiple users.
After you set synchronization values for the group, SSSE propagates the values to the members of
the group, thereby setting the individual user’s synchronization values.

NOTE: Make sure that the user’s synchronization is enabled or that user cannot synchronize,
regardless of the group synchronization level that is set. For more information about enabling
synchronization, see “Enabling or Disabling User Synchronization” on page 123.

CAUTION: SSSE applies group-level synchronization settings only to members of the selected group
who do not have Administrator Override selected in the User Level Access Control list. For more
information about the User Level Access Control list, see “Setting User-Level Synchronization” on
page 118.

To set group-level synchronization

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Sync Access Control > Group Access Control.

2 In the User Group Access Control list, click New, and then fill in the fields as shown in the
following table.

Field Description

Party Name Select the name of a party.

Party Type Code Automatically set to the correct value.

Siebel Domain Name Select Siebel Business Contact, Siebel Employee, Siebel Personal
Contact, or Siebel To Do.

Admin Sync Level Select Full Sync, Export Only, or None. This sets the Admin Sync Level
for each user in the group.

Allow MVG Creation Select the check box (On).

Allow User Leave check box cleared. User customization of the synchronization

Customization level is not supported in this release of SSSE.

Status Is automatically set to Pending, which means that the changes are

pending propagation to the users in the group.

3 Click the Propagate Changes button.

The group settings are propagated to each user that is a member of the group. This overwrites
any user settings that might already exist, provided that Administrator Override is not selected
for those users. The Status field is cleared, indicating that the changes were successfully
propagated.

Related Topics
“Setting User-Level Synchronization” on page 118
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Mapping Individual Users

To allow synchronization between the Siebel application and a PIM, you must map each Siebel user
to a PIM user, and then enable synchronization for the user.

To map a Siebel user to a PIM user

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Sync Access Control > User Map.

2 In the User Map list, click New, and then fill in the fields as shown in the following table.

Field Description

Siebel User Login Enter the user’s Siebel application login.

PIM User lIdentifier Enter the user’s Microsoft Exchange Server email address. This entry is
in the form <user>@<company.xxx> (Example:
jbrown@somecompany.com).

NOTE: This value must also match the email address in the user’s
Siebel Employee record, with the case matching exactly. If necessary,
the value can differ in case from the user’s Exchange email address, but
if the match with the Siebel Employee record is not exact, calendar
synchronization for the user fails.

PIM Server Type Select Exchange 2000.
Language Select a language.
Sync Enabled Select this check box to enable synchronization for this user.

Related Topics
“Mapping Multiple Users” on page 122

“Setting User-Level Synchronization” on page 118

Mapping Multiple Users

SSSE provides an automated method for mapping multiple users to allow synchronization between
the Siebel application and Microsoft Exchange Server. You can use this method to map all employees
in a Siebel deployment, for example. The Map User button finds and maps Siebel user login names
to Exchange email addresses. After you map the users, you must enable synchronization for each
user.

To map multiple users

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Sync Access Control > User Map.
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In the User Map list, click Map User.
The PIM Server Integration User Map dialog box appears.

Fill in the fields as shown in the following table, and then click Map Users.

Field Value

Business Object Name Select a business object. (Example: Employee).
Business Object Component Select a business component. (Example: Employee).
PIM Login Field Name Email Addr.

Siebel Login Field Name Login Name.

PIM Server Type Exchange 2000.

Default Language Select a language. (Example: English-American).

The mapped users appear in the User Map list.

From the Edit menu, choose Select All.

From the Edit menu, choose Change Records.

Under 1st Field to Change, in the field called Field, select Sync Enabled.
Under 1st Field to Change, in the Value field, type Y, and then click OK.
The Sync Enabled check box is selected for all of the highlighted records.

Enabling or Disabling User Synchronization

The administrator can enable or disable synchronization for each user individually.

To enable or disable user synchronization

1

2

From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Sync Access Control > User Map.

In the Sync Access Control list, select a record.
In the User Map list, select a record.

Select the Sync Enabled check box to enable synchronization for this user. Clear the check box
to disable synchronization.
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About SSSE File Maintenance

SSSE stores information about data changes to synchronize in the S_SD_SYNC_INFO table. Due to
technical limitations, this information is collected for all users, not just users for whom
synchronization has been enabled. Therefore, this table can accumulate a large number of rows in a
short time.

SSSE automatically removes rows that are associated with sync-enabled users (users who have
synchronization enabled) from the S_SD_SYNC_INFO table when the applicable synchronization
takes place. SSSE also automatically removes rows that are associated with users who have never
synchronized, on a schedule that is determined by the configuration parameter DispCycleCount for
GC (Dispatcher Cycle Count for Garbage Collection).

Rows are preserved indefinitely for users who are not currently sync-enabled, but who have
synchronized in the past. Preserving these rows allows for correct synchronization if synchronization
is later reenabled for one of the users in question. However, if a large number of users have
synchronization temporarily disabled, SSSE performance can decline as the size of the
S_SD_SYNC_INFO table grows.

For best results, it is recommended that you minimize the number of users who have synchronization
disabled after previously synchronizing.

CAUTION: Do not delete rows from the S_SD_SYNC_INFO table manually, as this can cause data
corruption. You can help control the size of the S_SD_SYNC_INFO table by deleting User Map records
for users who have previously synchronized but are not currently sync-enabled.

If you want to reenable synchronization for such users at a later time, you must create a new User
Map record for each such user. When you add a User Map record for a user and reenable
synchronization for that user, SSSE automatically performs a new initial extract operation for that
user. During this initial extract, Exchange contact records are checked for duplication before being
added as Siebel records. Unfortunately, technical constraints do not allow Exchange calendar records
to be checked for duplication, so a repeat of an initial extract for a given user is likely to result in
duplicate Siebel Calendar records. For more information about working with the User Map, see
“Mapping Individual Users” on page 122.

For more information about setting the DispCycleCount for GC configuration parameter, see “Tuning
SSSE Siebel Profile Parameters” on page 73. For more information about redoing an initial extraction
for a previously synchronized user, see “Reinitializing an SSSE User” on page 124.

Reinitializing an SSSE User

From time to time, you may need to reinitialize extraction for an SSSE user. For example, if a user
who has previously synchronized is currently not sync-enabled, a new initial extraction must be done
for that user before synchronization is reenabled for that user.

The following procedure describes how to reinitialize such a user.

CAUTION: During the initial extract that follows reinitialization, Exchange contact records are
checked for duplication before being added as Siebel records. Unfortunately, technical constraints do
not allow Exchange calendar records to be checked for duplication, so a repeat of an initial extract
for a given user is likely to result in duplicate Siebel Calendar records.
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To reinitialize an SSSE user

1 Navigate to Site Map > Administration - PIM Server Integration > Sync Access Control > User
Map.

2 In the User Map list, select the record for the user to be reinitialized, and then click Delete.
Create a new row and remap the user, as described in “Mapping Individual Users” on page 122.

4 Enable synchronization for the user, as described in “Enabling or Disabling User Synchronization”
on page 123.

About SSSE Log Files

Log files for SSSE reside in the siebsrvr\log directory, along with log files for other Siebel software
modules.

The amount of information that is logged can be tuned by adjusting log level settings. By default,
multiple log files are created. For information about how to tune log levels or to consolidate log files,
see “Modifying Log File Settings” on page 70.

In particular, the log file for the Exchange Connector records the following information, which can be
useful during troubleshooting:

B Exchange Connector successfully establishing a connection to the Exchange Server

B Exchange Connector processing domains for each user, including the number of records extracted
for each domain for each user

B Exchange Connector detecting a conflict
Other useful information that can be logged includes the following:

B PIMSI Engine and PIMSI Dispatcher startup and shutdown information is captured in the log file
whose name is of the form siebel.machineName.log, where machineName is the name of the
machine where PIMSI Engine or PIMSI Dispatcher runs.

B Several statements are typically logged regarding the beginning and ending of each extract
session. This information is captured in log files that have names of the forms PIMSIEngxxxxx.log
and PIMSIDispatcherxxxxx.log.

For examples of SSSE log messages, see Table 33.

Table 33. Typical SSSE Log Messages

SSSE Event Example of Log Message for Event

User Extract Session Start PIMS1EngSvc PIMSIInformational 4 0 2004-10-14 20:55:14 BatchMgr:
Starting extract for user PIMS11120

Extract data from Exchange Start | PIMSIEngSvc PIMSIInformational 4 0 2004-10-14 20:55:15 SBL-MBL-
51026: Extracting Domain IPM.Contact for User PIMSI1120.

Extract data from Exchange End | PIMSIEngSvc PIMSIInformational 4 O 2004-10-14 20:55:30 Connector:
CSSExchangeConnector : :ExtractUser (): Extracted 1 records for user
pimsill20@pimsisiebel.com for domain IPM.Contact
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Table 33. Typical SSSE Log Messages

SSSE Event Example of Log Message for Event

Extract data from Siebel Start PIMSIEngSvc PIMSIInformational 4 O 2004-10-14 20:55:51 SBL-MBL-
51026: Extracting Domain PIMSI Intermediate Business Contact for
User PIMSI1120.

PIMSIEngSvc PIMSIInformational 4 0 2004-10-14 20:55:51 BatchMgr:
Extracted 2 records for user PIMSI11120 for domain PIMSI Intermediate

Extract data from Siebel End

Business Contact

Import an Exchange record to

Siebel

PIMSIEngSvc PIMSIDebug 5 0 2004-10-14 20:55:47 (ssuserinit.cpp
(1002)) SBL-MBL-51027: Pushed row:
RowlD=7aac6063c0a8fd42806472a6ec618a0400000123a203 ,
User=pimsill20@pimsisiebel .com, Domain=1PM.Contact.

Export a Siebel record to
Exchange

PIMSIEngSvc PIMSIDebug 5 0 2004-10-14 20:55:55 (ssuserinit.cpp
(4696)) SBL-MBL-51027: Pushed row: RowlD=42-5AUWH , User=PIMSI11120,
Domain=PIMSI Intermediate Business Contact.

User Extract Session End

PIMS11120.

PIMSIEngSvc PIMSIInformational 4 0 2004-10-14 20:55:57 SBL-MBL-
51003: Successfully extracted domain All Domains for user

Table 34 lists SSSE error messages that do not indicate a major problem; that is, these errors do not
prevent the user’s synchronization session from completing, and the following synchronization
session for that user ordinarily will not repeat the same error messages.

Table 34.
Logged Error Message

Failed to process the
unresolved attendees for
Siebel Row: row_number,
Siebel Domain:
domain_name.

Cause of Error

SSSE cannot save the
unresolvable attendees
for the appointment in the
indicated row

SSSE Error Messages That Can Accompany Successful Synchronization

Error Codes

None

One or more records with
the same key already
exists.

SSSE found a duplicate
row in the Siebel
database.

IDS_ERR_EAI_SA_ MULTIPLE_MATCH
IDS_ERR_EAI_SA_ DUP_CONFLICT
SSASqIErrDupConflict2
SSASqIErrDupConflict

One or more required
fields of this record are
empty.

126

One of the required fields
for this record is empty
and there was no default
configured.

IDS_ERR_EAI_SA_MISSING_REQ_FIELD
IDS_WRN_EAI_SA_ DML
SSASqlErrReqgField
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Logged Error Message

This record cannot be
deleted because it does
not exist.

Cause of Error

SSSE cannot delete a
record because it is not in
the Siebel database. (It
was probably deleted
earlier.)

Server Sync ' About Moving or Deleting Mailboxes for SSSE Users

SSSE Error Messages That Can Accompany Successful Synchronization

Error Codes
IDS_ERR_EAI_SA_BC_NO_DATA
SSASqlErrRecordDeleted

Value entered for one or
more fields of this record
is not compatible with

their declared Data Type.

The value for one of the
fields in this record is not
of the correct data type
for the field.

SSASqlErrValidation

Number of characters
entered for one or more
fields of this record
exceeds their declared
Data Length.

A text field for this record
has more characters than
the Siebel database field
can handle.

SSAOMErrDataToolLong

SSASqIErrBindVarOverflowl

One or more fields of this
record has characters that
are not compatible with
this DB Code Page.

At least one of the fields in
this record is not
compatible with the code
page data base.

SSASqlErrUnicodeToCodePage

SSASqlErrUnicodeConversion

Alarm flag is checked for
past appointment.

This appointment is
scheduled in the past and
has an alarm flag
checked.

SSAOMErrAlarmTriggerTimePassed

One or more picklist fields
of this record have a value
that is not part of the

bounded picklist of values.

A value that SSSE is trying
to use for a picklist field is
not available in the
picklist for the field.

SSAOMErrBoundedPick
IDS_ERR_EAI_SA_PICK_VALIDATE

About Moving or Deleting Mailboxes for

SSSE Users

From time to time, you may need to move users’ Exchange mailboxes from one Exchange server to
another, or you may need to delete a user’s Exchange mailbox. When this situation occurs for an

SSSE user, simply follow Microsoft’s guidelines for moving or deleting a user’s Exchange mailbox. No
additional steps are needed for SSSE users.
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This chapter describes the common end-user tasks for using SSSE. It contains the following topics:
“About Using SSSE” on page 129

“Scenarios for SSSE” on page 129

“About Using SSSE with Calendar Records” on page 130

“About Using SSSE with To Do Records” on page 137

“About Using SSSE with Contacts Records” on page 140

“About Using SSSE with Employee Records” on page 145

“About Minor Error Messages” on page 148

About Using SSSE

SSSE allows you to synchronize Siebel application data with supported Personal Information Manager
(PIM) files, such as Microsoft Exchange Server, the server for Microsoft Outlook client software. The
types of data available for synchronization in the Siebel application are My Calendar, My Activities,
My Contacts, My Personal Contacts, and Employees information.

Your SSSE administrator defines who is able to synchronize between Exchange and the Siebel
application, and what types of data users are able to synchronize. After the administrator sets the
necessary synchronization settings, the synchronization of data between the Siebel application and
Exchange is automatic.

Scenarios for SSSE

This topic gives some examples of how SSSE may be used. You may use SSSE differently, depending
on your business model.

Scenario for Scheduling a Meeting Using the Calendar

A Siebel application user creates a new Calendar appointment in Outlook and invites three employees
to this appointment using Outlook scheduling capabilities. Upon saving the record, SSSE
automatically creates the new appointment in the user’s Siebel Calendar. In addition, the record is
written to the Outlook Calendar of the meeting invitees. One of the invitees cannot attend the
meeting and deletes the meeting from his Outlook Calendar. SSSE then removes that user from the
list of employees associated with this Calendar record in the Siebel application.
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Scenario for Recording a Task or To Do Activity

A Siebel application user creates a new Task in Microsoft Outlook. Upon saving the Task, the Task is
written to the Siebel application server, and is visible as a To Do Activity record in the user's My
Activities view. Later, the user changes the description of this Activity in the Siebel application. Upon
saving the changes, the Siebel to Outlook Connector updates the task in the user's Outlook database
on the Microsoft Exchange Server.

Scenario for Storing Personal Contact Information

A Siebel application user who has been using SSSE for some weeks creates a new contact in the My
Personal Contacts view of his Siebel application, and uses the Add To Sync List command to request
that the contact record be synchronized. On his next synchronization, PIMSI Engine and the Siebel
to Microsoft Exchange Connector automatically write the record to the user's Contacts folder on the
Exchange Server, and assign the Category value of Siebel Contact to the record. The user can then
access the contact information from Microsoft Outlook. To indicate that this is a personal contact, the
contact is marked Private in Outlook Contacts.

Scenario for Storing Business Contact Information

A Siebel application user creates a My Contacts record in the Siebel application and uses the Add To
Sync List command to request that the contact record be synchronized. On his next synchronization,
the Siebel to Exchange Connector writes the record to the user's Outlook Contacts list and assigns
it the Category value of Siebel Contact. The user then changes the spelling of the contact’s last name
in Outlook. SSSE writes the change to the Siebel application. After the record is written to the Siebel
application, all SSSE users that appear on the access list have the change propagated to their
Outlook Contacts list.

Scenario for Accessing Employee Information

A Siebel application user would like certain Employees in the Siebel application to also appear in his
Outlook Contacts list. The user uses the Add To Sync List command to request that the Employee
records be synchronized. On the next synchronization, the Siebel to Exchange Connector writes
those records to the user's Outlook Contacts list. Each exported Employee record is assigned a
Category value of Employee in Outlook Contacts.

About Using SSSE with Calendar Records

The SSSE administrator sets the Calendar synchronization level to either Full Sync, Export Only, or
None. No Calendar synchronization control is available to the end user; the synchronization level that
the administrator sets applies to all users who have synchronization enabled. After SSSE initiates
synchronization for a given user, all Calendar synchronization for that user is automatic; no user
action is required.

The following task descriptions assume that Calendar synchronization is set to Full Sync.

Topics in This Section
“Factors That Determine Calendar Synchronization” on page 131
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“About Activities and Calendar Records” on page 131
“Creating, Modifying, or Deleting an Appointment” on page 132
“Creating or Modifying a Recurring Appointment” on page 133
“Scheduling an All-Day Appointment” on page 133

“Adding an Attachment to an Appointment” on page 134
“Calendar Appointments with Multiple Attendees” on page 134

Related Topics
“SSSE Synchronization Options” on page 15

Factors That Determine Calendar Synchronization

Assuming that the administrator has enabled synchronization for the relevant user, then whether or
not a Calendar record is synchronized depends on the following factors:

B The synchronization level that the administrator sets (Full Sync, Export Only, or None)
B The value of the following configuration parameters, which the administrator also sets:
B ExtractStartDate (in MM/DD/YYYY format)
B ExtractStartDateFormat

If a nonrepeating calendar item has a Planned Completion Date that is earlier than the value of
the ExtractStartDate parameter, that item is not synchronized. If a repeating calendar item has
no ending date, or an ending date that is later than the value of the ExtractStartDate parameter,
then that item is synchronized.

B Whether a calendar record that is created in Siebel has a Planned Start and Completion date (a
Siebel Calendar record without these dates will not synchronize in Exchange

B Whether a calendar record that is created in Siebel has Display In set to Calendar and Activities
(this Display In value is required for synchronization)

B Whether the user archives their Exchange Calendar records. The process of archiving an
Exchange record, whether automatic or manual, stores the record externally and deletes the
record from the active data store. SSSE treats this operation as a deletion in Outlook, which
typically leads to the deletion of the corresponding Siebel record at the next synchronization.

About Activities and Calendar Records

In Siebel applications, To Do and calendar records are Activity records. From the perspective of
Siebel applications, calendar records are a subset of activity records. Therefore, each calendar record
is considered to be a type of activity record. When viewed in the Siebel application, all activity
records (including records classified as calendar items) appear in the Activities view. SSSE, however,
allows you to synchronize calendar records and activity To Do records separately. Separate treatment
is necessary for PIMs (such as Microsoft Exchange) that treat calendar records and To Do records as
distinct record types.
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The value in the Display In field determines how a new Siebel Activity record is synchronized with
Microsoft Exchange Server. Each Siebel Activity record is treated in one of three ways—it is
synchronized as a Calendar record, it is synchronized as a Task, or it is excluded from
synchronization. Table 35 summarizes how activities created in the Siebel application are
synchronized based on the value of the Display In field.

Table 35.  Synchronization of Siebel Activities Records with Microsoft Exchange Records

Siebel Display In Value Microsoft Exchange Record Type Record Synchronized as

Calendar and Activities Calendar Calendar
To Do and Activities Task Task
Activities Only Not Applicable Not synchronized

Similarly, when users create items in Outlook that SSSE synchronizes with a Siebel application, SSSE
automatically sets the Display In field to the appropriate value depending on the PIM record type.
Table 36 summarizes how the Display In field is set when a record that was created in Outlook is
synchronized with the Siebel application.

Table 36. Synchronization of Microsoft Exchange Records with Siebel Activities Records

Microsoft Exchange Record Type Siebel Display In Value Record Synchronized as
Task To Do and Activities To Do
Calendar Calendar and Activities Calendar

When synchronization adds an Exchange Task to the Siebel application, SSSE sets the Display In field
to To Do and Activities. If a user subsequently changes the Siebel Display In field to Calendar and
Activities, the activity appears in the Siebel Calendar. During the next synchronization, SSSE deletes
this item from the Exchange Task list and adds it to the Exchange Calendar.

Creating, Modifying, or Deleting an Appointment

You can add a new appointment, change an existing appointment, or remove an appointment in
either the Siebel application or Outlook. Synchronization is automatic.

Automatic or manual archiving of an Outlook stores the record externally and deletes the record from
the active data store. SSSE treats this operation as a deletion in Outlook, which typically leads to the
deletion of the corresponding Siebel record at the next synchronization.
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In the specific case where the Owner adds a Contact attendee to an appointment in the Siebel
application, or removes a Contact attendee from an appointment in the Siebel application, the
change is synchronized in the participant lists of the corresponding Exchange calendar items for all
sync-enabled participants.

NOTE: If an Owner removes a participant from a recurring appointment in Exchange, the change is
not synchronized in the Siebel application, but neither does the older Siebel data overwrite the

change in Exchange. If the Owner changes appointment header information (such as Start Date, End
Date, and Description) in Exchange, these header changes are synchronized in the Siebel application.

Creating or Modifying a Recurring Appointment

The Siebel application does not support the same recurrence options as Outlook. For example, the
Siebel application does not support appointments that occur every other week. The Siebel application
supports only a Meeting Repeat frequency of every day, week, month, quarter, and year.

If you set a recurrence that is not supported by the Siebel application, then, when the appointment
is synchronized, SSSE creates individual read-only appointments in the Siebel application to
represent individual instances of a recurring appointment. However, there is a limit to the number of
individual read-only appointments that can be created by synchronizing an unsupported recurrence
pattern. This limit is determined by the value of the Max Recurring Instances setting for the Siebel
Calendar domain.

If you modify a particular instance of a recurring appointment in Outlook, you cannot modify that
appointment in the Siebel application after it is synchronized. However, you can continue to modify
the appointment in Outlook. If you modify all instances of a recurring appointment in Outlook, then
you can continue to modify the appointment in either Outlook or the Siebel application.

Scheduling an All-Day Appointment

The Siebel Calendar does not have a field corresponding to the All Day Event check box in Microsoft
Outlook. To allow synchronization of Outlook All Day appointments, SSSE uses the following
conventions:

B When SSSE synchronizes an appointment from Microsoft Outlook with the Siebel Calendar, SSSE
checks starting and ending dates and times and Outlook time zone settings to determine whether
or not it is an all day appointment. If so, SSSE records the event as having a starting date and
time and an ending date and time that correspond to the values that are displayed in the Outlook
Active Appointments view. The end date that Outlook displays in the Active Appointments view
is one day greater than the end date that Outlook displays in an open appointment window with
the All day event check box selected. If the Siebel application and Outlook display the same time
zone, then both applications show a start time of 12:00 AM and an end time 12:00 AM for an all
day appointment. If the two applications display different time zones, then the Siebel application
shows different start and end time values based on the time zone configured for the Siebel user.
For example, an all day appointment might show starting and ending times of 3:00 AM instead
of 12:00 AM, if the Siebel application were using a time zone 3 hours away from the time zone
used by Outlook.
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B An appointment that originates in a Siebel application displays as an Outlook All Day Event after
synchronization only if all of the following conditions are met:

m The Siebel appointment must have a start date and time and an end date and time that span
exactly one or more 24 hour periods. For example, start date-time is 12:00 AM Jan 1, 2006
and end date-time is 12:00 AM Jan 3, 2006.

m The end date must be greater than the start date. An end date that is the same as the start
date does not display in Outlook as an All Day Event because it spans less than a 24 hour
period. An All Day Event must span at least one 24 hour period.

B The start and end time values that appear in the Outlook Active Appointments view must both
be 12:00 AM The display values for the Outlook appointment date and time fields are
dependant on the time zone configured for Outlook. Therefore, the start and end time values
may display as 12:00 AM in one time zone but other time values in other time zones. If the
Outlook and Siebel applications are both configured to the same time zone then 12:00 AM
start and end times in one application display as 12:00 AM start and end times in the other.

B A ssingle All Day Event appointment can extend over one or more days whether it originated in a
Siebel application or in Outlook.

Adding an Attachment to an Appointment

If you add an attachment to an Outlook calendar appointment, the attachment is not synchronized
with the Siebel application because SSSE does not currently support synchronization of calendar
attachments.

The attachment remains attached to your Outlook appointment even if you change appointment
details in the Siebel application and resynchronize with Outlook.

Calendar Appointments with Multiple Attendees

The following paragraphs describe how SSSE handles Calendar appointments that have multiple
Attendees in Microsoft Exchange or multiple Participants in Siebel applications.

Calendar Items Created in Siebel Applications
If an SSSE user who is enabled for synchronization creates a Calendar item in a Siebel application,
that user is listed in the Owner field of the Calendar Detail form for the item.

If the Calendar item has multiple Participants, all the Participants who are Employees are listed in
the Employees field in the Calendar Detail form.

If any participants are Contacts, rather than Employees, they are listed in the Contacts field in the
Calendar Detail form.

Employee participants can view the original Calendar item in their Siebel Calendars.
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Calendar Items in Siebel Applications Synchronized with Microsoft
Exchange

When SSSE synchronizes a Calendar item that was created in a Siebel application with Microsoft
Exchange, SSSE maps the value of the Siebel Owner field to the Exchange Organizer field.

SSSE maps the values listed as Employees and Contacts in the Siebel Calendar Detail Form to
Exchange Attendees.

NOTE: Only the Employees and Contacts that have email addresses are synchronized to Exchange
as attendees on the appointment.

SSSE writes the Siebel Calendar appointment directly to the Exchange Calendar folders of the sync-
enabled participants.

Special Handling When Siebel Owner Is Not Enabled to Use SSSE

If a Siebel user who does not have SSSE synchronization enabled creates a Siebel Calendar item that
includes SSSE-enabled participants, the following facts are true:

m The Siebel Calendar item is synchronized in Microsoft Exchange for all Siebel Employee
participants who have synchronization enabled. If the owner modifies the item in the Siebel
application, the changes are synchronized for these same participants.

m The Siebel Calendar item is not synchronized in Exchange for nonemployee Contacts,
because synchronization cannot be enabled for Contacts.

m Provided that email addresses are correctly configured, the Owner for the Siebel Calendar
item is synchronized to be the Exchange Organizer for the sync-enabled participants’
Exchange Calendar items, even if the Siebel Owner does not have synchronization enabled.

m If any sync-enabled attendee modifies the calendar item in Exchange (for example, to change
the Start Date or Subject), the change is synchronized in the Siebel application, where it is
visible to all Siebel participants, including the item Owner.

Calendar Items Created in Microsoft Exchange
If an SSSE user who is enabled for synchronization creates a Calendar appointment in Microsoft
Outlook, that user is listed in Outlook as the Organizer of the appointment.

Additional participants are listed as Required Attendees or Optional Attendees, regardless of whether
the attendees are Employees or Contacts.

A copy of the original Calendar appointment is stored for each attendee who is using Microsoft
Exchange client software. From this point on, any attendee can modify his or her own copy of the
appointment. The attendee can choose whether or not to notify other attendees (including the
organizer) of the change to their copy of the appointment.

If other attendees are notified of a change to a calendar item, the notifications provide information
about the change that one attendee has made, but the notification has no effect on the data stored
in other attendees' copies of the appointment.
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Calendar Items in Microsoft Exchange Synchronized with Siebel
Applications

When SSSE synchronizes a Calendar appointment that was created in Microsoft Outlook with a Siebel
application, a corresponding Siebel Calendar item is created as soon as SSSE synchronizes any
SSSE-enabled participant for the appointment.

At synchronization, the value of the Exchange Organizer field is mapped to the value of the Siebel
Owner field, provided that the Organizer has a corresponding Employee record in the Siebel
application.

The values listed as Exchange Attendees are mapped to the Employees or Contacts fields in the
Siebel Calendar Detail form, depending on whether or not each Attendee’s Exchange email address
matches the email address for a Siebel Employee record.

NOTE: Exchange Attendees must be specified on the Scheduling tab of the Outlook Calendar item.
SSSE does not support entering attendees using the Contacts field on the Appointment tab of the
Calendar item.

Employee participants can view the Calendar item in their Siebel Calendars. The Calendar
appointment is created regardless of each participant’s Accept/Decline status.

Provided that the Organizer is sync-enabled, the data that appears in the Siebel Calendar item is
updated if the Organizer modifies the appointment in Exchange, and subsequent synchronizations
propagate the modifications to the Attendees' copies of the appointment in Exchange. If Attendees
other than the Organizer modify their copies of the appointment in Exchange, those modifications
are not synchronized in the Siebel application.

If any Attendee modifies the Siebel Calendar item, subsequent synchronizations propagate the
modifications to Attendees' copies of the appointment in Exchange.

Special Handling When the Exchange Organizer Is Not Mapped or
Enabled to Use SSSE

If the Organizer who creates an Exchange Calendar appointment in Outlook is not enabled to use
SSSE, and is not an employee recognized by the Siebel application, then SSSE uses the value of the
Generic Siebel Owner setting as the Owner when synchronizing the appointment in the Siebel
application. If, additionally, the administrator has not configured a value for the Generic Siebel Owner
setting, then SSSE does not synchronize the Calendar appointment. For more information about the
Generic Siebel Owner setting, see “Configuring the Generic Siebel Organizer” on page 71.

NOTE: If the Organizer who creates an Exchange Calendar appointment in Outlook is not enabled to
use SSSE, then Siebel users cannot use their Siebel Calendars to update the Siebel Calendar item
that is produced by synchronization of the appointment. Users must make any updates to the item
in Exchange, and then SSSE must synchronize the changes with the Siebel application.

Special Handling When an Exchange Attendee Is Not Enabled to Use
SSSE

As long as at least one Exchange participant is enabled to use SSSE, the Calendar item is
synchronized in the Siebel Calendars of all valid Employee attendees, even if some of those
attendees do not have synchronization enabled.
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Similarly, valid Employee attendees are listed in the Employee field of the Calendar Detail form for
the item.

A Contact who is an Attendee for an Exchange Calendar appointment is listed in the Contacts field
of the Calendar Detail form for the synchronized item, provided that SSSE finds the Contact already
listed in the Siebel database. An unknown Contact attendee is not listed in the Contacts field of the
Calendar Detail form.

NOTE: If an Exchange Calendar appointment has any Attendees who are not enabled to use SSSE,
whether those users are Siebel Users or Contacts, then the Siebel user interface treats the record as
read-only. Users must make any updates to the item in Exchange, and then SSSE must synchronize
the changes in the Siebel application.

Special Handling When an Exchange Attendee Deletes or Declines an
Exchange Meeting

The results of deleting or declining an Exchange meeting depend on whether or not the attendee has
SSSE synchronization enabled:

B If the attendee has synchronization enabled, declining or deleting an Exchange meeting causes
SSSE to remove that attendee from the Siebel Calendar item.

B If the attendee does not have synchronization enabled, declining or deleting an Exchange
meeting does not cause any change in the Siebel Calendar item’s list of attendees, regardless of
whether the change in Exchange is made in the attendee’s folder or in the Organizer’s folder.

About Using SSSEwith To Do Records

Siebel To Do Activities are called Tasks in Microsoft Outlook. The SSSE administrator sets To Do
synchronization levels to either Full Sync, Export Only, or None. The synchronization level that the
administrator sets applies to all users who have synchronization enabled. End users have no control
over To Do synchronization. After SSSE initiates synchronization for a particular user, all To Do
synchronization for that user is automatic; no user action is required.

The following topics assume that To Do synchronization is set to Full Sync.

Topics in This Section
“Factors That Determine To Do Record Synchronization” on page 138

“Creating, Modifying, or Deleting a To Do Record” on page 138
“Creating or Modifying a Recurring To Do Record” on page 138
“Adding an Attachment to a To Do Record” on page 138
“Assigning To Do Activities to Other Users” on page 139
“Assigning Priorities to a To Do Record” on page 139
“Assigning Status Values to a To Do Record” on page 139
“Setting a To Do Activity Alarm” on page 140
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Related Topics
“SSSE Synchronization Options” on page 15

Factors That Determine To Do Record Synchronization
Whether or not a To Do record is synchronized depends on the following factors:
B The synchronization level that the administrator sets (Full Sync, Export Only, or None).
B The value of the following configuration parameters, which the administrator also sets:
B ExtractStartDate (in MM/DD/YYYY format)
B ExtractStartDateFormat

If a To Do item has a Due date that is earlier than the value of the ExtractStartDate parameter,
that item is not synchronized.

B The value of the Display In field for each individual To Do record. (SSSE synchronizes To Do
records for which the value of the Display In field is To Do and Activities.)

Creating, Modifying, or Deleting a To Do Record

You can add a new To Do activity, change an existing To Do activity, or remove a To Do activity in
either the Siebel application or Outlook. Synchronization is automatic.

Creating or Modifying a Recurring To Do Record

The Siebel application does not support recurring To Do activities, but Outlook does. If you set an
activity (task) recurrence in Outlook, when the task is synchronized, a single one-time To Do activity
record is created in the Siebel application.

Adding an Attachment to a To Do Record

It is possible to add attachments to both Outlook Task items and Siebel To Do Activity items.
However, when SSSE synchronizes these items, the attachments are not synchronized.

By default, the current version of SSSE preserves both Outlook and Siebel attachments during
synchronization. That is, if an Outlook Task item has attachments, and the corresponding Siebel To
Do record is updated, the next synchronization will update the Outlook Task without affecting the
attachment. Similarly, if a Siebel To Do record has attachments, and the corresponding Outlook Task
item is updated, the next synchronization will update the Siebel To Do record without affecting the
attachment.

An administrator can configure SSSE to discard Outlook attachments when a noncalendar Outlook
item is updated. For information about this configuration option, see “Configuring Exchange Connector
Parameters” on page 79.
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Assigning To Do Activities to Other Users

You can assignh activities to other users in either the Siebel application or Outlook. During
synchronization, SSSE makes the appropriate changes in the Siebel application or Microsoft
Exchange Server.

In Outlook, you assign a task by clicking Assign Task and then filling in the To field. If you select the
Keep an updated copy of this task on my task list check box, then the task appears on both your own
and the assignee’s task list.

In the Siebel application, you assign a task by changing the Owner to another person. If you change
the owner of an activity in the Siebel application, the activity appears in your My Delegated Activities
view and the assignee’s My Activities view.

If you assign a task to more than one person in Outlook, when synchronized, SSSE creates multiple
To Do activities in the Siebel application because Siebel applications do not support more than one
owner for each task.

Assigning Priorities to a To Do Record

Table 37 indicates how a To Do activity’s Priority is set when synchronized between the Siebel
application and Microsoft Exchange Server.

Table 37. Priority Synchronization

Siebel Priority Value Exchange Priority Value

1-ASAP High
2-High High
3-Medium Normal
4-Low Low

Assigning Status Values to a To Do Record

Table 38 indicates how a To Do activity’s Status is set when synchronized between the Siebel
application and the Microsoft Exchange Server.

Table 38. Status Synchronization

Acknowledged 0
Not Started (0]
In Progress 1
Done 2
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Table 38. Status Synchronization

Siebel Status Value Exchange Status Value

On Hold 3
Cancelled 4
Declined 4

Setting a To Do Activity Alarm

Outlook lets you set a task Reminder that displays a reminder at a time that you set. Siebel
applications let you set an Alarm flag that displays a reminder at the time the To Do activity is due.

If you set a task Reminder in Outlook, when synchronized, the Alarm flag is set on the To Do activity
in the Siebel application. If the Alarm flag is set in the Siebel application, when synchronized, a
Reminder is set on the task in Microsoft Exchange Server. The reminder is set to the time the activity
is due.

About Using SSSEwith Contacts Records

The SSSE administrator sets Contacts synchronization levels to either Full Sync, Export Only, or
None. The SSSE administrator sets Personal Contacts and Business Contacts synchronization levels
independently. Users can change Personal Contacts to Business Contacts in either the Siebel
application or Microsoft Outlook, but users can only change Business Contacts to Personal Contacts
in Outlook.

Contacts are synchronized only if the user uses the Add To Sync List command to request that the
contact record be synchronized. The Add To Sync List command adds the current user to the Sync
List MVG field for the selected record. For Business Contacts, if Visibility is set to Sales Rep, contact
records to be synchronized must also be visible in the user’s My Contacts list.

For successful synchronization of Business Contacts that have either Account information or Business
Address information, when you are synchronizing from Microsoft Exchange to a Siebel application,
the contact information must include both an Account Name and an Account Location.

If a SSSE user has multiple positions in the Siebel application, contacts are synchronized to the user’s
primary position.

If a new account is added to a Business Contact in Outlook, that account is made the primary Account
for that Contact when the record is synchronized with the Siebel application. Any accounts previously
associated with that Contact remain associated but are not primary.

If a new Business Address is added to a Business Contact in Outlook, that Business Address is made
the primary Business Address for that Contact when the record is synchronized with the Siebel
application. Any Business Addresses previously associated with that Contact remain associated but
are not primary.
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If a new Personal Address is added to a Business Contact in Outlook, that Personal Address is made
the primary Personal Address for that Contact when the record is synchronized with the Siebel
application. Any Personal Addresses previously associated with that Contact remain associated but
are not primary.

The following tasks are applicable to both the My Contacts and My Personal Contacts views, and
assume that Contacts synchronization is set to Full Sync.

NOTE: SSSE does not support the synchronization of Microsoft Outlook or Microsoft Exchange Server
distribution lists. SSSE can synchronize only individual contacts.

Topics in This Section
“Designating Contact Records for Synchronization” on page 141

“Ending Synchronization of Contact Records” on page 142
“Creating, Modifying, or Deleting a Contact” on page 142
“Adding an Attachment to a Contact” on page 143
“Creating a Personal Contact” on page 143
“Account-to-Contact Relationships” on page 144

“Contact Access” on page 144

“Changing Contact Domains” on page 144

Related Topics
“SSSE Synchronization Options” on page 15

Designhating Contact Records for Synchronization

Contacts (both personal and business) in the Siebel application are synchronized with Microsoft
Exchange Server only if your user name appears in the Sync List MVG field for the individual Contact
records. The following procedure describes how to designate a Contact record for synchronization in
this way.

To designate a Contacts record for synchronization

1 From the Siebel application menu, choose Navigate > Site Map > Contacts > Contacts List or
Personal Contacts List.

2 In the My Contacts or My Personal Contacts list, select one or more records.

In the My Contacts or My Personal Contacts list, click Menu, and then choose Add To Sync List.

Related Topic
“Designating Employee Records for Synchronization” on page 146
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Ending Synchronization of Contact Records

The following procedure describes how to stop synchronizing one or more Contact records that you
have previously synchronized.

To stop synchronizing selected Contacts records

1 From the Siebel application menu, choose Navigate > Site Map > Contacts > Contacts List or
Personal Contacts List.

2 In the My Contacts or My Personal Contacts list, select a Contact record that you no longer want
to synchronize with Exchange.

3 Click Menu, and then choose Remove from Sync List.

NOTE: When you choose Remove from Sync List, you remove yourself from the Sync List for the
selected Contact record. On your next synchronization, SSSE removes the corresponding Contact
record from your Exchange mailbox.

Related Topic
“Ending Synchronization of Employee Records” on page 146

Creating, Modifying, or Deleting a Contact

You can add a new contact, modify an existing contact, or delete a contact in either the Siebel
application or Outlook.

If you add a new contact in the Siebel application, you must also add yourself to the contact record’s
Sync List in order for the contact record to be synchronized in Microsoft Exchange. For information
about adding a yourself to a contact record’s Sync List, see “Designating Contact Records for
Synchronization” on page 141.

If you add a new contact in Microsoft Outlook, you must place an appropriate value in the Category
field in order for the contact record to be synchronized in the Siebel application. One value in the
Category field for the contact in Outlook must match the value defined in the PIM Category Value
field for the contact domain. (You can specify more than one value for the Category, as long as you
include the required value.) The default for the required value is Siebel Contact.

After the initial synchronization of a contact record, subsequent synchronizations are automatic.
NOTE: Employee contacts in Outlook are a special case. See “Synchronizing Employees” on page 145.

If you delete a business contact in Outlook, synchronization removes you from the Sync List for the
corresponding Siebel contact record, but the contact record itself continues to exist in the Siebel
database.

If you delete a personal contact in Outlook, synchronization deletes the corresponding Siebel
personal contact record from the Siebel database.
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If any Siebel user is removed from the Sync List of a business contact record or personal contact
record in the Siebel application, synchronization deletes that user’s corresponding contact record in
Outlook.

If multiple sync-enabled Siebel users are added to the Sync List of a contact record in the Siebel
application, then SSSE synchronizes the contact record with the Exchange mailboxes of all the users
who are on the Sync List.

If the Allow MVG Creation check box is not selected for a particular user in the User Level Access
Control list, and if the administrator has set default values for the Account, Personal Address, and
Business Address fields in the Siebel Domains, then if a new address or account is added to one of
the user's contact records in Outlook, SSSE uses the administrator-supplied default value when the
record is synchronized with the Siebel application.

Adding an Attachment to a Contact

You can add attachments to Contacts in both Outlook and the Siebel application. However, when the
Contact is synchronized, attachments are not synchronized.

By default, the current version of SSSE preserves both Outlook and Siebel attachments during
synchronization. That is, if an Outlook Contact record has attachments, and the corresponding Siebel
record is updated, the next synchronization will update the Outlook Contact without affecting the
attachment. Similarly, if a Siebel Contact record has attachments, and the corresponding Outlook
item is updated, the next synchronization will update the Siebel record without affecting the
attachment.

An administrator can configure SSSE to discard Outlook attachments when a noncalendar Outlook
item is updated. For information about this configuration option, see “Configuring Exchange Connector
Parameters” on page 79.

Creating a Personal Contact

In Outlook, the Private check box determines if a contact is a personal contact. If the Private check
box is selected, then the contact is considered a personal contact and appears in the My Personal
Contacts view in the Siebel application. If the Private check box is not selected, the contact is
considered a business contact and appears in the My Contacts view in the Siebel application.

To create a personal contact in Outlook
1 In Outlook, open or create a Contact record.

2 Select the Private check box.

3 In the Category field, enter the value that matches the PIM Category Value setting for the Siebel
Personal Contacts domain.

You can specify more than one Category, as long as you include the required value.
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Account-to-Contact Relationships

In Siebel applications, a contact can have multiple associated accounts, but in Outlook this is not the
case. When synchronizing contact information, only the primary account in the Siebel application is
exported or synchronized with Microsoft Exchange Server.

If a new account is added to a Business Contact in Outlook, that account is made the primary Account
for that Contact when it is synchronized in the Siebel application. Any accounts previously associated
with that Contact remain associated but are not primary.

CAUTION: Users must not delete the association between an Account and a Contact in Outlook.
Users must delete the association in the Siebel application. The limitation is due to the fact that when
you delete the association in Outlook, the delete operation causes the next Accountin line to become
the Primary Account for the Contact.

Consider a case where a Contact C1 is associated with 10 Accounts A1..A10 with Al being the
primary. When this contact is synchronized in Exchange, the Account A1 becomes the value for the
Company field. If the user clears the Company field in Outlook, then SSSE deletes Al from the
Account MVG for the Contact. In the process, A2 (next Account record) becomes primary and this
change is synchronized in Exchange. The end-result is that the user who cleared A1 now sees A2 in
its place. This has the potential for confusion and data loss.

Contact Access

For a Business Contact in the Siebel application to be accessible to SSSE, the user who is
synchronizing must be on the Contact record’s Sync List.

Changing Contact Domains

You can change a Personal Contact to a Business Contact in either the Siebel application or Microsoft
Outlook, by clearing the Private check box for the record. After you make this change, the record
disappears from your Siebel Personal Contacts List and appears in your Siebel Contacts List. (A
Personal Contacts record is deleted and a Business Contacts record is created.) If you make the
change in the Siebel application, synchronization automatically clears the Private check box in
Outlook.

However, you can only change a Business Contact to a Personal Contact in Outlook, by selecting the
Private check box. After you make this change, the next synchronization removes you from the Sync
List for the corresponding record in the Siebel Contacts List, and a new record appears in your Siebel
Personal Contacts List.

NOTE: It is not possible to select a Private checkbox for a Business Contact record in the Siebel
application.

144  Siebel Server Sync Guide Version 7.7, Revision A




iebel Server Sync = About Using SSSE with Employee Records

About Using SSSEwith Employee
Records

Employees in the Siebel application are Contacts in Microsoft Outlook. SSSE distinguishes employees
from other contacts in Microsoft Exchange Server by the use of an appropriate Category value. The
default Category value for indicating an employee is Employee.

The SSSE administrator sets Employee synchronization levels to either Export Only or None.
Employee records are synchronized only if the user designates them for synchronization by using the
Add To Sync List command. The Add To Sync List command adds the current user to the Sync List
MVG field for the selected record.

NOTE: SSSE does not support the synchronization of Microsoft Outlook or Microsoft Exchange Server
distribution lists. SSSE can synchronize only individual contacts and employees.

Topics in This Section

“Synchronizing Employees” on page 145

“Designhating Employee Records for Synchronization” on page 146
“Ending Synchronization of Employee Records” on page 146
“Creating or Modifying an Employee” on page 147

“Deleting an Employee” on page 147

Related Topics
“SSSE Synchronization Options” on page 15

Synchronizing Employees

Bidirectional synchronization is not recommended for the Employee domain, because its use could
allow end users to create unauthorized Employee records in Microsoft Outlook, and those records
would be synchronized in the Siebel database for the enterprise, causing data corruption. It is
strongly recommended that administrators leave the synchronization level for Employees set to the
default value of Export Only.

If Employee synchronization is set to Export Only, an employee’s data is exported from the Siebel
Application to Microsoft Exchange at the time that you designate the Employee record for
synchronization. For information about how to do this, see “Designating Employee Records for
Synchronization” on page 146. As long as the employee remains on your Sync List, SSSE
automatically exports employee record changes from the Siebel application to Microsoft Exchange.

Related Topics
“Setting Siebel Domain-Level Synchronization” on page 111
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Designating Employee Records for Synchronization

Employee records in the Siebel application are exported to you Microsoft Exchange mailbox only if
your user name appears in the Sync List MVG field for the individual Employee records. The following
procedure describes how to designate an Employee record for synchronization in this way.

To desighate an Employee record for synchronization
1 From the Siebel application menu, choose Navigate > Site Map > Employees.

2 In the Employees list, select a record.

3 In the Employees list, click Menu, and then choose Add To Sync List.

Ending Synchronization of Employee Records

The following procedure describes how to stop synchronizing one or more Employee records that you
have previously synchronized.

To stop synchronizing selected Employee records
1 From the Siebel application menu, choose Navigate > Site Map > Employees > Employees List.

2 In the All Employees list, select a record for an employee that you have previously synchronized
but no longer want to synchronize.

3 In the All Employees list, click Menu, and then choose Remove from Sync List.

NOTE: When you choose Remove from Sync List for an Employee record, or when you clear the
Sync field check box (which has the same effect), you remove yourself from the Sync List for the
selected Employee record. On your next synchronization, SSSE removes the corresponding
Contact record from your Exchange mailbox.

Related Topics
“Synchronizing Employees” on page 145
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Creating or Modifying an Employee

Because it is recommended that the synchronization level for employees be Export Only, you must
add or modify employees in the Siebel application. Do not add or modify employees in Outlook. After
adding an employee in the Siebel application, be sure to designate the record for synchronization,
as described in “Designating Employee Records for Synchronization” on page 146.

Deleting an Employee

Because it is recommended that the synchronization level for employees be Export Only, you must
delete employees in the Siebel application. Do not delete an employee in Outlook. If you delete an
employee in Outlook, the employee record reappears in Outlook the next time Employee records are
exported from the Siebel application.

If Employee synchronization is set to Export Only, after an employee is deleted in the Siebel
application, the deleted record is automatically removed from Microsoft Exchange Server.
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About Minor Error Messages

When SSSE synchronizes a particular user’s data, the synchronization can succeed completely,
succeed partially, or fail completely. This topic lists some error messages that indicate partially
successful synchronization. These error messages generally indicate a problem with an individual
record—other records for the same user may synchronize successfully. For this type of error, SSSE
typically displays the error message for only one synchronization attempt. On the next
synchronization attempt, the error message does not repeat. Table 39 contains a listing of some error
messages of this type.

NOTE: If a row in Table 39 indicates that SSSE does not save the user’s sync state for the session,
this means that SSSE does not synchronize the record that has the error, but continues synchronizing
the user’s other records. At the end of the synchronization process for the current user, SSSE does
not record a completely successful inbound (Outlook to Siebel) synchronization session. For each
synchronization session, SSSE attempts to synchronize all user-visible records in the domain that
have changed since the last completely successful synchronization of that domain. Therefore, many
records may be resynchronized even if only one record failed during the previous synchronization
attempt.

Table 39. Relatively Benign Error Messages

Logged Message Error Code Cause and Result of Error
Failed to process the none Saving the unresolvable
unresolved attendees for attendees for this

Siebel Row: row_ID, appointment fails. SSSE does
Siebel Domain: not synchronize the record
domain_name. that had the error, but

continues synchronizing the
user’s other records. SSSE
does not save the user’s sync
state for the session. SSSE
also saves the attendee data
in a special table, so that if
the Siebel record changes
and is synchronized to
Exchange, the Exchange
record retains the unresolved
attendees.

One or more records with | IDS_ERR_EAI_SA MULTIPLE_MATCH SSSE found a duplicate

the same key already record in the Siebel
IDS_ERR_EAI_SA DUP_CONFLICT

exists. database. SSSE does not
SSASqIErrDupConflict2 synchronize the record that
had the error, but continues

SSASqlErrDupConflict synchronizing the user’s

other records. SSSE does not
save the user’s sync state for
the session.
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Logged Message

One or more required
fields of this record are
empty.
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Relatively Benign Error Messages

Error Code

IDS_ERR_EAI_SA_MISSING_REQ_FIE
LD

IDS_WRN_EAI_SA_DML
SSASqlErrReqgField

Cause and Result of Error

One of the required fields for
this record is empty and
there was no default
configured. SSSE does not
synchronize the record that
had the error, but continues
synchronizing the user’s
other records. SSSE does not
save the user’s sync state for
the session.

This record cannot be
deleted because it does
not exist.

IDS_ERR_EAI_SA_BC_NO_DATA
SSASqlErrRecordDeleted

SSSE cannot delete a record
because it is not in Siebel (it
was probably already
deleted).

Value entered for one or
more fields of this record
is not compatible with

their declared Data Type.

SSASqlErrValidation

The value for one of the fields
in this record is not of the
correct data type for the
field. SSSE does not
synchronize the record that
had the error, but continues
synchronizing the user’s
other records. SSSE does not
save the user’s sync state for
the session.

Number of characters
entered for one or more
fields of this record
exceeds their declared
Data Length.

SSAOMErrDataToolLong

SSASqlErrBindVarOverflowl
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A text field for this record has
more characters than the
corresponding Siebel field
can handle. SSSE does not
synchronize the record that
had the error, but continues
synchronizing the user’s
other records. SSSE does not
save the user’s sync state for
the session.
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Table 39. Relatively Benign Error Messages

Logged Message Error Code Cause and Result of Error
One or more fields of this | SSASqlErrUnicodeToCodePage At least one of the fields in
record has characters this record is not compatible

that are not compatible SenEglErtpee e el with the codepage data base.

with this DB Code Page. This condition typically
affects multiple users. SSSE
does not synchronize the
record that had the error, but
continues attempting to
synchronize the user’s other
records. SSSE does not save
the user’s sync state for the
session. You may be able to
correct this condition by
inspecting the indicated
record and changing any
special characters to
standard characters.

Alarm flag is checked for | SSAOMErrAlarmTriggerTimePassed This appointment being
past appointment. synchronized is scheduled in
the past and has an alarm
flag checked in the PIM
record. SSSE synchronizes
the record but does not
synchronize the outdated
alarm flag. No user or
administrator action is

needed.
One or more picklist fields | SSAOMErrBoundedPick A value that SSSE is trying to
of this record have a use for a picklist field is not
value that is not part of ot R 2l s U Wiall pils available in the picklist for
the bounded picklist of the field. SSSE does not
values. synchronize the record that

had the error, but continues
synchronizing the user’s
other records. SSSE does not
save the user’s sync state for
the session.
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This chapter describes how to set up and use the Siebel Outlook Add-In deployment option for SSSE.
The chapter includes the following topics:

B “About Siebel Outlook Add-In” on page 151

B “Siebel Outlook Add-In Controls” on page 151

B “System Requirements for Siebel Outlook Add-In” on page 154
B “Process of Setting Up Siebel Outlook Add-In” on page 155

B “Setting Siebel Outlook Add-In Options” on page 159

B “Using Siebel Outlook Add-In” on page 160

About Siebel Outlook Add-In

The Siebel Outlook Add-In lets users link from Microsoft Outlook Calendar appointments, Contacts,
and Tasks to Siebel records using controls in the Outlook interface.

The Siebel Outlook Add-In adds the following controls to the Calendar, Contacts, and Tasks views of
the user’s Outlook interface:

B Siebel Options menu

B Siebel toolbar

B Right-click menu items

[l Siebel tab in Options dialog box

Using these controls a user can link Siebel records to Outlook calendar, contacts, or tasks records.
For example, a user creates a calendar appointment in Microsoft Outlook and then links that
appointment to a relevant Opportunity in the Siebel application. After a user links a Siebel record to
an Outlook record, the user can use the link to navigate from Outlook directly to the linked record
in the Siebel application.

Siebel Outlook Add-In uses the same permissions as PIMSI Engine for allowing specific users to
synchronize calendar, contact, and task data. For more information about setting permissions, see
“Setting SSSE Group and User Access Controls” on page 118.

Siebel Outlook Add-In Controls

The following figures illustrate the new controls provided by the Siebel Outlook Add-In that allow
linking to Siebel data from Outlook.

Siebel Server Sync Guide Version 7.7, Revision A 151



Setting Up and Using Siebel Outlook Add-In =

Figure 3 shows the Siebel Options menu. This menu lets you link the selected Outlook item to a
record in the Siebel application, remove existing links, or access recently created links.
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Figure 3.

Figure 4 shows the Siebel toolbar, which lets you link the selected Outlook item to a record in the
Siebel application or use an existing link to go to a record in the Siebel application.
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Project [ 3
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Figure 5 shows the right-click menu, which lets you link the selected Outlook item to a record in the
Siebel application or remove existing links.

00 [ Project Meeting
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5 0 Remove Current Link(z)

Figure 5. Right-Click Menu Items
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Figure 6 shows the Siebel tab in the Options dialog box, which lets you set up communication settings
in your Siebel application.

Options
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| Other | RightFax | Delegates | Siebel %
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Llser Mame: IMSTEHN

xxxxx

Pazzword: I

Log Specificity: IFalal Ermors ;I Yiew Log |

L OK. JI_ Cancel J Apply

Figure 6. Siebel Tab in Options Dialog Box

Related Topics
“Using Siebel Outlook Add-In” on page 160

System Requirements for Siebel Outlook
Add-In

Deployment of Siebel Outlook Add-In requires the following:

B  You must install PIMSI Engine before you deploy Siebel Outlook Add-In. For information about
PIMSI Engine, see “SSSE Deployment Options” on page 14.

B You must install a supported version of Microsoft Outlook on the machine of each user who needs
Siebel Outlook Add-In. For information about supported versions, see Siebel System
Requirements and Supported Platforms on Siebel SupportWeb.
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Process of Setting Up Siebel Outlook
Add-In

Setting up Siebel Outlook Add-In consists of the following tasks, which you must complete in the
order shown. The system administrator performs the first task on the Siebel Enterprise Server. The
second task is required only if your implementation modifies the information that Outlook Add-In
makes available. An administrator can perform it wherever there is access to your Siebel application
and Enterprise database. Either the administrator or the end user performs the remaining tasks on
the end user’s machine.

To deploy the Siebel Outlook Add-In, complete the following tasks:
“Setting Enterprise Server Parameters” on page 155
“(Optional) Setting Siebel Outlook Add-In Objects and Fields” on page 156
“Installing Siebel Outlook Add-In” on page 157

1

2

3

4 “Clearing Browser Objects” on page 158

5  “Initializing Siebel Outlook Add-In" on page 158
6

“Testing Siebel Outlook Add-In" on page 159

Setting Enterprise Server Parameters

You must set the MsgClientAddInEAIUrl enterprise server parameter, which defines the path to the
Siebel EAl. The Add-In Update Agent uses this path to download data from the Siebel application and
cache the data on the client's desktop. For information about the Add-In Update Agent, see “Installing
Siebel Outlook Add-In” on page 157.

You must also enable Web Client Automation.

If you want, you can also set values for the MsgClientAddInCacheRefreshlnterval parameter and the
MsgClientAddInLinkHistory parameter. The MsgClientAddInCacheRefreshinterval parameter defines
the initial cache refresh interval for all users, in minutes. The MsgClientAddInLinkHistory parameter
defines the initial quick link retention period for all users, in days. For information about how
individual users can modify these values in Outlook, see “Setting the Cache Refresh Interval” on
page 160 and “Setting the Quick Link Retention Period” on page 160.

CAUTION: You must use the same authentication mechanism for the Application Object Manager
and the EAI Object Manager used to refresh the data cache. This is because SSSE uses the user name
and password of the currently logged in user to log in to the EAI Object Manager to refresh the data
cache. If the authentication mechanism for the Object Manager is different from the authentication
mechanism for the Application, this results in a refresh failure.

This task is a step in “Process of Setting Up Siebel Outlook Add-In.”

To set the MsgClientAddInEAIUrI enterprise server parameter
1 Log in to the Siebel Enterprise Host as the administrator.
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2 From the Siebel application menu, choose Navigate > Site Map > Administration - Server
Configuration > Enterprises.

3 In the Enterprise Servers list, click the appropriate enterprise server, and then click the
Parameters view tab.

4 In the Enterprise Parameters list and the accompanying form, select each of the parameters
shown in the following table, and enter or modify values and check box settings as needed.

Parameter Value Effective

Messaging Client AddIn EAI Url Enter the Siebel EAl path At Server Restart
http://<your_host>/
<eail_language-code>/

Messaging Client AddIn Cache Refresh  Optional. Modify the value of the At Server Restart
Interval cache refresh interval in
minutes.

Messaging Client AddIn Link History Optional. Modify the number of At Server Restart
days to keep quick links.

5 On the Siebel Server where the Siebel application is enabled, complete the following substeps to
modify the configuration file for the application:

a  Navigate to the directory Siebel _installation_home\siebsrvr\BIN\language-code.
b Locate the .cfg file for the application, and open it using a text editor.

For example, edit the uagent.cfg file for the Siebel Call Center application, or edit the
siebel.cfg file for the Siebel Sales application.

C  Set the EnableWebClientAutomation setting to TRUE.
d Save the file.
e Restart the Siebel Server.

6 Proceed to “Installing Siebel Outlook Add-In.”

(Optional) Setting Siebel Outlook Add-In Objects and
Fields

This topic describes the information that Outlook Add-In ordinarily makes available. If your Siebel

implementation does not require all of that information, you can use the instructions in this chapter
to have Outlook Add-In omit the information that your users do not need. You can also adjust the

order in which Outlook Add-In supplies information from the relevant Siebel fields.

This task is an optional step in “Process of Setting Up Siebel Outlook Add-In.”
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Table 40 lists the Siebel objects and fields that Siebel Outlook Add-In makes available from Outlook.
Outlook Add-In lets you link to Siebel records that have any of the listed Siebel Object types. The
data that is contained in the listed Siebel Object Fields is the data that is visible in Siebel Outlook
Add-In controls.

Table 40. Siebel Objects and Fields Available Through Outlook Add-In

Siebel Object Siebel Object Fields

Account Id, Name, Location

Opportunity Id, Name, Account

Project Id, Name, Account Name, Project Num
Service Request ID, SR Number, Abstract, Account

The following procedure describes how to set the Siebel Objects, Siebel Object fields, and field order
that Outlook Add-In uses when supplying Siebel data.

To set Siebel Objects and Siebel Object Fields that Outlook Add-In makes available

1
2

a A

Log in to your Siebel application as the administrator.

From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Siebel Objects.

In the PIMCI Siebel Object list, select any object that you do not want Outlook Add-In to make
available, and then click Delete.

Repeat this step until the list displays just the objects that you want Outlook Add-In to make
available.

In the PIMCI Siebel Object list, select any object for which you want to adjust field settings.

In the Siebel Object Fields list, select the record for any field that you do not want Outlook Add-
In to display in its controls, and then click Delete.

Repeat this step until the list displays just the fields that you want Outlook Add-In to display in
its controls.

In the Siebel Object Fields list, inspect the Field Sequence values for the remaining fields, and
enter new values as needed to produce the desired sequence.

NOTE: Field sequence values must be unique. To avoid error messages, enter only values that
are not currently assigned to other fields.

Installing Siebel Outlook Add-In

You must install the Siebel Outlook Add-In on each user’s machine where it will be used.
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The following procedure installs the Siebel Outlook Add-In dynamic link library (DLL) files and the
Add-In Update Agent. The Add-In Update Agent is automatically started when you try to create
Outlook-to-Siebel links or when you restart your computer. The Add-In Update Agent is responsible
for caching and refreshing Siebel data stored on the user’s machine.

This task is a step in “Process of Setting Up Siebel Outlook Add-In.”

To install Siebel Outlook Add-In
1 On the user’'s machine, close all Outlook windows and all Siebel application windows.

2 Navigate to the network directory that contains the installation files for your Siebel application
and start the install program .. .\Siebel_Outlook_Addin\install _exe.

3  Follow the installation wizard prompts. Accept all default values. You can install to any location
on the user’s hard drive.

4 Proceed to “Clearing Browser Objects.”

Clearing Browser Objects

If the user has previously used their browser to access Siebel applications, you must remove the
existing browser objects.

This task is a step in “Process of Setting Up Siebel Outlook Add-In.”

To clear browser objects
1 Exit all applications, and then open a new browser window.

From the Tools menu, choose Internet Options.
On the General tab, under Temporary Internet Files, click Settings.

In the Settings dialog box, click View Objects.

a A W N

In the Downloaded Program Files, delete all files.

If you receive an error while deleting a file, repeat Step 1 through Step 5.
Close the Downloaded Program Files window.

Click OK to exit the Settings dialog box.

Click OK to exit the Internet Options dialog box.

© 00 N O

Proceed to “Initializing Siebel Outlook Add-In.”

Initializing Siebel Outlook Add-In

Perform the following task to initialize the communication between Outlook and the Siebel
application.
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This task is a step in “Process of Setting Up Siebel Outlook Add-In.”

To initialize Siebel Outlook Add-In
1 On the user’s machine, start Microsoft Outlook.

2 In Microsoft Outlook, select any calendar, contact, or task record (or create a new record if one
does not exist), and then choose Siebel Options > Link Selected Item(s).

3  When you are prompted to start the Siebel application, open a browser window, navigate to the
URL for your Siebel application, and then log in.

Outlook connects to the Siebel server using the Siebel application and creates an initial cache file
on the client machine. This can take several minutes. The Siebel Add-In Update Agent is started
and appears in the system tray of your Windows desktop.

4 Wait five minutes to allow time for the creation of the local cache file and then proceed to “Testing
Siebel Outlook Add-In.”

Testing Siebel Outlook Add-In

Perform the following task to test linking and unlinking between Outlook and the Siebel application.
This task is a step in “Process of Setting Up Siebel Outlook Add-In.”

1 In Microsoft Outlook, select any calendar, contact, or task record (or create a new record if one
does not exist), and then choose Siebel Options > Link Selected Item(s).

2 Select any record in the Siebel application.
If the link is successfully created, the link appears in the Existing Links list on the Siebel toolbar.
3 From the Siebel Options menu, choose Unlink Record to remove the link you just created.

If you encounter no errors during linking and unlinking, then the communication between
Outlook and the Siebel application has been initialized and is working properly.

Related Topics
“Linking to Siebel Data from Outlook” on page 161

Setting Siebel Outlook Add-In Options

Siebel Outlook Add-In adds a Siebel tab to the Microsoft Outlook Options dialog box, which lets you
change settings that control how Outlook communicates with the Siebel application.

Topics in This Section
“Setting the Cache Refresh Interval” on page 160

“Setting the Quick Link Retention Period” on page 160

Siebel Server Sync Guide Version 7.7, Revision A 159



Setting Up and Using Siebel Outlook Add-In = Using Sieb

Setting the Cache Refresh Interval

The Siebel Outlook Add-In stores the linked Siebel data in a local cache file, which is updated
periodically by obtaining new data from the Siebel application. By default, the cache is refreshed
every three days (4320 minutes). You can change the cache refresh interval by performing the
following task.

To change the Siebel Outlook Add-In cache refresh interval
1 In Microsoft Outlook on the user’s machine, choose Tools > Options.

2 In the Options dialog box, click the Siebel tab.
3 In the Cache Refresh Interval text box, enter the new interval (in minutes).
4

Click OK to exit the Options dialog box.

Setting the Quick Link Retention Period

Quick Links are retained for a number of days as defined on the Siebel tab of the Microsoft Outlook
Options dialog box. By default, Quick Links are retained for 30 days. You can change the Quick Link
retention period by performing the following task.

To change the Quick Link retention period
1 In Microsoft Outlook on the user’s machine, choose Tools > Options.

2 In the Options dialog box, click the Siebel tab.
3 In the Quick Link Retention text box, enter the new interval (in days).
4

Click OK to exit the Options dialog box.

Related Topics
“Using Outlook Add-In Quick Links” on page 162

Using Siebel Outlook Add-In

The Siebel Outlook Add-In adds a Siebel Options menu, a Siebel toolbar, and right-click menu items
to the Microsoft Outlook interface. These features let you link to records in the Siebel application.
You can also remove links using these controls.
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Table 41 lists the types of Siebel records that you can link to from Outlook.

Table 41. Supported Outlook-to-Siebel Record Linking

Can Link to These Siebel
Outlook Record Type Record Types

Calendar Account

Opportunity

Project

Service Request

Task Account

Opportunity

Project

Service Request

Contact Account

Opportunity

Project

Each Outlook record can support a single link to each Siebel record type. For example, an Outlook
contact can link to one Siebel account, one Siebel opportunity, and one Siebel project. If you link to
a new Siebel record and a link of that type already exists, the new link replaces the old link.

You can associate the same Siebel record to multiple Outlook records. By selecting multiple Outlook
records, and then associating the Siebel records, you can assign the same Siebel record to multiple
Outlook records in a single operation.

Topics in This Section
“Linking to Siebel Data from Outlook” on page 161

“Using Outlook Add-In Quick Links” on page 162
“Using Outlook Add-In Links” on page 162
“Removing Links to Siebel Data” on page 162

Linking to Siebel Data from Outlook

Perform the following task to link from Outlook records to Siebel records.

To link to Siebel data from Outlook
1 In Microsoft Outlook, select one or more calendar appointments, tasks, or contacts.
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2 From the Siebel Options menu, choose Link Selected Item(s).

NOTE: You can also create links using the Siebel toolbar and the right-click menu.

3 In the Create Siebel Links dialog box, from the Link Type drop-down list, choose a Siebel record
type.

4 Select a record from the list, and then click Add.
5 When you have defined all of the links, click OK.

The links appear in Current Siebel Links on the Siebel toolbar and also on the Siebel Options >
Quick Links list.

Using Outlook Add-In Quick Links

When you link to Siebel data from Outlook, the link is automatically added to the Siebel Options >
Quick Link list. You can use the Quick Link list to link one of the listed Siebel records to another
Outlook record, or records. By default, the Quick Link list retains links for 30 days. To change the
Quick Link retention period, see “Setting the Quick Link Retention Period” on page 160.

To use a Quick Link
1 In Microsoft Outlook, select one or more calendar appointments, tasks, or contacts.

2 From the Siebel Options menu, choose Quick Links, and then choose the desired link.

The selected record is linked to the current Outlook record, or records.

Using Outlook Add-In Links

When you link to Siebel data from Outlook, the link is automatically added to the Current Siebel Links
drop-down list on the Siebel toolbar. This list displays the Siebel links associated with the currently
selected Outlook record. Selecting a link from the list lets you access the Siebel record from Outlook.

To use a link
1 In Microsoft Outlook, select one or more calendar appointments, tasks, or contacts.

2 On the Siebel toolbar, choose a link from the Current Siebel Links drop-down list, and then click
Go.

The associated record is displayed in the Siebel application.

Removing Links to Siebel Data

You can remove individual links or all links associated with an Outlook record.
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To remove individual links associated with an Outlook record

1 In Microsoft Outlook, select a calendar appointment, task, or contact.

2 From the Siebel Options menu, choose Link Selected Item(s).

3 In the Create Siebel Links dialog box, under Siebel Links, select a link, and then click Remove.
4

When you have removed the appropriate links, click OK.

To remove all links associated with an Outlook record

=

In Microsoft Outlook, select one or more calendar appointments, tasks, or contacts.
From the Siebel Options menu, choose Remove Current Link(s).

NOTE: You can also remove links using the right-click menu.

3 Click Yes in the confirmation dialog box.

All links associated with the selected Outlook records are removed.

About Using Outlook Add-In with the Mobile Web Client

If your computer is set up to use the Siebel Mobile Web Client with a local database and file system,
and to use Microsoft Outlook in offline mode, you can use Outlook Add-In even when your computer
is not connected to a network. The following capabilities are available in this situation:

B If the Siebel Mobile Web Client is running, you can use Siebel links to navigate from Outlook to
a Siebel record in the local database.

B You can create or modify Siebel links in Outlook, whether Outlook is running in offline mode or
connected to the Exchange Server, provided that the Siebel records involved are already present
in the desktop cache. This cache is refreshed only when the computer is connected to the
Enterprise or Regional Siebel Database. For this reason, records that are created in the local
Siebel database are not present in the desktop cache until after the local database has been
synchronized with the Enterprise or Regional database, and the desktop cache has been
refreshed. A background process checks once a minute to determine whether the computer is
connected to the Enterprise or Regional Siebel Database and whether the refresh interval has
passed. If both these conditions are met, the cache is updated automatically. For information
about setting the cache refresh interval, see “Setting the Cache Refresh Interval” on page 160.

B If you create items such as Siebel links in Outlook while working offline, those items are cached
in an .OST file. The next time you synchronize your offline Outlook folders with your Exchange
Server folders, either automatically or manually, Outlook copies your cached items to the
Exchange Server.

B If you create an association by means of a Siebel link in Outlook (for example, if you link an
Outlook Contact to a particular Siebel Account in your local database), the association is not
visible in the Siebel Mobile Web Client until both of the following events have taken place:

m The local Siebel database is synchronized with the Enterprise or Regional database
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B The data in Outlook reaches the Exchange Server and is synchronized with the Siebel
database by SSSE.

For an example of a Siebel Account being associated with an Outlook Contact, after these two
synchronizations have taken place, the Account name appears in the Contact record regardless
of whether you are using the local database or the Enterprise or Regional database.
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This chapter describes how to set up and use the Embedded Outlook Calendar deployment option for
SSSE. The chapter includes the following topics:

B “About Embedded Outlook Calendar” on page 165
“About Siebel Calendars and Views” on page 166
“System Requirements for Embedded Outlook Calendar” on page 167

“Process of Setting Up Embedded Outlook Calendar” on page 167

“About Using Embedded Outlook Calendar” on page 169

About Embedded Outlook Calendar

Embedded Outlook Calendar (EOC) lets users access their Microsoft Outlook calendar from within the
Siebel application.

The EOC interfaces with the Microsoft Exchange Server, and is a fully functional Outlook client that
offers the same functionality as Microsoft Outlook. When appointments are created using the EOC,
they are placed directly into the Microsoft Exchange Server and not the Siebel database. SSSE
synchronizes these appointments into the Siebel database using PIMSI Engine. After this occurs,
users can access the records originally created in the EOC in any Siebel Activity view.

The SSSE administrator can choose to give users access to only the EOC or both the EOC and the
Siebel calendar. For more information about accessing the Siebel Calendar and the Embedded
Outlook Calendar, see “About Siebel Calendars and Views” on page 166.
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Figure 7 illustrates the Outlook calendar displayed in the Siebel Calendar view.
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Figure 7. Outlook Calendar in the Siebel Calendar View

About Siebel Calendars and Views

Depending on your Siebel implementation, you may have access to one or more types of calendars.
Table 42 lists the available Siebel calendars and views. For the Embedded Outlook Calendar, the
Outlook View Control is embedded in the Siebel application to allow viewing of the Outlook calendar
from within the Siebel application. This calendar is represented by a single view called HI Activity
Outlook Calendar View. This view works only in High Interactivity (HI) mode.

Calendar Visibility

The regular Siebel view visibility controls the visibility of the three calendar types (Sl Calendar, HI
Calendar, and Embedded Outlook Calendar). If a user has a responsibility that permits visibility of
all three views, then three Calendar links appear on the user’s Calendar tab. Each link corresponds
to one of the calendar types.

Table 42 illustrates the calendar views associated with responsibilities.

Table 42. Calendars and Views

Calendar View Name Description Responsibility
Standard eCalendar Daily View Daily calendar S| Calendar
Interactivity (SI) eCalendar Weekly View Weekly calendar (and many others)
Calendar

eCalendar Monthly View Monthly calendar
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Table 42. Calendars and Views

Calendar View Name Description Responsibility
High Interactivity HI Activity Calendar View | Daily, Weekly, and Many responsibilities
(HI) Calendar Monthly calendars in

(aka JavaScript a single view

Calendar)

Embedded Outlook HI Activity Outlook Outlook calendar Embedded Outlook
Calendar Calendar View Calendar

Related Topics
“Enabling Embedded Outlook Calendar Visibility” on page 168

System Requirements for Embedded
Outlook Calendar

Deployment of Embedded Outlook Calendar requires the prior installation of PIMSI Engine. For more
information about PIMSI Engine, see “SSSE Deployment Options” on page 14.

You must install a supported version of Microsoft Outlook on the machine of each user who needs
Embedded Outlook Calendar. For information about supported versions, see Siebel System
Requirements and Supported Platforms on Siebel SupportWeb.

Process of Setting Up Embedded Outlook
Calendar

To deploy the Embedded Outlook Calendar, complete the following tasks in the order shown:
1 “Verifying the Outlook Day/Week/Month View Names” on page 167
2 “Enabling Embedded Outlook Calendar Visibility” on page 168

Verifying the Outlook Day/Week/Month View Names

To display the Embedded Outlook Calendar, you must specify the Outlook Day/Week/Month view
names for the language that your Siebel implementation uses. This task is a step in “Process of
Setting Up Embedded Outlook Calendar” on page 167.

To verify Day/Week/Month view names

1 From the Siebel application menu, choose Navigate > Site Map > Administration - PIM Server
Integration > Configuration.

2 In the PIM Server Integration Configuration list, select Siebel Outlook Calendar.
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Outlook Calendar

3

5

In the Configuration Parameters list, verify that the following records exist. The example shown
is for English-American language.

Section Parameter Value

Day/Week/Month_ENU Day/Week/Month Day/Week/Month

Day/Week/Month_ENU Day/Week/Month View With Day/Week/Month View With
AutoPreview AutoPreview

If these records do not exist, then the Siebel administrator must create them as follows.

Section Parameter Value

Day/Week/Month_ Day/Week/Month Enter a language-dependent Outlook view name
<language code> for Day/Week/Month. See the second note
(See the following following.

note.)

Day/Week/Month_ Day/Week/Month Enter a language-dependent Outlook view name
<language code> View With for Day/Week/Month View With AutoPreview.
(See the following AutoPreview See the second note, following.

note.)

NOTE: <language code> is a three-letter Siebel language code in uppercase letters. For
example, the English-American language code is ENU.

NOTE: To retrieve the Outlook view names, from your Outlook Calendar, choose View > Arrange
By > Current View. Typically, the first two views are Day/Week/Month and Day/Week/Month View
With AutoPreview, respectively. You can also use other views as long as the views contain Day,
Today, Work Week, Week, and Month buttons required by the Siebel application.

Proceed to “Enabling Embedded Outlook Calendar Visibility.”

Enabling Embedded Outlook Calendar Visibility

To allow user visibility to the Embedded Outlook Calendar, the following conditions must be true:

An administrator must map the Outlook user to a Siebel user login. To do this, see “Setting SSSE
Group and User Access Controls” on page 118.

The Siebel user must have a responsibility that includes the HI Activity Outlook Calendar View.
You can accomplish this task in one of the following ways:

= Assign the HI Activity Outlook Calendar View to an existing responsibility that is already
assigned to the desired users.

Assign the Embedded Outlook Calendar responsibility to the desired users. See the following
procedure.
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B The copy of Outlook on the user's machine must be configured to use the user's profile by default,
rather than prompting the user to select a profile.

B The machine from which the user accesses Embedded Outlook Calendar must be able to
communicate with the user’s Exchange Server. For more information consult your Microsoft
Exchange documentation.

B The user must log into the machine using the Active Directory login that corresponds to the PIM
User ldentifier that is set up in the User Map of the Siebel application.

If the previous conditions are true, then users are able to access their Outlook calendars from the
Calendar tab of the Siebel application; however this does not make sure that their Outlook calendars
are synchronized with their Siebel calendars. To set calendar and user synchronization, see “Setting
Siebel Domain-Level Synchronization” on page 111, and “Enabling or Disabling User Synchronization”
on page 123.

NOTE: If you want the user to have access to only the Embedded Outlook Calendar, then you must
remove the HI Activity Calendar View, eCalendar Daily View, eCalendar Weekly View, and eCalendar
Monthly View from the user’s responsibilities.

This task is a step in “Process of Setting Up Embedded Outlook Calendar” on page 167.

To assign Embedded Outlook Calendar responsibility to a user

1 From the Siebel application menu, choose Navigate > Site Map > Administration - Application >
Responsibilities.

In the Responsibilities list, select the Embedded Outlook Calendar record.

In the Users list, click New, and then select a user.

Related Topics
“About Siebel Calendars and Views” on page 166

About Using Embedded Outlook
Calendar

The Embedded Outlook Calendar is a fully functional Outlook client that functions the same as the
Microsoft Outlook application. However, EOC has the following limitations:

B If another user logs in to the Siebel application from your machine, the EOC automatically
switches to the Siebel calendar. This is because your machine cannot display the login user's
EOC.

B Itis not possible to view another user’s EOC. If you attempt to view another user’s calendar from
your EOC using the Owner drop-down list, the other user’s calendar displays as a Siebel calendar
(HI Activity Calendar View).
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Setting Up and Using Embedded Outlook Calendar = A
and the Siebel Mobile Web Client

About Embedded Outlook Calendar and
the Siebel Mobile Web Client

If your computer is set up to use the Siebel Mobile Web Client with a local database and file system,
and to use Microsoft Outlook in offline mode, you can use Embedded Outlook Calendar even when
your computer is not connected to a network. The following capabilities are available in this situation:

B If a user has a responsibility that grants visibility for the HI Activity Outlook Calendar View, then
the Embedded Outlook Calendar is the only calendar view that the Siebel application displays
when that user is connected to the local database.

B Records that are created in the Embedded Outlook Calendar are stored on the Microsoft Exchange
Server if Outlook is connected to the server, and in a local file if Outlook is being run offline.

Records that are created in the Siebel application are stored in the local database.
B Records are not completely synchronized until all of the following have taken place:
m  Outlook synchronizes locally stored data with the Exchange Server
m Siebel Mobile Web Client synchronizes with the Siebel Enterprise or Regional Database

B  SSSE synchronizes the Exchange Server with Oracle’s Siebel Enterprise Database

170 Siebel Server Sync Guide Version 7.7, Revision A



A

Active Directory forest, requirements 28

Active Directory Global Catalog 36, 38
activities
See to do records
activity alarm, setting 140
appointment
about appointments with multiple
attendees 134
about creating, modifying, or deleting an
appointment 132
activities and calendar items 131
adding an attachment to an
appointment 134
creating or modifying a recurring
appointment 133
scheduling an all day appointment 133
architecture
overview 17
physical machine requirements 29
attachments
adding to a contact 143
adding to a to do record 138
adding to an appointment 134

B

browser objects, clearing 158

C
cache refresh interval, setting for Siebel
Outlook Add-In 160
calendar records, using with SSSE
about 130
about appointments with multiple
attendees 134
about creating, modifying, or deleting an
appointment 132
activities and calendar items 131
adding an attachment to an
appointment 134
creating or modifying a recurring
appointment 133
scheduling an all day appointment 133
synchronization factors 131
components
enabling and disabling server

Siebel Server Sync Guide Version 7.7, Revision A

components 84
required for SSSE 29
verifying definitions 52
conflict resolution 116
connector share directory
creating the shared directory 56
registering the shared directory 56
contacts records, using with SSSE
about 140
about creating, modifying, or deleting a
contact 142
account-to-contact relationships 144
adding an attachment to a contact 143
changing contact domains 144
contact access 144
creating a personal contact 143
designating a contact for
synchronization 141
ending synchronization of a contact 142
Coordinated Universal Time (UTC) 28

D
data flow, PIMSI Engine 30
data maps

about 90

changing 96, 97
data synchronization options 15
database triggers, activating 61
DB_LAST_UPD database columns,

populating 63

default account, configuring 72
deployment options 14

Domain Controller, checking properties 36,

38
domain maps, configuring 104
domains, defined 15

E
Embedded Outlook Calendar
about 165

about calendars and views 166
assigning calendar responsibility 169
calendar visibility 168

controlling calendar visibility 166
introduction 165

setting up process 167

171



Index m F

system requirements 167
using 169
using with the Mobile Web Client 170
viewing Outlook view names 167
employee records, using with SSSE
about 145
creating or modifying an employee 147
deleting an employee 147
designating an employee for
synchronization 146
ending synchronization of an employee 146
synchronizing employees 145
error messages, minor 148
Exchange 2000 Server Service Pack 3 Rollup,
installing 35
Exchange 2000 Server Service Pack 3,
installing 34
Exchange 2003 Server Service Pack 1 38
Exchange Connector
about 18
configuring application DCOM security 65
configuring parameters 79
installing 42
remote Exchange Connector defined 42
required privileges 58
setting log levels 86
Exchange Server Host 28
Exchange Servers
configuring 11S Web server 64
designating trusted sites 69
Exchange service account credentials,
configuring 58
Exchange System Management Tools
updating Microsoft Exchange 2000 server 34
updating Microsoft Exchange Server 2003 37
Exchange virtual directories 78
Export Only data synchronization option 15

F

features, new 9

field synchronization, setting 117
firewalls, configuring 39

Full Sync data synchronization option 15

G

Generic Siebel Organizer, configuring 71

11S Web servers, configuring 64

172

inbound activity filtering
using with calendar records 130
using with to do records 137
Initial Extract process
about 19
data flow 30
installing SSSE
installing Exchange Connector 42
introduction 33
PIMSI Dispatcher 40
PIMSI Engine 41
roadmap 33

K
key fields, setting 117

L

links, using 162

log files
configuring Exchange Connector logs 86
configuring SSSE logs 70

M

mailboxes, moving or deleting for SSSE
users 127
Microsoft Exchange 2000 Server, updating
about 34
installing Exchange 2000 Server Service Pack
3 34
installing Exchange 2000 Server Service Pack
3 Rollup 35
installing Exchange System Management
Tools 34
installing Microsoft XML Core Services 36
Microsoft Exchange Server 2003, updating
about 37
installing Exchange 2003 Server Service Pack
1 38
installing Exchange System Management
Tools 37
installing Microsoft XML Core Services 38
Microsoft Exchange service account 58
Microsoft Outlook
about creating, modifying, or deleting a
contact 142
account-to-contact relationships 144
adding an attachment to a contact 143
caution, installing 33
creating a personal contact 143

Siebel Server Sync Guide Version 7.7, Revision A



designating a contact for
synchronization 141
linking Siebel data from Outlook 161
Siebel Outlook Add-In 151
using Embedded Outlook Calendar
Microsoft XML core services
updating Microsoft Exchange 2000 Server

165

updating Microsoft Exchange Server 2003 38

Mobile Web Client, using with SSSE 163

N
new features 9
O
Ongoing Extract process
about 19
data flow 30
Outlook

about creating, modifying, or deleting a
contact 142

account-to-contact relationships 144

adding an attachment to a contact 143

caution, installing 33

creating a personal contact 143

designating a contact for
synchronization 141

linking Siebel data from Outlook 161

Siebel Outlook Add-In 151

using Embedded Outlook Calendar 165

P

parameters, setting 73
performance, optimizing 55, 73, 76
personal contact, creating 143
PIM Category values, setting 113
PIM domains
about establishing 109
changing domain configuration 100, 104

establishing PIM domains for SSSE 109, 110

setting domain field defaults 114
setting required fields 114
PIMSI Dispatcher
about 18
actions described 29
configuring 85
installing 40
starting 85
PIMSI Engine
about 17

Index

actions described 29
data flow 30
PIMSI Engine, installing 41

Quick Links
setting retention period 160
using 162

R

remote Exchange Connector 42

S

Siebel data, removing links to 162
Siebel domains
about establishing 109
changing domain configuration 98, 99
setting domain field defaults 113
setting domain synchronization level
setting PIM Category values 113
setting required fields 113
Siebel Enterprise Server, system
requirements 28
Siebel Links drop-down list, adding
links 162
Siebel Outlook Add-In
about 151
clearing browser objects 158
initializing 158
installing 157
linking to Siebel records from Outlook 160,
161
process of setting up 155
removing links to Siebel data 162
right-click menu items figure 151
setting cache refresh interval 160
setting enterprise server parameters 155
setting objects and field 156
setting options 159
setting Quick Link retention period 160
Siebel Options menu figure 151
Siebel tab in options dialog box 151
Siebel toolbar figure 151
system requirements 154
testing 159
using links 162
using Quick Links 162
using with the Mobile Web Client 163

111

Siebel Server Sync Guide Version 7.7, Revision A

BN

173



Index m S

sspicnea application 65
sspicnfm application 65
SSSE
about 13
architecture 17, 29
components 29
configuring for optimum performance 55,
73, 76
important terminology 18
required components 29
system requirements 28
SSSE domain mapping
about 115
mapping PIM and Siebel domains 115
SSSE usage scenarios
activity (task) scenario 130
business contact scenario 130
calendar scenario 129
employee scenario 130
personal contact scenario 130
SSSE, administering
about 109
about file maintenance 124
about log files 125
creating a new field mapping 116
enabling/disabling user synchronization 123
establishing domains 109
establishing PIM domains for SSSE 109, 110
introduction 109
mapping multiple users 122
mapping PIM and Siebel domains 115
mapping Siebel user to PIM user 122
moving or deleting SSSE user mailboxes 127
reinitializing a user 124
setting conflict resolution for a domain 116
setting domain synchronization level 111
setting field-level synchronization 117
setting group synchronization level 120
setting key fields 117
setting PIM Category values 113
setting PIM domain field defaults 114
setting PIM domain required fields 114
setting Siebel domain field defaults 113
setting Siebel domain required fields 113
setting SSSE group and user access 118
setting user synchronization level 118
SSSE domain mapping 115
SSSE, configuring
about mapping Engine shares to Exchange
Servers 76
activating database triggers 61
configuring and starting PIMSI Dispatcher 85
configuring Exchange Connector application

DCOM security 65
configuring Exchange Connectors 79
configuring Exchange service account
credentials 58
configuring the default account 72
configuring the Generic Siebel Organizer 71
enabling and disabling server
components 84
firewalls 39
introduction 43
modifying log file settings 70
populating DB_LAST_UPD database
columns 63
process steps 44
registering the shared directory 56
restarting Siebel services 84
setting Exchange Connector log levels 86
setting SSSE parameters 73
setting up the connector share directory 56
using Exchange virtual directories 78
verifying component definitions 52

SSSE, customizing

about 87

about data maps 90

about SSSE Integration Objects 90

about SSSE user filtering 106

about synchronizing additional fields 88

changing data maps 96, 97

changing domain map configurations 104

changing Integration Objects 91, 92, 94

changing PIM domain configurations 100,
104

changing Siebel domain configurations 98,
99

changing user filtering configurations 107

introduction 87

process steps 91

SSSE, installing

installing Exchange Connectors 42
installing PIMSI Dispatcher 40
installing PIMSI Engine 41
introduction 33

roadmap 33

SSSE, using

about 129

introduction 129

scenarios 129

using with calendar records 130
using with contacts records 140
using with employee records 145
using with to do records 137

Sync List

adding a user for a contact 141
adding a user for an employee 146

174 Siebel Server Sync Guide Version 7.7, Revision A



ending synchronization of a contact 142
ending synchronization of an employee 146
synchronization
enabling and disabling synchronization 123
options 15
system requirements
Embedded Outlook Calendar 167
machines required 28
Siebel Outlook Add-In 154

T
terminology for SSSE 18

time zone requirements 28
to do records, using with SSSE

about 137
about creating, modifying, or deleting a to do
item 138

adding an attachment 138

assigning priorities to a to do item 139
assigning Status values to a to do item 139
assigning to do items to others 139

IndexmT

creating or modifying a recurring to do
item 138

setting a to do activity alarm 140

synchronization factors 138

U
user filtering

about 106

changing user filtering configurations 107
users

mapping individual Siebel users to PIM

users 122
mapping multiple users 122
reinitializing a user 124

w
Web servers, configuring 11S Web
servers 64
workflows, caution 15

Siebel Server Sync Guide Version 7.7, Revision A 175



Index m W

Siebel Server Sync Guide Version 7.7, Revision A



	Contents
	1 What’s New in This Release
	What’s New in Siebel Server Sync Guide, Version 7.7, Revision A
	What’s New in Siebel Server Sync Guide, Version 7.7

	2 Introducing Siebel Server Sync
	About SSSE
	SSSE Deployment Options
	SSSE Synchronization Options

	3 Siebel Server Sync Architecture Overview
	About PIMSI Engine
	About PIMSI Dispatcher
	About Exchange Connector
	Important SSSE Terminology
	Initial Extract and Ongoing Extract
	About Synchronizing Records during Initial Extract
	About Synchronizing Records during Ongoing Extract

	SSSE System Requirements
	SSSE Architecture
	Required Components for SSSE
	PIMSI Engine Data Flow

	4 Installing Siebel Server Sync
	Roadmap for Installing SSSE
	Process of Preparing Microsoft Exchange 2000 Environment for SSSE Installation
	Installing Exchange 2000 System Management Tools
	Installing Exchange 2000 Server Service Pack 3
	Installing Exchange Server Service Pack 3 Rollup
	Installing MSXML 4.0 SP2
	Checking Domain Controller Properties

	Process of Preparing Microsoft Exchange 2003 Environment for SSSE Installation
	Installing Exchange 2003 System Management Tools
	Installing Exchange 2003 Server Service Pack 1
	Installing MSXML 4.0 SP2 (for Exchange 2003)
	Checking Domain Controller Properties (for Exchange 2003)

	Configuring Firewalls for Use With SSSE
	Firewall Located Between PIMSI Engine and Exchange Connector
	Firewall Located Between Exchange Connector and Exchange Server

	Installing Siebel Server for PIMSI Dispatcher
	Installing Siebel Server for PIMSI Engine
	Installing Siebel Exchange Connector

	5 Configuring Siebel Server Sync
	Process of Configuring SSSE
	Modifying the Database
	Modifying the Repository
	Modifying Seed Data
	Verifying SSSE Component Definitions
	About Tuning SSSE for Optimal Performance
	MaxUsers
	MaxTasks
	Selecting and Testing MaxUsers and MaxTasks Values
	Choosing an Appropriate Dispatcher Repeat Interval

	Setting Up the Connector Share Directory
	About Exchange Service Account Privileges
	Configuring Exchange Service Account Credentials
	Configuring Credentials Using a Script
	Configuring Credentials Manually

	Setting System Preferences for SSSE
	Configuring the Database for SSSE
	Activating SSSE Database Triggers

	Populating DB_LAST_UPD Columns
	Configuring the IIS Web Server for Exchange
	Configuring Exchange Connector Application DCOM Security
	Designating Trusted Exchange Servers
	Modifying Log File Settings
	Configuring the Generic Siebel Organizer
	Configuring the Default Account
	Tuning SSSE Siebel Profile Parameters
	About Mapping Exchange Connectors to Exchange Servers
	Configurations That Include Connector Application Map Records
	Configurations That Exclude Connector Application Map Records

	About Using Exchange Virtual Directories
	Configuring Exchange Connector Parameters
	Enabling and Disabling Components on SSSE Servers
	Restarting Siebel Services
	Configuring and Starting PIMSI Dispatcher
	Setting Exchange Connector Log Levels

	6 Customizing Siebel Server Sync
	About Customizing SSSE
	About Synchronizing Additional Fields
	About SSSE Integration Objects
	About SSSE Data Maps
	Process of Customizing SSSE
	Changing Integration Objects
	Example of Changing Integration Objects (New Field)
	Example of Changing Integration Objects (Existing Field)
	Changing SSSE Data Maps
	Example of Changing Data Maps (New Field)
	Example of Changing Data Maps (Existing Field)
	Changing Siebel Domain Configurations
	Example of Changing Siebel Domain Configurations (New Field)
	Example of Changing Siebel Domain Configurations (Existing Field)
	Changing PIM Domain Configuration
	Example of Changing PIM Domain Configuration
	Changing Domain Map Configurations
	About SSSE User Filtering
	Changing User Filtering Configurations


	7 Administering Siebel Server Sync
	About Administering SSSE
	Establishing Domains for SSSE
	About Siebel Domains
	About PIM Domains
	Setting Siebel Domain-Level Synchronization
	About the Limitation Against Import Only Synchronization Level

	Setting PIM Category Values for Siebel Domains
	Setting Required Siebel Domain Fields and Defaults
	Setting Required PIM Domain Fields and Defaults

	SSSE Domain Mapping
	Mapping PIM Domains and Siebel Domains
	About Resolving Synchronization Conflicts
	Mapping Fields
	Setting Key Fields
	Setting Field-Level Synchronization

	Setting SSSE Group and User Access Controls
	Setting User-Level Synchronization
	Setting Group-Level Synchronization
	Mapping Individual Users
	Mapping Multiple Users
	Enabling or Disabling User Synchronization

	About SSSE File Maintenance
	Reinitializing an SSSE User
	About SSSE Log Files
	About Moving or Deleting Mailboxes for SSSE Users

	8 Using Siebel Server Sync
	About Using SSSE
	Scenarios for SSSE
	Scenario for Scheduling a Meeting Using the Calendar
	Scenario for Recording a Task or To Do Activity
	Scenario for Storing Personal Contact Information
	Scenario for Storing Business Contact Information
	Scenario for Accessing Employee Information

	About Using SSSE with Calendar Records
	Factors That Determine Calendar Synchronization
	About Activities and Calendar Records
	Creating, Modifying, or Deleting an Appointment
	Creating or Modifying a Recurring Appointment
	Scheduling an All-Day Appointment
	Adding an Attachment to an Appointment
	Calendar Appointments with Multiple Attendees
	Calendar Items Created in Siebel Applications
	Calendar Items in Siebel Applications Synchronized with Microsoft Exchange
	Special Handling When Siebel Owner Is Not Enabled to Use SSSE
	Calendar Items Created in Microsoft Exchange
	Calendar Items in Microsoft Exchange Synchronized with Siebel Applications
	Special Handling When the Exchange Organizer Is Not Mapped or Enabled to Use SSSE
	Special Handling When an Exchange Attendee Is Not Enabled to Use SSSE
	Special Handling When an Exchange Attendee Deletes or Declines an Exchange Meeting


	About Using SSSE with To Do Records
	Factors That Determine To Do Record Synchronization
	Creating, Modifying, or Deleting a To Do Record
	Creating or Modifying a Recurring To Do Record
	Adding an Attachment to a To Do Record
	Assigning To Do Activities to Other Users
	Assigning Priorities to a To Do Record
	Assigning Status Values to a To Do Record
	Setting a To Do Activity Alarm

	About Using SSSE with Contacts Records
	Designating Contact Records for Synchronization
	Ending Synchronization of Contact Records
	Creating, Modifying, or Deleting a Contact
	Adding an Attachment to a Contact
	Creating a Personal Contact
	Account-to-Contact Relationships
	Contact Access
	Changing Contact Domains

	About Using SSSE with Employee Records
	Synchronizing Employees
	Designating Employee Records for Synchronization
	Ending Synchronization of Employee Records
	Creating or Modifying an Employee
	Deleting an Employee

	About Minor Error Messages

	9 Setting Up and Using Siebel Outlook Add-In
	About Siebel Outlook Add-In
	Siebel Outlook Add-In Controls
	System Requirements for Siebel Outlook Add-In
	Process of Setting Up Siebel Outlook Add-In
	Setting Enterprise Server Parameters
	(Optional) Setting Siebel Outlook Add-In Objects and Fields
	Installing Siebel Outlook Add-In
	Clearing Browser Objects
	Initializing Siebel Outlook Add-In
	Testing Siebel Outlook Add-In

	Setting Siebel Outlook Add-In Options
	Setting the Cache Refresh Interval
	Setting the Quick Link Retention Period

	Using Siebel Outlook Add-In
	Linking to Siebel Data from Outlook
	Using Outlook Add-In Quick Links
	Using Outlook Add-In Links
	Removing Links to Siebel Data
	About Using Outlook Add-In with the Mobile Web Client


	10 Setting Up and Using Embedded Outlook Calendar
	About Embedded Outlook Calendar
	About Siebel Calendars and Views
	Calendar Visibility

	System Requirements for Embedded Outlook Calendar
	Process of Setting Up Embedded Outlook Calendar
	Verifying the Outlook Day/Week/Month View Names
	Enabling Embedded Outlook Calendar Visibility

	About Using Embedded Outlook Calendar
	About Embedded Outlook Calendar and the Siebel Mobile Web Client

	Index



